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▲�2.19 ������CPU���������������������GPU��������������������Draw

Call���������������������������������������� �������������

�������Draw Call��������

�������������10 000�������������1KB�������������

����������������������������10MB������������������

��������������10MB��������������������������������

���������������������������������������������������

���������������������������������������������������

���������



�������������������������������������Draw Call���

CPU���GPU�������������������������CPU�������������

���������CPU����������GPU�����������GPU�����������

�200���2 000������������������������CPU����������

Draw Call������CPU������������Draw Call����CPU�����

2.20����������

▲�2.20 �������������GPU���������������������������� GPU��������CPU�

������������

��������Draw Call�

����Draw Call���������������������Batching� ����



������������Draw Call���CPU�������CPU���������

Draw Call��������������������������DrawCall�������

Draw Call������������2.21������������

��������������CPU������������������������������

��������������������������������������������������

���������������������������������������������������

���GPU������������������

▲�2.21 ������CPU�RAM��������������������GPU������Draw Call���������

�������������������������������������������������������������

�������������Draw Call������������

�1�������������������������������������������

�2�����������������������������



����16.4������������Unity��������������

2.4.4 ���������

���������Fixed-Function Pipeline� ���������������

���GPU��������������������������������������������

����

������������������������������Function Entry

Points��������������GPU����������������������������

���������������������������������������������������

�������������������������������������������

��������GPU������������������������������������

�����������������������������������������������GPU

����������2.1���3��������������������������

�2.1 3���������������������

3D API ����������� �������������

OpenGL 1.5 2.0

OpenGL ES 1.1 2.0

DirectX 7.0 8.0

�GPU�������������������������������������������

���������������������������������������������������

�����������������������OpenGL 2.0������������������

���������������������������GPU��������������������

��OpenGL 3.0�����������������������������OpenGL 3.2

��Core Profile��������������



���������������������������������������



2.5 ���������Shader��

��������������GPU����������Shader��������������

���������Shader���

GPU��������������������������������GPU��������

����������������������������

��������������������������

�����������������������������������������������

������������

��������������������������Shader���������������

�������������������������������������/������

Unity������������������������������� �����������

����Unity Shader��������������Unity Shader����



2.6 ����

������������������������������������[1] ���������

���������������������������������Draw Call���������

��������������������������������������������������

������������������������NVIDIA�������[2] �����������

���OpenGL�DirectX������������������������

�https://www. opengl.org/wiki/Rendering_Pipeline_Overview

�https://msdn.microsoft.com/en-us/ library/windows/

desktop/ff476882(v=vs.85).aspx �����������

[1] Akenine-Möller T, Haines E, Hoffman N. Real-time

rendering[M]. CRC Press, 2008.

[2] Wloka M. Batch, Batch, Batch: What does it really

mean?[C]//Presentation at game developers conference.
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�3� Unity Shader��

����������������Shader�����������������������������

��������������������

���Unity����������������������������������������

// ������� 

void Initialization() { 

    // �������������� 

    string vertexShaderCode = LoadShaderFromFile(VertexShader.shader); 

    // �������������� 

    string fragmentShaderCode = LoadShaderFromFile(FragmentShader.shader);

    // ���������GPU� 

    LoadVertexShaderFromString(vertexShaderCode); 

    // ���������GPU� 

    LoadFragmentShaderFromString(fragmentShaderCode); 

 

    // ����"vertexPosition"�������������� 

    SetVertexShaderProperty("vertexPosition", vertices); 

    // ����"MainTex"�������someTexture��������� 

    SetVertexShaderProperty("MainTex", someTexture); 

    // ����"MVP"�������MVP��������������� 

    SetVertexShaderProperty("MVP", MVP); 

 

    // ���� 

    Disable(Blend); 

    // ������ 

    Enable(ZText); 

    SetZTestFunction(LessOrEqual); 

 

    // ���� 

    … 

} 

 

// ������� 

void OnRendering() { 

    // ������ 

    DrawCall(); 

    // ����������������������������� 

    ... 

} 

 

VertexShader.shader�



// �����������MVP���� 

in float3 vertexPosition; 

in sampler2D MainTex; 

in Matrix4x4 MVP; 

 

// �������MVP������ 

out float4 position; 

 

void main() { 

    // ��MVP����������� 

    position = MVP * vertexPosition; 

} 

 

FragmentShader.shader�

// ���VertexShader���position������������������position 

in float4 position; 

 

// ���������� 

out float4 fragColor; 

 

void main() { 

    // ��������� 

    fragColor = float4(1.0, 1.0, 1.0, 1.0); 

} 

 

����������������������������������������������������

�������������������������������������������������

Unity�����������������������������������������������

�/��������������������������������������������Unity����

�“�����”���Unity Shader�



3.1  Unity Shader��

��������Unity Shader�������������

3.1.1 ���������Unity Shader

������Unity����������� �Material� �Unity Shader����

����������������

�1��������

�2�����Unity Shader����������������

�3�������������

�4���������Unity Shader�������������

�3.1���Unity Shader��������������������

▲�3.1 Unity Shader�����������Unity Shader�������Unity Shader�����������

��������������������������������������������



�����Unity Shader��������������������������������

�������������������������������������������������

3.1.2 Unity����

Unity����������GameObject�Mesh��Particle Systems��

�������������������������������Unity Shader�����

����������������Unity�������Assets -> Create ->

Material ����������Project����� -> Create -> Material�����

����������������������������������Scene������������

������Mesh Renderer ����������3.2���

�Unity 5.x��������������������Unity���Standard

Shader���������������������18�����

������������������������Unity������������Cinema

4D�Maya�������������������������������������������

�������������������������������3.3���

▲�3.2 �����������Mesh Renderer���



��

▲�3.3 �������������������������

����“1”����������������Unity�����������������������“2”������������

3.1.3 Unity��Shader

��������Shader����������Unity��Shader�����Unity

Shader ������Unity Shader�������������Shader��������



��3.6.2������������

��������Unity Shader������Unity�������Assets ->

Create -> Shader ����������Project����� -> Create ->

Shader �����Unity 5.2�������Unity�����4�Unity Shader���

����——Standard Surface Shader �Unlit Shader �Image

Effect Shader ��Compute Shader ����Standard Surface

Shader ������������������Unity 5������������������18

�����������Unlit Shader ������������������������/����

��Image Effect Shader �������������������12����������

�����Compute Shader ��������Shader�����Shader����

GPU�����������������������������������������Unity��

�Compute Shader ��

�http://docs.unity3d.com/Manual/ComputeShaders.html ����

�����������Standard Surface Shader ������������������

�������������Unity�����/�����������������������Unlit

Shader ����������/��������

�����Unity Shader�����������������������������“��

��”�����������������������������Unity Shader��������

����������Unity Shader������������������������������

��������������������������������������������������

Unity Shader�������������Unity�����������Unity

Shader������ �Import Settings�����Project �������Unity

Shader������Unity 5.2����Unity Shader���������3.4���

�����������Default Maps ����Unity Shader���������

����������Unity Shader�����������������������������

Unity������Unity Shader��������������������Surface

Shader���������������Fixed Function Shader������������

��Unity Shader���������3.3.3�����������������������

LOD���

����������3.4.1�������������Show generated code ��

������������������Unity���������������/�������������

����������������������Unity Shader�����������������

http://docs.unity3d.com/Manual/ComputeShaders.html


Unity Shader������������Fixed function ���������Show

generated code ����������������������/������Compile

and show code �������������Unity Shader�������������

OpenGL�D3D9�D3D11��������Shader�����3.5����������

�����������������������������������

▲�3.4 Unity Shader�������



▲�3.5 Compile and show code����

�����Unity Shader����������������������Render

queue����������Disable batching�������Properties�����



3.2 Unity Shader����ShaderLab

“��������������������������”

——��·��

������������������������������������������������

���������������������������������������������������

����

Unity�������������������——Unity Shader����������

���������Unity��������Unity Shader�����——ShaderLab

�

���ShaderLab�

"ShaderLab is a friend you can afford."——����·����

�Nicholas Francis��Unity�������COO����������

Unity Shader�Unity������������������3.6���������

Unity�����������������������



▲�3.6 Unity Shader���������������������Unity Shader�������������������

�������������������Unity Shader�����������������ShaderLab���Unity

Shader������������

�Unity�����Unity Shader����ShaderLab�����ShaderLab

�Unity�����Unity Shader��������������������������

�syntax� �����Unity Shader�������������������������

Properties ����������������������������������������

ShaderLab���CgFX�Direct3D Effects�.FX�����������������

������������������ �

��Unity Shader����������

Shader "ShaderName" { 

    Properties { 

        // �� 

    } 

    SubShader { 

        // ��A������� 

    } 

    SubShader { 

        // ��B������� 

    }     

    Fallback "VertexLit" 

} 

 

Unity��������������������������Shader�����������

Unity Shader������



3.3 Unity Shader���

����������������ShaderLab�����Properties �

SubShader �Fallback ���������Unity Shader��������Unity

���Unity Shader�����������������������������������

3.3.1 ����Shader����

��Unity Shader�����������Shader ������Unity Shader

��������������������“MyShader”����������Unity

Shader����������������������������������“/”������

Unity Shader���������������

Shader "Custom/MyShader" {     } 

 

����Unity Shader������������Shader -> Custom ->

MyShader ���3.7���



▲�3.7 �Unity Shader����������������������

3.3.2 ���Unity Shader����Properties

Properties ������������ �property� ��������������

��

Properties �����������

Properties { 

    Name ("display name", PropertyType) = DefaultValue 

    Name ("display name", PropertyType) = DefaultValue 

    // ���� 

} 

 

����������������������������������������Shader�

����������������� �Name� ��Unity������������������

������� �display name� ����������������������������



� �PropertyType� ����������3.1���������������������

�������������Unity Shader������������������������

�3.1  Properties����������

� � � � �������� � �

Int number _Int ("Int", Int) = 2

Float number
_Float ("Float", Float)

= 1.5

Range(min,

max)
number

_Range("Range",

Range(0.0, 5.0)) =

3.0

Color (number,number,number,number)
_Color ("Color",

Color) = (1,1,1,1)

Vector (number,number,number,number)
_Vector ("Vector",

Vector) = (2, 3, 6, 1)

2D "defaulttexture" {}
_2D ("2D", 2D) = ""

{}

Cube "defaulttexture" {}
_Cube ("Cube",

Cube) = "white" {}

3D "defaulttexture" {}
_3D ("3D", 3D) =

"black" {}

��Int �Float �Range ��������������������������

Color �Vector �������������������������2D �Cube �

3D �3��������������������������������������������



�����������������������“white”“black”“gray”��“bump”�

������������������������Unity 5.0�������������

TexGen CubeReflect �TexGen CubeNormal �����������

����������Unity 5.0���������������������������������

���������������������

����������������������

Shader "Custom/ShaderLabProperties" { 

    Properties { 

        // Numbers and Sliders 

        _Int ("Int", Int) = 2 

        _Float ("Float", Float) = 1.5 

        _Range("Range", Range(0.0, 5.0)) = 3.0 

        // Colors and Vectors 

        _Color ("Color", Color) = (1,1,1,1) 

        _Vector ("Vector", Vector) = (2, 3, 6, 1) 

        // Textures 

        _2D ("2D", 2D) = "" {} 

        _Cube ("Cube", Cube) = "white" {} 

        _3D ("3D", 3D) = "black" {} 

    } 

 

    FallBack "Diffuse" 

} 

 



▲�3.8 �����������������

�3.8�������������������

����������������������������������Shader������

��Unity����������������������������������������

Assets -> Materials -> Chapter3 -> RedifyMat ������������

��������������Custom Shader GUI ��

�http://docs.unity3d.com/Manual/SL-CustomShaderGUI.html

������

���Shader����������������Cg��������������������

�������������Properties �����������������Cg���������

������������Shader�����������Properties ������������

���������������

3.3.3 ������SubShader

http://docs.unity3d.com/Manual/SL-CustomShaderGUI.html


���Unity Shader��������SubShader �������������

Unity������Unity Shader��Unity������SubShader �������

���������������SubShader ����������Unity����Fallback

�����Unity Shader�

Unity�������������������������������������������

�������������������������������������������������

�����������������������������������

SubShader ��������������

SubShader { 

    // ��� 

    [Tags] 

 

    // ��� 

    [RenderSetup] 

 

    Pass { 

    } 

    // Other Passes 

} 

 

SubShader �������Pass ������� �[RenderSetup]����

�[Tags]������Pass ����������������Pass ��������������

��������������������Pass �����������Pass ��������

SubShader �������������������������Pass ����������

�������������������������������SubShader ����������

�������Pass �

● ����

ShaderLab��������������������������������������

��/�������3.2���ShaderLab�������������

�3.2 �����������



� � �

�
� � � � � �

� � �

�
� � � � � �

Cull Cull Back � Front� Off
�����������/�

�/����

ZTest
ZTest Less Greater� LEqual� GEqual� Equal�

NotEqual� Always
������������

ZWrite ZWrite On�Off ��/������

Blend Blend SrcFactor DstFactor ���������

��SubShader ���������������������Pass ���������

������������������Pass ������������������Pass ������

������������Pass ��������������

● SubShader ���

SubShader ����Tags������� �Key/Value Pair���������

������������SubShader �������������������Unity����

������������������

��������

Tags { "TagName1" = "Value1" "TagName2" = "Value2" } 

 

SubShader �������������3.3���

�3.3 SubShader�����

� � � � � � � �



� � � � � � � �

Queue

����������������

����������������

����������������

����������8�����

����������������

�������

Tags { "Queue" =

"Transparent" }

RenderType

����������������

����������������

��������������

�Shader

Replacement���

Tags { "RenderType" =

"Opaque" }

DisableBatching

��SubShader ���

Unity�����������

����������������

��������11.3����

����������������

�SubShader �����

Tags { "DisableBatching"

= "True" }

ForceNoShadowCasting
�����SubShader ��

�����������8.4��

Tags {

"ForceNoShadowCasting"

= "True" }

IgnoreProjector

�������“True”����

��SubShader �����

��Projector�������

������

Tags { "IgnoreProjector"

= "True" }

CanUseSpriteAtlas

��SubShader �����

�sprites��������

�“False”

Tags {

"CanUseSpriteAtlas" =

"False" }



� � � � � � � �

PreviewType

����������������

����������������

�������������

�“Plane”“SkyBox”�

������

Tags { "PreviewType" =

"Plane" }

����������������������

���������������SubShader ���������Pass �����Pass

��������������������SubShader ������������������

● Pass ���

Pass �����������

Pass {  

    [Name] 

    [Tags]  

    [RenderSetup]  

    // Other code 

} 

 

��������Pass ����Pass �������

Name "MyPassName" 

 

�������������ShaderLab�UsePass ���������Unity

Shader��Pass ����

UsePass "MyShader/MYPASSNAME" 

 



����������������������Unity������Pass ����������

����������UsePass ���������������

��������Pass �������SubShader ����������Pass ����

�����������Pass �������������������3.4.3�����

Pass �����������������SubShader ����������������

����������������3.4���Pass ���������

�3.4 Pass �����

� � � � � � � �

LightMode ���Pass�Unity����������

Tags {

"LightMode" =

"ForwardBase" }

RequireOptions

����������������Pass����������

����������Unity�������

SoftVegetation������������������

�

Tags {

"RequireOptions"

=

"SoftVegetation"

}

�������Pass����Unity Shader��������Pass ���������

����������

UsePass ������������������������Unity Shader��

Pass �

GrabPass ��Pass �������������������������Pass ��

���10.2.2���

�����������������������������������������������

���������

3.3.4 ������Fallback



�����SubShader ������������Fallback ��������

Unity�“�������SubShader�����������������������

Shader��”

�������

Fallback "name" 

// �� 

Fallback Off 

 

�������������������Unity��“����Unity Shader”�����

��������Fallback ��������������������“��������������

SubShader���������”

���������Fallback ������

Fallback "VertexLit" 

 

����Fallback �������������������Unity����Unity

Shader����������Pass��������������������Pass�����

Fallback �����Shader�����������Pass�������Unity Shader

����Fallback �����������Unity�����������9.4��

3.3.5 ShaderLab��������

�������������������������������Unity������������

����������������CustomEditor �����������������

Category ����Unity Shader���������������������������

������



3.4 Unity Shader���

��������Unity Shader�������ShaderLab������Unity

Shader��������������������������������������������

�����������SubShader ��������������������Pass ����

���/������������������

�Unity����������3������Unity Shader��������������

���Shader��������ShaderLab����������

Shader "MyShader" { 

    Properties { 

        // ������� 

    } 

    SubShader { 

        // ������Shader�������� 

        // ������Surface Shader��� 

        // ��/������Vertex/Fragment Shader��� 

        // ��������Fixed Function Shader� 

    } 

    SubShader { 

        // ����SubShader�� 

    } 

} 

 

3.4.1 Unity���������

����� �Surface Shader� �Unity�������������������

������Unity����������������������������������/�����

������������Unity�����������������������������/����

����������������Unity���/�����������������������

Unity�������������������������“�����”�

�������������������

Shader "Custom/Simple Surface Shader" { 

    SubShader { 

        Tags { "RenderType" = "Opaque" } 



        CGPROGRAM 

        #pragma surface surf Lambert 

        struct Input { 

            float4 color : COLOR; 

        }; 

        void surf (Input IN, inout SurfaceOutput o) { 

            o.Albedo = 1; 

        } 

        ENDCG 

    } 

    Fallback "Diffuse" 

} 

 

��������������������SubShader ������Pass ������

CGPROGRAM �ENDCG �������������������������Pass���

Pass��������Unity�������������������������“��������

����������������������Lambert��������������”�

CGPROGRAM �ENDCG ��������Cg/HLSL�������������

�Cg/HLSL�����ShaderLab��������������Cg/HLSL�Unity��

��������������Cg/HLSL�����������������������������

Unity��������

3.4.2 ���������/�����

�Unity�������Cg/HLSL�������/�����

�Vertex/Fragment Shader� ����������������

���������/������������

Shader "Custom/Simple VertexFragment Shader" { 

    SubShader { 

        Pass { 

            CGPROGRAM 

            #pragma vertex vert 

            #pragma fragment frag 

 

            float4 vert(float4 v : POSITION) : SV_POSITION { 

                return mul (UNITY_MATRIX_MVP, v); 

            } 

 



            fixed4 frag() : SV_Target { 

                return fixed4(1.0,0.0,0.0,1.0); 

            } 

 

            ENDCG 

        } 

    } 

} 

 

�����������/��������������CGPROGRAM �ENDCG �

����������/��������Pass �������SubShader �����������

������Pass�����Shader������������������������������

����������������������������CGPROGRAM �ENDCG ���

������Cg/HLSL����

3.4.3 ��������������

����Unity Shader������������������������GPU���

DirectX 7.0�OpenGL 1.5�OpenGL ES 1.1����iPhone 3������

����������������������������� �Fixed Function

Shader� ����������������������������

���������������������

Shader "Tutorial/Basic" { 

    Properties { 

        _Color ("Main Color", Color) = (1,0.5,0.5,1) 

    } 

    SubShader { 

        Pass { 

            Material { 

                Diffuse [_Color] 

            } 

            Lighting On 

        } 

    } 

} 

 



�������������������Pass ������������Pass �������

���������3.3.3��������

��������������������ShaderLab�������ShaderLab��

��������������Cg/HLSL�

��������GPU������������������������������������

Unity 5.2�����������������Unity��������/�������������

���������������

3.4.4 ����Unity Shader��

���������������Unity Shader���������������

�����������������������������������������������

������������������������������/������

��������������������������������������������

��������������������������������/��������������

����������������������������/������



3.5 �����Unity Shader��

�����������������Unity Shader�������������������

�����������������������������“����������”���������

��

�����������������������/��������Unity Shader�����

�����������������17������������������������



3.6 ����

����������������������������������������������

3.6.1 Unity Shader != ���Shader

���������Unity Shader������2�����Shader���Unity

Shader������Unity�����Unity��Unity Shader���������

ShaderLab��——����.shader ������������

�Unity Shader�����ShaderLab���������������������

���Shader�

����Shader��������������Shader�����������������

�Unity Shader����������������������������������

����Shader�������������������������������������

��������������Unity Shader���������������������

��

����Shader�������������������������������������

������������Unity Shader������������������������

�������������������������������������������Unity

Shader�����������������������������

���Unity Shader�������������������Unity Shader���

�����������Shader������������������Shader����������

�Tessellation Shader��������Geometry Shader���Unity���

����������Unity 4.x��DirectX 11����������������������

�����OpenGL��������������������Shader��Unity Shader

�����

����Unity Shader��������������������������������

���Shader�����������������������Unity Shader��������

��������������

3.6.2 Unity Shader�Cg/HLSL�����



���������Unity Shader��ShaderLab����������������

�/�����������ShaderLab����Cg/HLSL���������������

Cg/HLSL������CGPROGRAM �ENDCG ������������������

����Cg�DX9���HLSL������������������Unity�Cg�HLSL��

���������Cg/HLSL������ShaderLab�������

���Cg��������Pass ������������

Pass { 

    // Pass�������� 

 

    CGPROGRAM 

    // �������� 

    #pragma vertex vert 

    #pragma fragment frag 

 

    // Cg�� 

 

    ENDCG 

    // ������ 

} 

 

���������“�������������Cg/HLSL�����SubShader ���

������Pass ���”�����������Cg/HLSL�����SubShader ���

�������������������������/�����������������������

Unity���/��������������������������Unity������������

�Pass���/�����������Unity Shader����������Show

generated code �������������/�������������������Unity

Shader������ ���/���������������Unity 5.2������������

�������������/��������������Unity������/�������

����������������Unity�������Cg�����������������

���Unity������Cg�����������������������������

Direct3D 9�OpenGL�Direct3D 11�OpenGL ES������������

���Unity�����������Cg������������������������������

��������������������������



���3.1.3�������������Unity Shader����������������

��������������Debug�������3.9���

▲�3.9 �Unity Shader������������Compile and show code �����Unity�CG����

���������Compile and show code ��������������������������������������

���������������������������������������������������

�����������������������������������������������

���������������Mac OS X�����DirectX�������������

3.6.3 �����GLSL���

������������“������Cg/HLSL��������GLSL���”�����

���������������Mac OS X�OpenGL ES 2.0��Linux����PC�

Xbox 360������DirectX��������������

��������GLSL��Unity Shader��������������Cg/HLSL�

����CGPROGRAM �ENDCG �����GLSL��������

GLSLPROGRAM �ENDGLSL ���



�������Unity Shader��GLSL��������Unity�����GLSL

Shader Programs ���http://docs.unity3d.com/Manual/SL-

GLSLShaderPrograms.html �����

http://docs.unity3d.com/Manual/SL-GLSLShaderPrograms.html


3.7 ����

Unity�����Unity Shader���������������Unity�������

������,�������Unity Shader�����������������

�http://docs.unity3d.com/Manual/SL-Reference.html ������

����Unity����������������

�http://docs.unity3d.com/Manual/ShaderTut1.html �

http://docs.unity3d.com/Manual/ShaderTut2.html �����Unity

Shader��������������������Cg�����������NVIDIA���Cg

���http://http.developer.nvidia.com/Cg/ ����������NVIDIA�

����������

�http://http.developer.nvidia.com/CgTutorial/cg_tutorial_cha

pter01.html ���������Cg������

http://docs.unity3d.com/Manual/SL-Reference.html
http://docs.unity3d.com/Manual/ShaderTut1.html
http://docs.unity3d.com/Manual/ShaderTut2.html
http://http.developer.nvidia.com/Cg/
http://http.developer.nvidia.com/CgTutorial/cg_tutorial_chapter01.html


�4� ��Shader�������

����������

——�������������

�����������������������������������������������

���������Shader����Shader��������������������������

��——������

�����������������������������������������������

��������������������������������������������������

�������Shader�����������“��������”���“�������������

�������”

�����������������������������������������������

��������������������������������������������������

��������������������������������������������������

���������������������

����������������������



4.1 �������

�����������������������������������������������

��������������������������������������������������

�������——�����4.1���������������������������

▲�4.1 �������������������������������

���������������������������������

�����������������������������������������������

�������



4.2 ������

������������������������������������������������

���� �Cartesian Coordinate System� ����������������

����������������������René Descartes��

������������������������������������������������

���������������������������������������������������

���������������������������������������������������

���������������������������������������������������

�����������������������������������������4.2�������

���������������������������������������������������

���������������������������������������������������

����������

▲�4.2 ��������������������������������������������������������������

������������������������������������������“�����

����”�����������������������������������



4.2.1 ��������

������������������������������������������������

���������������������������������������������������

������

�4.3��������������������������

▲�4.3 ����������

����������������������

�����������������������

���������������x ��y ���������������������

����4.3�x ��y �����������������������������������

��30°���������x �����y �������������������2.3.4�����

��OpenGL�DirectX�����������������4.4���

��������������������������������“��1, 2��������

��”������������������



▲�4.4 �������OpenGL�DirectX����������������

������������������������������������������������

�������������“�����������”�������“����”��“����”�����

��������������������������������������������������

������������������������������������������������

��“�����������”���������“���1���3�����”��4.5���

▲�4.5 ��������������������



4.2.2 ��������

�����������������������������������������������

����������������������50%����

������������������������������������������������

���������������������������������������������������

�������������������������������������������

�����������������3�����������4.6��������������

▲�4.6 ����������

�3����������������� �basis vector� �������� 3 ����

�������������1��������������� �orthonormal basis� ��

��������������������������������1�������������

�orthogonal basis� �������������������������������

���������������

������������������������������������������



�����������������������������������������4.6����

��������������������������� �left-handed coordinate

space� ������ �right-handed coordinate space� �

4.2.3 �����������

�����������������������������������������������

�������������x ��y �����������������4.4�������������

�����������������������4.4�OpenGL�DirectX�����������

��������������������������������������180°�����y ��

����x ���������������������������x �����������������

�������������������������������������

�����������������������������������������4.6��+z

�����������������������������+z ���������x ��y ����

��������������������������������������������������

������������������

������������������������������������������������

������������������ �handedness� �������������������

������������������������������A������������B������

����������������

������������������������������������������������

������������������������������“L”�������������������

��������������������������������������������������

��������������������������������������+x �+y �+z ��

�����4.7���

������������������������������������������������

��������������4.8���



▲�4.7 �����



▲�4.8 �����

�����������������������������������3������������

��������������������

������������������������� �forward� ������������

���������������x �����������������y ����������������

���z ����������������������������������������z �����

�������������

������������������������������������������������

��� �left-hand rule� ����� �right-hand rule� ����������

�������������������������������������30°�����������



���������������������������������������������������

���������������������������������������������������

�������������������������

������������������������������������������������

���������������4�����������������������������������

��4.9���

��3.9�������������������������������������������

��

�����������������������������������������������

������������������������������������������������

������������������������������������������2��������

������������������������������“��”����“������������

����������”����������������������������������������

���������������������������������������������������

���������������������������������������������������

���������������������������������������������������

�������������������������������������������

������������������������������������������������

���������������������“����”�������4.10���



▲�4.9 ������������������



▲�4.10 �����������������������1�������������4��������������60°

�����������������������������������������������

���������������������������4.11���

▲�4.11 ����������������������������������������������



��������3���������4.11����������x ������1 �������

�z ������4���������������60°����������+z �����������

������������x ������1����������������������z ������4

�����������������������������60°���������������

��������������������������������������������z ��

�����������������������������z ���������������������

���������������������������������������������������

��������������������������

4.2.4 Unity������

���������������������Unity����������������������

���������4.6�����������������Unity��������������

Scene��������������4.12����������������������

�right�����up�����forward������x ��y ��z ������

▲�4.12 ������������Unity���������� �������������������3��������x ����

�y �����z ��

����������Unity���������������������������������

���������������z ������������������������������z ���



����������������4.13���

▲�4.13 �Unity�����������������������z ������z ������������������

��Unity����������������4.5.9��������

4.2.5 ���

�����������������������������

�1�����������3ds Max������������x ���������y ����

�����z ��������������������������

�2�����������������0, 0, 1��������y ������+90°���

����������������������������0, 0, 1�����y ������+90°�

����������

�3��Unity������������������������0, 1, −10�������

�������������Rotation�(0, 0, 0)�Scale��1, 1, 1�����������

���(0, 1, 0)�����������4.14���



▲�4.14 ��������0, 1, -10���������0, 1, 0�

���������������z ��������������������z ������



4.3 ����

� �point� �n ������������������������������������

������������������2��3���������������P =(Px , Py )����

������P =(Px , Py ,Pz )����������

�� �vector� ������ � �����������������������������

������������������������������������ �scalar� ������

��������n ���������� �magnitude� ��� �direction� ����

� �����������velocity�����������������������80km/h���

���������80km/h������������������������������

�distance������������������200��200���������

�����

��������������������������������

���������������������

������������������v =(x ,y )���������v =(x ,y ,z )���

������v =(x ,y ,z ,w )��������

��������������������������������

������������������a �b �x �y �z �θ �α ��

���������������������a �b �u �v ��

���������������������������A �B �S �M �R ��

��4.15������������������������������ �head� ��

�tail� ���������������������������������4.15���

������������������������������������������������

�������������������������������������������������“�

������100km/h�������”�����������“�100km/h�����”����

���������������������������� �displacement� �������

�����������������������������������



4.3.1 �������

������������������������������������������������

���������������������������

������������������������������������������������

��������������������������������������������������

��������������������������������������������������

4.16�����������

▲�4.15 �������������



▲�4.16 ���������

������������������������������������������������

���������������������������������������������������

�������������������������������������������������

4.3.2 ����

������������������������������������������������

���������������������������������������������������

�����������������������

1��������/��

����������������������������������/�������������

������������������������������������������������

����������������������������

kv =(kvx ,kvy , kvz )

������������������������������������

���������

2(1,2,3)=(2,4,6)

−3.5(2, 0)=(−7, 0)

������������������������������������������������

����������



�������������v �����k ���������v ��������k ������

���������������������2��k <0�������������4.17������

�����

2���������

��������������������������������

������������������������������

a +b =(ax +bx ,ay +by , az +bz )

a –b =(ax −bx ,ay -by , az −bz )

��������

(1,2,3)+(4,5,6)=(5,7,9)

(5,2,7) − (3,8,4)=(2, −6,3)

�����������������������������������������

���������������������a �������b ���������a ���b �

��������a �b ��������������������������������a �����

�������b ������������a +b ���������������� ����

�triangle rule� �������������4.18���



▲�4.17 ���������������

▲�4.18 ����������

������������������������������������������������

�����������������



���������a �b �������������a �b �����������������

������b ����a ����������b �a �������4.19���

3�����

������������������������������������������������

���������������������������������������������������

��

�v �=

����������������������������������

���������

�(1,2,3)�=

�(3,4)�=

���������������������������������������������

4.20���



▲�4.19 �����������a��b���

▲�4.20 ����

��4.20������������������������������������������

���������������������

4�����

������������������������������������������������

���������������������������������������� �unit

vector� �

�����������1������������������� �normalized

vector� �������������������������������

�normalization� �

��������v ��������v ����������������������������

��������������������������������������������������

��

 ,v �������

���������



��� ������������0��v =(0,0,0)��������������������

������0�

������������������������������������������������

�������������������������������������4.21����������

������

▲�4.21 �����������������

������������������������������������������������

��������������������������������������������������

5������

���������������������������������������������

�dot product� ������ �inner product� ��� �cross

product� ������ �outer product� ��������������������

������������������“��������”��������������������

���������������������������������������������������

���������������



����������������������������������������������

��“������������������”�����Shader������������������

���������������������������Unity Shader������������

dot(a, b)������������������

����������������a ·b ���������������������������

������������������������������������������������

����

a ·b =(ax , ay , az ) ·(bx , by , bz )= ax bx + ay by +az bz

��������

(1,2,3) ·(0.5,4,2.5)=0.5+8+7.5=16

(−3,4,0)·(5, −1,7)= −15+−4+0=−19

������������a ·b =b ·a

������������������������������������������

�projection� �

���������������������b ����������b ������������

��������������·b ���b ������������

������������������������������������������������

���������b ���������b ����������4.22���

���������������������������b �������������������

90°�������0���������������90°�������0��������������

90°�������0��4.23����3�������



▲�4.22 ��b�����a������

▲�4.23 �����

���������������������������



�����  �����������������������������a ·b ���b �a �

����������a ����

��������������Shader����������������������

��������������

���“��”����������������������������������������

(k a )·b = a ·(k b )=k (a ·b )

���������������������������������������

������������������������

���“��”���������������������������������

a ·(b + c )= a ·b + a ·c

����c ��−c �����������

�����������������������������

���������������

v ·v =vx vx + vy vy + vz vz =�v �2

������������������������������������������������

���������������������������������������������������

���������������������

������������������������������������������������

������������������������

�������������

����



a ·b =�a ��b �cosθ

������������������������������������������������

�������  ·  ���4.24���

���������������  ���1��������  ����������  ·  �

������cosθ ������������4.24�����

▲�4.24 ����������

��������������������������������������������

a ·b =(�a �  )·(�b �  )=�a ��b �(  ·  )=�a ��b �cosθ

������������������������������������������������

�������������������������������������90°��cosθ >0��

����90°��cosθ =0������90°��cosθ <0�



������������������������0°�180°��

θ =arcos(  ·  )���  �  ������

���arcos�������

6������

�������������� �cross product� ������� �outer

product� ����������������������������

�������������������a ×b ������������������������

���������

a ×b =(ax , ay , az )×(bx , by , bz )=(ay bz −az by , az bx −ax

bz , ax by −ay bx )

������������������������4.25�����������

▲�4.25 ������������������������������������������������������������

��������y ������������z ������������z ��������y �����

���

(1,2,3)×(−2, −1,4)=((2)(4) − (3)(−1),(3)(−2) − (1)(4),(1)

(−1)−(2)(−2))

=(8−(−3),(−6)−4,(−1)−(−4))=(11,−10,3)



�����������������a ×b≠b×a �����������������a ×b

=−(b ×a )�������������� (a ×b ) ×c ≠a ×(b ×c )�

������������������������������������������������

���������������������������������������������������

���������a ×b �����a �b ������������������������

�a×b �=�a ��b �sinθ

������������������������������������������������

���������������������������������������������������

����

��4.26�������a �b ����������

������������������b �h �����������h ������a ����θ

�����

A =�b �h =�b �(�a �sinθ )=�a ��b �sinθ =�a ×b �

��������a �b �����������������������������������

������������������������0���a ×b =0 ���������������

����0�

���������������������“��������������������������

����”����������������������������������������������

��������������

�����������������������������4.27���



▲�4.26 ����a ���b ���������

▲�4.27 ����������������������

������������������������……����������������a ×b

�������������������������a �b ���������������������

a �����������������b �������������������������������

�a ×b �����������������������������4.28���



▲�4.28 ��������������a ×b ���

����������������������a ×b ���������������������

�����������

�����������������������������������“���”��������

���������������������������������������������������

���������������������������������������������������

���������������“�����������”�����������������������

���������������������������������������������

������������������������������������������������

�����������������������������



4.3.3 ���

�������������������������������������

1����

�1���������������������������������

�2������������������������������

�3�������������������������������

2�����������

�1��(2,7,3)�

�2�2.5(5,4,10)

�3�

�4��(5,12)�����

�5�(1,1,1)�����

�6�(7,4)+(3,5)

�7�(9,4,13)−(15,3,11)

3����������������(10,13,11)�������(2,1,1)���������

�������

4�����������

�1�(4,7)·(3,9)

�2�(2,5,6)·(3,1,2)−10

�3�0.5(−3,4)·(−2,5)



�4�(3,−1, 2)×(−5,4,1)

�5�(−5,4,1)×(3,−1,2)

5�����a ���b �a ���4�b ���6���������60°����

�1�a ·b

�2��a ×b ����  �  �

6����������NPC�����p �������forward�������v ����

�1������������x ������������NPC�����������������

��������������

�2�����a���������p =(4,2),v =(−3,4),x =(10,6)������

��

�3�������������NPC���������������������φ �����

NPC��������������  ���������������������NPC�������x

��

�4��c�����������������NPC����������������������

������������

7���������������������������������������3�������

�����������������������3���p 1 �p 2 �p 3 �����������3�

�����������������������������p 1 �p 2 �p 3 ���xy ������

�z ����0������z ��������z ���������4.29���



▲�4.29 ����������xy ��������z ������z ������



4.4 ��

���������������matrix�����������������

——�������������The Matrix�

��� ����matrix�����������matrix������������������

�������������������������������������������The

Matrix���������������������������������������������

����������

�����������������������������������������������

�������������������������������������������������

����2���������������������������������������������

���������������������������������

�����������������������������������������������

��������������

4.4.1 �����

�������������������������

�����������������������������������������������

m ×n ���������������������������������������������

�����������������������

���������������� �row�� �column���������������

3×4������������������������������3×3������������



mij ����������M ��i ���j ��

������������������������������������������

4.4.2 �������

�����������������������������������������������

��������������������������n ×1���� �column matrix�

�1×n ���� �row matrix� ���n ��������������v =(3,8,6)�

������

[3 8 6]

����

�����������������������������������������������

����������

�����������������������������������������������

��������������������������������������������������

����

4.4.3 ����

�����������������������������������������������

�Shader������������������������

1���������



�����������������������������������������������

����������������3×3������������

2���������

�����������������������������������������������

��

��r ×n ���A ���n ×c ���B ��������AB �����r ×c ����

��������������������������������������������������

�����������������������������A ����4×3���B ����

3×6���AB �����4×6�

�����������������������������������������������

��������������������������������������������������

��������������������������������

����������������������������������������������r

×n ���A ���n ×c ���B ����������r ×c ���C =AB ����C �

������cij ��A ��i ��������B ��j ������������������

cij =ai 1 b 1 j + ai 2 b 2 j +…+ ain bnj =

�����������������������������������cij �����A ���i

��B ���j �������������������������cij �

����������4.30�����A ����4×2�B ����2×4��������

C ���c 23 ������������������A ���2��B ���3����������

�������������� c 23 =a 21 b 13 +a 22 b 23 �



▲�4.30 ��c 23 ���

�Shader�������������4×4�������

�����������

����������������

�����������

AB ≠BA

��������������

�����

(AB )C =A (BC )

������������������������

ABCDE =((A (BC ))D )E =(AB )(CD )E

�����������������������



4.4.4 �����

�����������Shader�������������������������

1�����

�����square matrix� ��������������������������

���������3×3�4×4����

��������������������������������������������

�diagonal elements� ������������������������m 11 �m

22 �m 33 ������������������������������������������

����������������������0�������������� �diagonal

matrix� ����������4×4������

2�����

�������������� �identity matrix� ��I n ������3×3��

������

����������������������������������������������

��

MI =IM =M

���������1���

3�����



���� �transposed matrix� �����������������������

r ×c ���M ����������M T �����c ×r �������������������

�����������������������i �����i ����j �����j ��������

���

������������������������������

��������������

�����������������

��������������������������������������

(M T ) T =M

��������������������������

��������

(AB ) T =B T A T

��������������������



4����

��� �inverse matrix� ���������������������������

���������������������������

������M �������M −1 ���������������������M �M -1

�������������������������

MM −1 = M −1 M =I

��������������������������������������0��������

����������������������������0���������������������

������ �invertible� �������� �nonsingular� ����������

�������������������� �noninvertible� �������

�singular� �

��������������������������������� �determinant�

��0�����������������������������������������������

�������������������������������Shader�������������

����������C++���Eigen�������������������Unity�����

�������Unity�������������������Unity��������������

4.8����������

��������������

������������������

����M �������

(M −1 )−1 =M

�����������������

�

I −1 =I



��������������������

�

(M T )−1 =(M −1 ) T

������������������������������

�

(AB )−1 =B −1 A −1

��������������������

(ABCD )−1 =D −1 C −1 B −1 A −1

�������������������������������4.5�������������

����������������������������������M ���v ����������

��������M −1 ��������������������������������������

��������

M −1 (Mv )=(M −1 M)v=Iv =v

5�����

������������� �orthogonal matrix� ��������������

����M ������������������������������ �orthogonal� �

����������������M ��������

MM T = M T M =I

�����������������������������������������������

�������������������������������������������������M

��������

M T =M −1
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�����������

��������c 1 �c 2 �c 3 �����������������������1�

��������c 1 �c 2 �c 3 �����������������������0�

����������������������M ��������M T ��������

����������������������������������������������

�����4.2.2���������������4.6.2����������������������

��������������������������������������������������

���������������



����������������������������������

�����������������������������������������������

������������������������� �orthogonal basis� �������

���������1�����������1�����������������

�orthonormal basis� ������������������������������

��������������������������������������������������

���1���������������

4.4.5 ��������

�����������������������������������������������

���

�����������������������������������������������

��������������������������

�������v =(x ,y ,z )�������������v = [xyz ]����v = [x
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�����������������������������4.33������������������

����������������������������������������Transform��

Rotation�Scale��������

������������������������������������������

�model transform� �

������������������������������������������������

��������Transform���������������4.34���

▲�4.33 Unity�Transform��������������Transform���������“Mesh”���Position

�����������“Cow”�������������������Position�����������



▲�4.34 ������������������������������������������������������������

�����������

��Transform�����������������������(2, 2, 2)��������

(0, 150, 0)�����(5, 0, 25)������������������������������

����������������������������



�����������������������

P world = M model P model

��������������������(9, 4, 18.072)����������������

���������3�������Unity�����������

4.6.6 ����

���� �view space� ��������� �camera space� �����

��������������——����������������������������������

���������������������������������

������������������������������������������������

�������������Unity����Unity�������������+x ������+y

�������+z �����������������������������������������

�+z ���������������������������Unity����������������

���������������������������OpenGL�����������������

��������-z ����

��������������������Unity�����������Unity��������

��������������������������������

Camera.cameraToWorldMatrix�Camera.worldToCameraMatrix

������������������������������



������������������������4.6.8�������������������

����������������������������������������

�projection� ����������

������������������������������������������ �view

transform� �

������������������������������������������������

��������������������������Transform�������4.35���

▲�4.35 ��������������������������������������������z ������������z ��

��������Unity��������������������������������������������������������

���

������������������������������������������������

���������4.6.2��������������������������������������

���������������������������������������������������



���������������������������������������������������

�������

�������������Transform����������������������(30,

0, 0)��������(0, 10, −10)�����������������������������

���������������������������������������������(0,

−10, 10)�����������������(−30, 0, 0)������������������

������

������������������������z ����������������������

����������������

M view =M negate z M view

�����������������������



P view =M view P world

���������������������—— (9, 8.84,−27.31)�

4.6.7 ����

������������������ �clip space� ���������� � �����

������������ �clip matrix� ����������projection

matrix� �

������������������������������������������������

���������������������������������������������������

��� �view frustum� ����

������������������������������������������������

���������� �clip planes� ���������������������������

�orthographic projection� �������� �perspective

projection� ��4.36��������������������������������

▲�4.36 �����������������������������������������



������������������������������������������������

���������������������������������������������������

�������������������������������������3D������������

�������2D�����������HUD��������������

�����6������������������������������� �near clip

plane� ������ �far clip plane� �����������������������

�����������4.37���

▲�4.37 ������������������������������������

��4.37������������������������4�����������������

��������������������������������������������������

���������������������������������������������������

���������������������������������������������������

������������������������������������������

����������

������������������������������������������������

��������������������������� �homogeneous

division� �������������������w ������������

��������������



������������������������������������������������

���������������������������������������������������

�4.6.8�����

����x �y �z ���������������������6��������������

����������������������w ������������x �y �z �����

��������������������

��������������������������������������������w ��

�1������w ���0������������������������4������������

���������������������������

1�����

������������������������������������������������

���������������6�����������6���������������Unity���

��Camera�������Game�������������4.38���



▲�4.38 �������������������

��4.38�����������Camera���Field of View���FOV�����

���������������Clipping Planes��Near�Far��������������

�����������������������������������������������

�����������������������������Unity������������

Game�������Viewport Rect��W�H�����������Unity������

����Camera.aspect���������������������������Aspect��

����



������������Near�Far�FOV�Aspect����������������

��

�����������������������������������������Unity��

��������������������������������������������������z

������[-w , w ]����������DirectX����������������z �����

�[0, w ]�����������������������������������

�������������������������������������

P clip =M frustumPview

�������������������x �y �z ����������������z �����

��������������������������������w �����1�����z �����

�����,���������������������������������������������

������������

−w ≤x ≤w



−w ≤y ≤w

−w ≤z ≤w

������������������������4.39��������������������

▲�4.39 �������������������������4��������������������������x �y �z �w

����������

��4.39������������������������������������������

���������z �����

2�����

����������������6���������������������Unity�����

��Camera�������Game�������������4.40���



▲�4.40 �������������������

����������������������������������������������

Camera���Size��������������������Clipping Planes��

Near�Far�������������������������������������������

������������������

nearClipPlaneHeight=2 ·Size

farClipPlaneHeight=nearClipPlaneHeight

���������������������������������������������

Aspect����

nearClipPlaneWidth=Aspect ·nearClipPlaneHeight

farClipPlaneWidth=nearClipPlaneWidth



������������Near�Far�Size�Aspect����������������

��

�������������������������������������Unity������

�����

��������������������

P clip =M ortho P view

�����������������������������������w �����1�����

����������������������������[0 0 −1 0]��������������

���[0 0 0 1]�����������������������������������

������������������������������������������������

����������4.41�������������������������

�����������������������������������������������

��

�����������������������������������4.6.6��������

���������������������——(9, 8.84, -27.31)�������������

�������



��������������������������������3D�������������

�����������Game��������4.42���

▲�4.41 �������������������������4��������������������������x �y �z �w

����������



▲�4.42 ���������������������

�����������������FOV�60°�Near�5�Far�40�Aspect�

4/3 = 1.333��������������

������������������������������������

P clip =M frustum P view

�����������������������—— (11.691, 15.311, 23.692,

27.31)�����Unity������������������������������������

−w ≤x ≤w →−27.31≤11.691≤27.31

−w ≤x ≤y →−27.31≤15.311≤27.31

−w ≤z ≤w →−27.31≤23.692≤27.31

�����������������������������

4.6.8 ����

������������������������������������������������

������������������� �screen space� �����������������



�����������������

������������������������������������������2D���

���������������

��������������� �homogeneous division� ���������

�perspective division� ������������������������������

����w �����x �y �z ����OpenGL�����������������������

�Normalized Device Coordinates�NDC� ��������������

������������NDC�����������������������������������

��OpenGL����������x �y �z �������[−1, 1]���DirectX���

API��z �������[0, 1]��Unity���OpenGL������������4.43�

��

▲�4.43 ��������������������������

�����������������������������������������������

w ���1��������������x �y �z ���������4.44���



▲�4.44 ��������������������������

������������������������������������������������

x �y �����������������

�Unity����������������0, 0�����������(pixelWidth,

pixelHeight)�����x �y ����[−1, 1]��������������������

�������������������������

������x �y �����������z �������z �����������������

���  ��������������������������������������������

��clipw ����������������������——�������������NDC��

��������������������������������

�Unity������������������������������������������

��������

�����������������������——(11.691, 15.311, 23.692,

27.31)����������������������������������������400��



��300��������������������������NDC����������������

������

�������������������——(285.617, 234.096)�

4.6.9 ��

���������������������������4.45����������������

��������������������������������������4.45���3��

������������������������������������������4.9.3�����

����������

�Unity���������������������4.46���Unity����������

�����

��4.46��������������Unity���������

������������������������������������������������

� �tangent space� ������������������4.7��������



▲�4.45 ���������������



▲�4.46 Unity�����������



4.7 ����

������������������������

�� �normal� �������� �normal vector� ������������

���������������������������������������������������

���������������������������������������������������

��������������������������������

�����������������������4×4�3×3�����M A → B �����

��A �������B ��������������������������������������

����������������������

���������������——�� �tangent� �������� �tangent

vector� �������������������������������������������

�����4.47���



▲�4.47 ������������������

������������������������������������������������

�������3×3�����M A → B ��������������������3×3�����

��������������������������������������������������

��

T B =M A → B T A

��T A �T B ���������A������B��������������M A → B �

���������������������������4.48�����������



▲�4.48 ���������������������������������������������������������

������������������������������������������������

�T A ���T A N A N A ����������T A ·N A =0�������M A → B �

������T B =M A → B T A �������������G �����N A ��������

����������

T B ·N B =(M A → B T A )·(GN A )=0

������������

��T A ·N A =0�����  �����������������

 �������������������������������

�������������M A → B ��������  ���

 �������������������������������������

���������������������������������������������������

�����k �������M A → B ������  ����������

���������������������������������������������



4.8 Unity Shader����������

��Unity�Shader����������������������������������

����������Unity����������������������������������

UnityShaderVariables.cginc�����������

4.8.1 ����

����������������4.2���Unity 5.2������������������

�����float4x4����

���������Unity�����������

������������Unity������������������������Unity��

����5.2���4.x������������������

�4.2 Unity�������

��� ��

UNITY_MATRIX_MVP �����������������/����������������

UNITY_MATRIX_MV ���������������/����������������

UNITY_MATRIX_V �������������/����������������

UNITY_MATRIX_P �������������/����������������

UNITY_MATRIX_VP ���������������/����������������

UNITY_MATRIX_T_MV UNITY_MATRIX_MV�����



��� ��

UNITY_MATRIX_IT_MV
UNITY_MATRIX_MV�������������������������

������UNITY_MATRIX_MV����

_Object2World �������������/����������������

_World2Object _Object2World����������/����������������

�4.2�������������������������������������������

����������4.6.2��

�������������UNITY_MATRIX_T_MV�����������������

��������������������������������������������——���

����������������������������UNITY_MATRIX_MV�������

�����UNITY_MATRIX_T_MV�������������������

UNITY_MATRIX_T_MV���������������������������

UNITY_MATRIX_MV������������������4.5��������������

�������������3�����������������������

UNITY_MATRIX_MV�����������������������������������

������������������k ����UNITY_MATRIX_MV����������

�������������������������������������1���k ��������

����������������������������������������

UNITY_MATRIX_MV������  UNITY_MATRIX_T_MV����������

�������������������������������������������������

��������UNITY_MATRIX_T_MV��3��3�������������������

��������������������������������������������������

�����

����������������UNITY_MATRIX_IT_MV������4.7����

�������������������������UNITY_MATRIX_IT_MV��������

�������������������������������UNITY_MATRIX_MV����



——�����������������������������������������������

���������

// ������transpose���UNITY_MATRIX_IT_MV����� 

// ��UNITY_MATRIX_MV��������������� 

// ��������������������� 

float4 modelPos = mul(transpose(UNITY_MATRIX_IT_MV), viewPos); 

 

// �������������transpose�����mul������������� 

// ������������ 

float4 modelPos = mul(viewPos, UNITY_MATRIX_IT_MV); 

 

��mul�������������4.9.2����������

4.8.2 ��������

Unity�������������������������������������������

Camera���������4.3���Unity 5.2����������

�4.3 Unity�����������

��� �� ��

_WorldSpaceCameraPos float3 �������������

_ProjectionParams float4

x = 1.0��−1.0�����������

�����������y = Near�z =

Far�w = 1.0 + 1.0/Far���

Near�Far���������������

������

_ScreenParams float4

x = width�y = height�z =

1.0 + 1.0/width�w = 1.0 +

1.0/height���width�height

�������������render

target���������



��� �� ��

_ZBufferParams float4

x = 1− Far/Near�y =

Far/Near�z = x/Far�w =

y/Far���������Z���������

��13.1��

unity_OrthoParams float4

x = width�y = heigth�z ���

��w = 1.0�������������w

= 0.0���������������

width�height������������

��

unity_CameraProjection float4x4 ���������

unity_CameraInvProjection float4x4 �������������

unity_CameraWorldClipPlanes[6] float4
�����6�����������������

�������������������



4.9 ����

���������������������������������������������������

�����������������������������������������������

4.9.1 ��3×3��4×4�����

���������������������3×3��������������������������

������4×4����������������������4×4�������������������

������������������w ����1�������������������3×3������

����������������������

4.9.2 Cg���������

�����Unity Shader���Cg�����������Cg�����������������

�������������������������float����������

�Cg��������float3x3�float4x4����������������float3�

float4�������������������������������1×n ��������n ×1��

������������������������������������������������������

float4 a = float4(1.0, 2.0, 3.0, 4.0); 

float4 b = float4(1.0, 2.0, 3.0, 4.0); 

// ����������� 

float result = dot(a, b); 

 

����������������������������������Cg���������mul���

������

float4 v = float4(1.0, 2.0, 3.0, 4.0); 

float4x4 M = float4x4(1.0, 0.0, 0.0, 0.0, 

                      0.0, 2.0, 0.0, 0.0, 

                      0.0, 0.0, 3.0, 0.0, 

                      0.0, 0.0, 0.0, 4.0); 

// �v��������M���� 

float4 column_mul_result = mul(M, v); 

// �v��������M���� 

float4 row_mul_result = mul(v, M); 

// ���column_mul_result���row_mul_result���� 

// mul(M,v) == mul(v, tranpose(M)) 



// mul(v,M) == mul(tranpose(M), v) 

 

��������������������������������������������������

��Unity���������UNITY_MATRIX_MVP����������������������

���������������������

���������Cg�������������������Cg���float4x4���������

��������������������������������������������������3×4�

���������12�������������������������������������������

�������������(1, 2, 3, 4, 5, 6, 7, 8, 9)�����3×3�������������

����������

�������������������

Cg�������������������������������������������������

�������������������������

��������Cg�������������������������

// ������������M 

float3x3 M = float3x3(1.0, 2.0, 3.0, 

                      4.0, 5.0, 6.0, 

                      7.0, 8.0, 9.0); 

// ��M������(1.0, 2.0, 3.0) 

float3 row = M[0];  

 

// ��M��2��1������4.0 

float ele = M[1][0]; 

 

���Unity Shader��������������������Cg���������������

Cg����



������Unity�API�����Unity�������������——Matrix4x4���

���������������������Unity Shader���������������������

��

4.9.3 Unity�������ComputeScreenPos/VPOS/WPOS

���4.6.8����������������Shader����������������������

������

���/�����������������������

���������������VPOS �WPOS ��������������5.4���

VPOS�HLSL�����������WPOS�Cg�������������Unity Shader��

���������HLSL/Cg�������������/�������������������������

����������������������������/�������������������VPOS�

WPOS������������������������

fixed4 frag(float4 sp : VPOS) : SV_Target { 

    // ������������_ScreenParams.xy����������� 

    return fixed4(sp.xy/_ScreenParams.xy,0.0,1.0); 

} 

 

�������4.49���

▲�4.49 �������������



VPOS/WPOS����������float4��������������xy ����������

��������������400 x 300���x �����[0.5,400.5]�y ����

[0.5,300.5]����������������������OpenGL�DirectX 10�������

�������������0.5������zw ��������Unity��VPOS/WPOS�z ���

��[0,1]�������������z ��0���������z ��1���w �������������

������������������w ������  �Near�Far����Camera

���������������������������������������w ������1������

������������w ��������������������������������������

�viewport space� ���������������������������������(0,

0)������(1, 1)������������������xy �����������

��������Unity���ComputeScreenPos ��������

UnityCG.cginc���������������������������

ComputeScreenPos��������������������������������������

���������

struct vertOut { 

    float4 pos:SV_POSITION; 

    float4 scrPos : TEXCOORD0; 

}; 

 

vertOut vert(appdata_base v) { 

    vertOut o; 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    // �����ComputeScreenPos������scrPos� 

    o.scrPos = ComputeScreenPos(o.pos); 

    return o; 

} 

 

fixed4 frag(vertOut i) : SV_Target { 

    // �����scrPos.xy��scrPos.w���������� 

    float2 wcoord = (i.scrPos.xy/i.scrPos.w); 

    return fixed4(wcoord,0.0,1.0); 

} 

 

�����������4.49������������������������������������

��������������������������������3.6.8������������������

���������������������������������



���������������������������������[−1, 1]�NDC�������

�����[0, 1]������������ComputeScreenPos���������������

UnityCG.cginc�����ComputeScreenPos���������

inline float4 ComputeScreenPos (float4 pos) { 

    float4 o = pos * 0.5f; 

    #if defined(UNITY_HALF_TEXEL_OFFSET) 

    o.xy = float2(o.x, o.y*_ProjectionParams.x) + o.w * _ScreenParams.zw;

    #else 

    o.xy = float2(o.x, o.y*_ProjectionParams.x) + o.w; 

    #endif 

 

    o.zw = pos.zw; 

    return o; 

} 

 

ComputeScreenPos�����pos���MVP�����������������

UNITY_HALF_TEXEL_OFFSET�Unity���DirectX����������������

�������������#else����_ProjectionParams.x�������1��������

�������������−1���������������������������

��������xy ����������������������������������������

���w ���������������������ComputeScreenPos������������

�����������������������������������w �����������������

������Unity����ComputeScreenPos��������w ��������������

������������������Unity��������������������������������

�����������������������������������2.3.6���������������

��������x �y �w ����������������������  �  �������������

���������������������������������������  �  �����������

������������������������������������������������������

����������������������������������xy ����[0, 1]������

���zw ����������������������������zw ������������������

�����������������zw ��������������������z �����[-Near,

Far]�w �����[Near, Far]��������������z ����[−1, 1]��w ���1�



4.10 ����

�����������������������������������������������

����[1][2] ������������������������������������������

��������������������������������[3] ����������������

���[4] �

[1] Fletcher Dunn, Ian Parberry. 3D Math Primer for

Graphics and Game Development (2nd Edition). November

2, 2011 by A K Peters/CRC Press�

[2] Eric Lengyel. Mathematics for 3D game

programming and computer graphics (3rd Edition). 2011 by

Charles River Media�

[3] David Eberly. Conversion of Left-Handed Coordinates

to Right-Handed Coordinates�

[4]

http://www.humus.name/temp/Linearize%20depth.txt �

http://www.humus.name/temp/Linearize%20depth.txt


4.11 �����

4.2.5 �

1�������

2�(1, 0, 0)�(1, 0, 0)�������������������������������

���������������������������������������������������

�������������������������������������4.50���

▲�4.50 ��������x ��y �����������z ������������0, 0, 1�����������0, 0, 1�

����������������������

������������������������������������������������

�������z ���������������(0, 0, 1)���������(0, 0, −1)����

���������������������������y ������90°�������������

�4.51���



▲�4.51 ������������������������������������������������������������

��������������

3�−10�10�������Unity����������������������������

������z ��������������z ��10�����������������������z

���������������z ��−10�

4.3.3 �

1�

�1����������������������������������������������

���������������������

�2����

�3�����������������������������������������

a ×b =(ax ,ay ,az )×(bx ,by ,bz )

=(ay bz −az by , az bx − ax bz , ax by − ay bx )



������������������������������������������������

���������������������������������������������������

�����������

2�

�1�

�2�(12.5,10,25)

�3�(1.5,2)

�4�

�5�

�6�(10,9)

�7�(−6,1,2)

3�

4�

�1�75

�2�13

�3�13

�4�(−9,−13,7)

�5�(9,13,−7)����������4��������������������

5�

�1�12



�2�

6�

�1���������x -p �v ��������x ���NPC���������

(x −p )·v =�v ��x −p �cosθ

��θ �x -p �v �����������������0����� < 90°���x �

NPC������������0����� > 90°���x �NPC������������0��

��� = 90°���x �NPC���������

�2����

(x −p )·v =((10,6)− (4, 2))·(−3,4)=

(6,4)·(−3,4)=−18+16=−2<0

����x �NPC����

�3���������cosθ �  ������  �����  ��NPC����

�����  �����  ��NPC�������cosθ ���  ��

���  ��������

�4�������������������p ��������������

7��u =p 2 -p 1 �v = p 3 - p 1 ��������xy�������

u =(ux ,uy ,0), v =(vx ,vy ,0)

�������

u ×v =(0,0,ux vy −uy vx )

��������ux vy −uy vx �����������������������������

��3����������������������������4.52���



▲�4.52 �������������������3����������

4.4.6 ��

1.

�1�

�2������������������������������������������2×3

�4×2��������

�3�



2�

�1����������������������������������������������

���������

�2�������

�3���������������z ���° ������

3�

�1�

������������(3,2,6)������������������������������

�����������

�2�

������������������������������������������������

�������������������



�3�

������������(22,−11,27)���������������������

�symmetric matrix� ��������������������������������



�2� ���

�����������������Unity Shader����������������

Shader�����Shader����������������������������������

�������Unity Shader��������������������������������

������������������������9���������������Unity

Shader�

�5� ��Unity Shader����

������������/���������������������������Unity

Shader������������

�6� Unity������

��������Shader����������������������

�7� ����

����������Unity Shader������������������

�8� ����

���������������������Unity����������������������

������������������������������



�5� ��Unity Shader����

�������� 2 �——�������������������������Unity

Shader��������������������������������������Unity��

�Unity Shader�

���������5.1��������������������Unity�����������

�����������������������5.2���������������/���������

�������/�����������5.3����Unity���Unity Shader�������

��������������������5.4�������Unity Shader����Cg����

���������������5.5�����������Unity Shader�����5.6���

������Unity Shader�������5.7���������Unity Shader����

�������������������������������������



5.1 ����������

�����Unity���Unity 5.2.1�����������Unity����������

�������������Unity���������������������������������

�����Unity�����������Unity��������������������������

�����������������Unity����������������������������

���������������������19.3����������Unity�����������

��������������UnityObjectToWorldNormal��������������

��������������Unity 5����������������Unity 5��������

����������������������Unity 4.x�����Unity 5.x��������

����������������������������������������Unity 4.x��

��������������������

������������Mac OS X 10.9.5���������������������

���������������������������������������Mac��������

����OpenGL��������Windows�������DirectX�����

OpenGL�������Render Texture��(0, 0)���������DirectX��

(0, 0)��������5.6����������������������



5.2 ��������/�����

���������������Unity Shader����������������/����

��

5.2.1 ��/����������

���3.3������Unity Shader����������Shader �

Properties �SubShader �Fallback �������/���������������

�������

Shader "MyShaderName" { 

    Properties { 

        // �� 

    } 

    SubShader { 

        // ����A�SubShader 

        Pass { 

            // ��������� 

 

            // ��Cg���� 

            CGPROGRAM 

            // �������������� 

            #pragma vertex vert 

            #pragma fragment frag 

 

            // Cg������ 

 

            ENDCG 

 

            // ���� 

        } 

        // �����Pass 

    } 

    SubShader { 

        // ����B�SubShader 

    } 

 

    // ��SubShader���������Unity Shader 

    Fallback "VertexLit" 

} 

 



����������Pass ���������������������������������

���������/������

�1�������������Scene_5_2��Unity 5������5.1�����

▲�5.1 �Unity 5������������

����������������������������������������������

�Skybox�������Unity 5.x�����������������Unity��������

��������������������������������Unity�������Window -

> Lighting -> Skybox������������Unity 4.x��������������

�������

�2�����Unity Shader������Chapter5-SimpleShader�

�3�������������SimpleShaderMat���2�����Unity

Shader����

�4�����������������Game���������������3��������

����



�5������2�����Unity Shader����������������������

Shader "Unity Shaders Book/Chapter 5/Simple Shader" { 

    SubShader { 

        Pass { 

            CGPROGRAM 

 

            #pragma vertex vert 

            #pragma fragment frag 

 

            float4 vert(float4 v : POSITION) : SV_POSITION { 

                return mul (UNITY_MATRIX_MVP, v); 

            } 

 

            fixed4 frag() : SV_Target { 

                return fixed4(1.0, 1.0, 1.0, 1.0); 

            } 

 

            ENDCG 

        } 

    } 

} 

 

�����Unity�����

������������5.2���



▲�5.2 ���������/�������������

������������������/���������������������

�����������Shader �������Unity Shader���——“Unity

Shaders Book/Chapter 5/Simple Shader”�����������������

�����Shader���������Unity Shader��������������������

��Properties ����Properties �������������������������

��������SubShader �Pass �������������������������

�����SubShader �����������������SubShader ����������

��Pass ����Pass �������������������������

������CGPROGRAM �ENDCG ����CG����������������

�����������������

#pragma vertex vert 

#pragma fragment frag 

 

�����Unity��������������������������������������

��������



#pragma vertex name 

#pragma fragment name 

 

��name �����������������������vert�frag���������

����������������vert�frag�����������������

�����������vert������

float4 vert(float4 v : POSITION) : SV_POSITION { 

    return mul (UNITY_MATRIX_MVP, v); 

} 

 

�������������������������vert�����v�������������

��POSITION ��������������float4���������������������

POSITION �SV_POSITION ��Cg/HLSL���� �semantics� ����

�����������������������������������������POSITION ��

�Unity����������������v��SV_POSITION ���Unity��������

���������������������������������������������������

����������������5.4��������������������������������

���������������������������������������������������

�����UNITY_ MATRIX_MVP���Unity�����·��·��������4.8���

�����

����������frag���

fixed4 frag() : SV_Target { 

    return fixed4(1.0, 1.0, 1.0, 1.0); 

} 

 

�����frag����������������fixed4�����������

SV_Target �������SV_Target ��HLSL��������������������

�����������������render target�����������������������

�����������������fixed4������������������������[0,

1]���(0, 0, 0)������(1, 1, 1)�����



�������������/����������������������������������

���������������������������������������/������

5.2.2 ��������

�������������������POSITION ��������������������

���������������

������������������������������������������������

���������������������������������������������������

�����������������������

Shader "Unity Shaders Book/Chapter 5/Simple Shader" { 

    SubShader { 

        Pass { 

            CGPROGRAM 

 

            #pragma vertex vert 

            #pragma fragment frag 

 

            // ������������������ 

            struct a2v { 

                // POSITION����Unity�������������vertex�� 

                float4 vertex : POSITION; 

                // NORMAL����Unity�������������normal�� 

                float3 normal : NORMAL; 

                // TEXCOORD0����Unity��������������texcoord�� 

                float4 texcoord : TEXCOORD0; 

            }; 

 

            float4 vert(a2v v) : SV_POSITION { 

                // ��v.vertex������������ 

                return mul (UNITY_MATRIX_MVP, v.vertex); 

            } 

 

            fixed4 frag() : SV_Target { 

                return fixed4(1.0, 1.0, 1.0, 1.0); 

            } 

 

            ENDCG 

        } 

    } 

} 

 



��������������������a2v�������������������a2v���

���������Unity�������NORMAL �TEXCOORD0 �����������

���������������Unity���������������������������Unity

�������POSITION, TANGENT �NORMAL �TEXCOORD0 �

TEXCOORD1 �TEXCOORD2 �TEXCOORD3 �COLOR ��

�����������������������������

struct StructName { 

    Type Name : Semantic; 

    Type Name : Semantic; 

    ....... 

}; 

 

���������������5.4�������������������

��������vert������������������������a2v���������

�������������������������

���a2v����������

���a�����application��v��������vertex shader��a2v��

���������������������

������POSITION �TANGENT �NORMAL ���������������

����Unity������������Mesh Render �����������Draw Call

����Mesh Render �����������������Unity Shader��������

���������������������3����������������������������

������������������������������������������������

5.2.3 �����������������

������������������������������������������������

��������������������

���������������������������



Shader "Unity Shaders Book/Chapter 5/Simple Shader" { 

    SubShader { 

        Pass { 

            CGPROGRAM 

 

            #pragma vertex vert 

            #pragma fragment frag 

 

            struct a2v { 

                float4 vertex : POSITION; 

                float3 normal : NORMAL; 

                float4 texcoord : TEXCOORD0; 

            }; 

 

            // ������������������ 

            struct v2f { 

                // SV_POSITION����Unity�pos����������������� 

                float4 pos : SV_POSITION; 

                // COLOR0������������ 

                fixed3 color : COLOR0; 

            }; 

 

            v2f vert(a2v v) : SV_POSITION { 

                // ������ 

                v2f o; 

                o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

                // v.normal�����������������[-1.0, 1.0] 

                // ��������������[0.0, 1.0] 

                // ���o.color��������� 

                o.color = v.normal * 0.5 + fixed3(0.5, 0.5, 0.5); 

                return o; 

            } 

 

            fixed4 frag(v2f i) : SV_Target { 

                // �����i.color������ 

                return fixed4(i.color, 1.0); 

            } 

 

            ENDCG 

        } 

    } 

} 

 

��������������������v2f�v2f���������������������

����v2f������������������������SV_POSITION �COLOR0



�����������������������������SV_POSITION ����������

���������������������������COLOR0 �����������������

����������������������������������������COLOR1 ����

����5.4��

������������������������������������������������

���������������������������������������������

5.2.4 ������

�3.1.1������������Unity Shader��������������������

����Unity Shader������������������������������������

��Properties�����

������������������������������������������������

������������������

Shader "Unity Shaders Book/Chapter 5/Simple Shader" { 

    Properties { 

        // ����Color����� 

        _Color ("Color Tint", Color) = (1.0,1.0,1.0,1.0) 

    } 

    SubShader { 

        Pass { 

            CGPROGRAM 

 

            #pragma vertex vert 

            #pragma fragment frag 

 

            // �Cg�������������������������� 

            fixed4 _Color; 

 

            struct a2v { 

                float4 vertex : POSITION; 

                float3 normal : NORMAL; 

                float4 texcoord : TEXCOORD0; 

            }; 

 

            struct v2f { 

                float4 pos : SV_POSITION; 

                fixed3 color : COLOR0; 

            }; 

 



            v2f vert(a2v v) : SV_POSITION { 

                v2f o; 

                o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

                o.color = v.normal * 0.5 + fixed3(0.5, 0.5, 0.5); 

                return o; 

            } 

 

            fixed4 frag(v2f i) : SV_Target { 

                fixed3 c = i.color; 

                // ��_Color��������� 

                c *= _Color.rgb; 

                return fixed4(c, 1.0); 

            } 

 

            ENDCG 

        } 

    } 

} 

 

���������������Properties ����������������_Color��

����Color�����(1.0,1.0,1.0,1.0)���������Cg�������������

��Cg�����������������������������Properties ���������

����

ShaderLab�������Cg���������������5.1���

�5.1 ShaderLab�����Cg���������

ShaderLab���� Cg����

Color�Vector float4, half4�fixed4

Range�Float float�half�fixed

2D sampler2D

Cube samplerCube



ShaderLab���� Cg����

3D sampler3D

�����������Cg�������uniform�������

uniform fixed4 _Color; 

 

uniform����Cg�����������������������������������

��������������������������uniform�������������Unity

Shader��uniform����������



5.3 ������Unity����������

���������Unity����������/�����������/������������

���������“����”������������������������������������

����Unity������������������������������������������

���Unity Shader�������������������������������������

�������������Unity�������������

����������������

5.3.1 �������

���� �include file� �����C++�����������Unity�����

�����.cginc����Shader��������#include���������������

������Unity������������������������

CGPROGRAM 

// ... 

#include "UnityCG.cginc" 

// ... 

ENDCG 

 

����������������������http://unity3d.com/cn/get-

unity/download/ archive ������ -> ����� �����������5.3��

�������������

▲�5.3 Unity������

��5.3���������������������������CGIncludes������

�����������DefaultResources��������������������Unity

Shader�����GUI�����Shader�DefaultResourcesExtra������

http://unity3d.com/cn/get-unity/download/archive


Unity����Unity Shader�Editor���������������������Unity

5���Standard Shader����18��������������������������

��������������������������������������������������

�CGIncludes����������

������Unity����������CGIncludes�����Mac�������

��/Applications/Unity/Unity.app/Contents/CGIncludes��

Windows���������Unity�����/Data/CGIncludes�

�5.2���CGIncludes������������������

�5.2 Unity����������

� � � � �

UnityCG.cginc �������������������

UnityShaderVariables.cginc
���Unity Shader���������������������

����UNITY_MATRIX_MVP�

Lighting.cginc
�������������������Surface Shader���

�������

HLSLSupport.cginc
���Unity Shader���������������������

�������

�������������������#include �������������������

UnityShaderVariables.cginc��������������������

UNITY_MATRIX_ MVP�������������5.2����������Unity 5��

��������������UnityStandardBRDF.cginc�

UnityStandardCore.cginc�������������������������18���

������



UnityCG.cginc�����������������������������������

������������������������������UnityCG.cginc���������

��������������5.3������������������

�5.3 UnityCG.cginc���������

� � � � �����

appdata_base ����������� �����������������

appdata_tan ����������� ����������������������

appdata_full ����������� ��������������������������

appdata_img ����������� ������������

v2f_img ����������� �������������

��������UnityCG.cginc���������������������������

��Unity�������������

�������UnityCG.cginc���������������5.4�����������

����

�5.4 UnityCG.cginc����������

� � � � �

float3 WorldSpaceViewDir

(float4 v)

���������������������������������

�



� � � � �

float3 ObjSpaceViewDir

(float4 v)

���������������������������������

�

float3 WorldSpaceLightDir

(float4 v)

��������� �����������������������

������������������

float3 ObjSpaceLightDir

(float4 v)

��������� �����������������������

������������������

float3

UnityObjectToWorldNormal

(float3 norm)

������������������

float3 UnityObjectToWorldDir

(float3 dir)
������������������

float3

UnityWorldToObjectDir(float3

dir)

������������������

�������UnityCG.cginc����������������������������

���������UnityObjectToWorldDir�UnityWorldToObjectDir���

��������������������������UnityCG.cginc�������������

����UnityCG.cginc�������������������������

5.3.2 �����

���4.8�����������������������������Unity��������

�����������������������������UnityShader

Variables.cginc����������������Lighting.cginc�

AutoLight.cginc��������������������������������



5.4 Unity���Cg/HLSL��

������Shader�����������������������������������

����������������5.2����SV_POSITION �POSITION �COLOR

0�����������������������

5.4.1 �����

�������Cg/HLSL����� �semantics� ����������

Cg/HLSL��������������������������DirectX���

�https://msdn.microsoft.com/ en-

us/library/windows/desktop/bb509647(v=vs.85).aspx#VS

.aspx#VS)��������������������������������������

Shader��������������������������������������Shader�

����������������������Cg/HLSL�Shader���������������

���Unity�����������

�����������������������������������������������

������������������������COLOR 0�����color���color���

�������Shader��������

�Unity������������������������������������������

��a2v�TEXCOORD 0���texcoord�Unity���TEXCOORD 0����

��������������texcoord�����������������������������

���������TEXCOORD 0������������������a2v���������

���v2v��������a2f��TEXCOORD 0���������������������

�������������v2f��TEXCOORD 0�����������������

�DirectX 10���������������������� �system-value

semantics� �������SV����SV����������� �system-

value� ���������������������������������SV_POSITION

���������������pos������pos�����������������������

��������������������������������������������������

��������SV_POSITION �������������������������������

�����Shader������������������Shader���POSITION ��

https://msdn.microsoft.com/en-us/library/windows/desktop/bb509647(v=vs.85


SV_POSITION ������������SV_POSITION �DirectX 10������

����������������POSITION ������������������ PS4����

��SV_POSITION �����������������Shader������������

COLOR �SV_Target ����������Shader������������������

����������SV�������������5.6����������������������

5.4.2 Unity�����

�5.5���������������������Unity������������������

SV����Unity�������������

�5.5 ������������������Unity�������

� � � �

POSITION ��������������float4��

NORMAL ��������float3��

TANGENT ��������float4��

TEXCOORDn ��

TEXCOORD0�TEXCOORD1

���������TEXCOORD0���������������

���float2�float4��

COLOR ��������fixed4�float4��

��TEXCOORDn �n �����Shader Model���������Shader

Model 2��Unity������Shader Model����Shader Model 3��n

��8���Shader Model 4�Shader Model 5��n ��16����������

�������������2���������TEXCOORD0�TEXCOORD1��

Unity��������appdata_full��������6�������

�5.6�������������������Unity��������



�5.6 �����������������Unity�������

� � � �

SV_POSITION
����������������������������������DirectX 9��

POSITION������SV_POSITION

COLOR0 ��������������������

COLOR1 ��������������������

TEXCOORD0�

TEXCOORD7
�����������������

���������SV_POSITION ���������������������������

��������������������������������������������������

����������TEXCOORD 0��

�5.7���Unity���������������

�5.7 ��������Unity�������

� � � �

SV_Target
�������������render target������DirectX 9��COLOR����

����SV_Target

5.4.3 �����������

����������������������������fixed2�float�float4�

fixed4�����������������������������



struct v2f { 

    float4 pos : SV_POSITION; 

    fixed3 color0 : COLOR0; 

    fixed4 color1 : COLOR1; 

    half value0 : TEXCOORD0; 

    float2 value1 : TEXCOORD1; 

}; 

 

�����������������5.7.1��������������������������

������4�����float�������������������float3×4�float4×4

�������������������������������������float4×4������

�������4�float4����������������������



5.5 �������Debug

��������������������

> ����������������

> ����������������bug��

�� �debug� ����������������������Shader������������������

Shader�������——��������������������������������������������

Shader���������������������������

������Unity��Unity Shader�����������������

5.5.1 �������

����� �false-color image� ����������������������������������

�� �true-color image� ����������������������������Shader������

���������������������[0, 1]���������������������������������

���������������������“��������������”�������������������������

�����������������������������

�����������������[0, 1]�������������������������������������

������[0, 1]�������������������������������Shader��������������

����������������������1���������1������0��������0�������������

������������������������0�1����

�����������������������������������R������������������0���

��������������������������������������

�����������������������������������������������������������

������������

Shader "Unity Shaders Book/Chapter 5/False Color" { 

    SubShader { 

        Pass { 

            CGPROGRAM 

 

            #pragma vertex vert 

            #pragma fragment frag 

 

            #include "UnityCG.cginc" 

 

            struct v2f { 

                float4 pos : SV_POSITION; 

                fixed4 color : COLOR0; 



            }; 

 

            v2f vert(appdata_full v) { 

                v2f o; 

                o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

                // ������� 

                o.color = fixed4(v.normal * 0.5 + fixed3(0.5, 0.5, 0.5), 1.0); 

 

                // ������� 

                o.color = fixed4(v.tangent.xyz * 0.5 + fixed3(0.5, 0.5, 0.5), 1.0); 

 

                // �������� 

                fixed3 binormal = cross(v.normal, v.tangent.xyz) * v.tangent.w; 

                o.color = fixed4(binormal * 0.5 + fixed3(0.5, 0.5, 0.5), 1.0); 

 

                // ���������� 

                o.color = fixed4(v.texcoord.xy, 0.0, 1.0); 

 

                // ���������� 

                o.color = fixed4(v.texcoord1.xy, 0.0, 1.0); 

 

                // ��������������� 

                o.color = frac(v.texcoord); 

                if (any(saturate(v.texcoord) - v.texcoord)) { 

                    o.color.b = 0.5; 

                } 

                o.color.a = 1.0; 

 

                // ��������������� 

                o.color = frac(v.texcoord1); 

                if (any(saturate(v.texcoord1) - v.texcoord1)) { 

                    o.color.b = 0.5; 

                } 

                o.color.a = 1.0; 

 

                // ������� 

                //o.color = v.color; 

 

                return o; 

            } 

 

            fixed4 frag(v2f i) : SV_Target { 

                return i.color; 

            } 

 

            ENDCG 

        } 

    } 

} 

 

�������������Unity��������——appdata_full ����5.3������������

����UnityCG.cginc��������

struct appdata_full { 

    float4 vertex : POSITION; 



    float4 tangent : TANGENT; 

    float3 normal : NORMAL; 

    float4 texcoord : TEXCOORD0; 

    float4 texcoord1 : TEXCOORD1; 

    float4 texcoord2 : TEXCOORD2; 

    float4 texcoord3 : TEXCOORD3; 

#if defined(SHADER_API_XBOX360) 

    half4 texcoord4 : TEXCOORD4; 

    half4 texcoord5 : TEXCOORD5; 

#endif 

    fixed4 color : COLOR; 

}; 

 

�����appdata_full�������������

��������������������������——v2f��color�������������������

������������������������������������5.4�����������������������

���������������������Unity������

�������������������������������������RGBA�����������������

��������������������������Assets -> Scripts -> Chapter 5 ->

ColorPicker.cs �������������������������������������������5.5���

▲�5.4 �����Unity Shader����



▲�5.5 ��������������

5.5.2 �����Visual Studio

���Windows������Mac������Visual Studio��Windows����������

Visual Studio 2012��������Unity Shader�����——Graphics Debugger �

��Graphics Debugger����������������������������������������

���������������������Unity������� Visual Studio � DirectX 11 �

Shader ���� ���http://docs.unity3d.com/Manual/SL-Debugging

D3D11ShadersWithVS.html ��

����������������������Unity���DirectX 11������Graphics

Debugger������bug������������������Mac��������������

5.5.3 ���������

��Mac������Visual Studio������������Unity 5�������UI����������

�������������——���� �Frame Debugger� ���������������Unity���

�����������������������������������������

���������������Window -> Frame Debugger ������������5.6���

http://docs.unity3d.com/Manual/SL-DebuggingD3D11ShadersWithVS.html


▲�5.6 ����

������������������������ �event� ��������Draw Call����������

�������������������3��������������/�����Enable����������������

��������������������������������������������������������������

��������������������������������������������������������������

Draw�����������Draw Call���������������������������������������

�������Shader�����Game�����������������������Draw Call��������

���GameObject�����GameObject���Hierarchy������������5.7�������

��������������



▲�5.7 ��Knot����������Game�������������Hierarchy��������Knot����������������������

�

������Draw Call���������RenderTexture��������������������

Game���������������������������������Game�������R�G�B�A���

Unity 5������������������������frame capture��������������� �

�������������������������4�Draw Call��������������4�Draw Call���

������������������������������������������������������5.5.2���

Visual Studio�����Intel GPA�RenderDoc�NVIDIA NSight�AMD GPU

PerfStudio����



5.6 ����������

Unity��������������——������������������������Unity�����

���������������������������������������������

5.6.1 ���������

�2.3.4��4.2.2���������OpenGL�DirectX���������������������

���������������������������OpenGL�OpenGL ES�����(0, 0)�����

��������DirectX�Metal�����(0, 0)���������5.8������������������

▲�5.8 OpenGL�DirectX������������

���������������������������������������Render Target����

�������������Render Texture����������������12��������������

�������������������������������������������������������

�������������������������������Unity���������������——��

DirectX��������������Unity���������������������������

��������Unity������������������������������Edit -> Project

Settings -> Quality -> Anti Aliasing��������������������������

Unity�����������������������������������������������DirectX�

������������������Unity�������������������������DirectX����

�������������������������������������������������

Graphics.Blit����Unity����������������������������������������

�����������������������������������������������������������

��������������DirectX���������������������������������������

����������������������������������DirectX���������



#if UNITY_UV_STARTS_AT_TOP 

if (_MainTex_TexelSize.y &; 0) 

        uv.y = 1-uv.y; 

#endif 

 

���UNITY_UV_STARTS_AT_TOP�����������DirectX�������������

����������������������������������������������������������

_MainTex_TexelSize.y����0������������������������������������

�����������������13������������

�����������������������12������������������������������

�������������������������������Unity���������������12.5�����

�����Pass����������������������Bloom�������������������

DirectX�����������������������������������������������������

�������13������������������/�������������������������������

�������������15.3�����������Pass���������������������������

�����������������������������������������������������������

������������������������������������������������

5.6.2 Shader�����

���Windows��������Mac��������Shader�����������������

incorrect number of arguments to numeric-type constructor (compiling for d3d11) 

 

��

output parameter 'o' not completely initialized (compiling for d3d11) 

 

���������DirectX 9/11�Shader����������������������������

Shader�������������

// v�float4��������������������� 

float4 v = float4(0.0); 

 

�OpenGL��������������������4�����0.0�float4��������

DirectX 11������������������������������������

float4 v = float4(0.0, 0.0, 0.0, 0.0); 

 



����������������������������������������������������out�

�����������������������������������������������������������

������������������

void vert (inout appdata_full v, out Input o) { 

    // ��Unity���UNITY_INITIALIZE_OUTPUT�������o����� 

    UNITY_INITIALIZE_OUTPUT(Input,o); 

    // …  

} 

 

������������DirectX 9 / 11�������������tex2D���tex2D������

���������������������������DirectX 9 / 11���������tex2D������

��������Shader����UV����tex2D������������������������������

������������������������tex2Dlod��������

tex2Dlod(tex, float4(uv, 0, 0)). 

 

���������#pragma target 3.0���tex2Dlod�Shader Model 3.0���

��

5.6.3 Shader�����

���5.4����Shader��������������������������������

SV_POSITION �POSITION �����������������������Shader���������

���������������������Shader��������

��SV_POSITION ������������������Shader���POSITION ������

Shader�����PS4���������������������

��SV_Target ����������������Shader���COLOR��COLOR0 �����

����Shader�����PS4������

5.6.4 ������

�����������������������������������������Shader���A����

������B����������Unity�����http://docs. unity3d.com/Manual/SL-

PlatformDifferences.html ����������

http://docs.unity3d.com/Manual/SL-PlatformDifferences.html


5.7 Shader����

�������������������Shader��������������������������������������������

����������������������������������������

5.7.1 float�half��fixed

���������Cg/HLSL���Unity Shader�������Cg/HLSL���3���������float�half�

fixed�������������������5.8����3���������������

�5.8 Cg/HLSL�3��������

� � � �

float �������������32����

half �������������16����������−60 000�+60 000

fixed �������������11����������−2.0�+2.0

�������������������������GPU����������������������������

��������GPU�������������������������float�half�fixed��������������������

�PC�������half�fixed���������

�������GPU�����������������������������������������������������������

��Shader�

fixed���������������������������GPU�������fixed�half����������

��������������������������������������Shader�������������������������

������������fixed�����������������������������half�������������float�������

��������������������������Shader���������������������������16���������

5.7.2 ����

�5.6.2������DirectX���Shader�������������������������DirectX������������

�������������������������������

5.7.3 ��������

����������Shader�������������������������������Unity������

temporary register limit of 8 exceeded 

 

�

Arithmetic instruction limit of 64 exceeded; 65 arithmetic instructions needed to compile program

 



����������������Shader�����������������������������������������������

��Shader Target��������������������������������

����������������Shader Target���������5.9���Unity�������Shader Target�

�5.9 Unity���Shader Target

� � � �

#pragma target

2.0

���Shader Target������Direct3D 9��Shader Model 2.0�������������������LOD

�����

#pragma target

3.0
���Direct3D 9��Shader Model 3.0������������

#pragma target

4.0
���Direct3D 10��Shader Model 4.0���������

#pragma target

5.0
���Direct3D 11��Shader Model 5.0

���������Unity������Unity���Shader Target��������������������������

������Shader Model��

���Shader Model������������������������Shader������feature����

�capability������������Shader����������������������Shader Model�����Shader�

���������������������������

�������Shader Target�����������������������������������Shader����������

��������������

5.7.4 ���������

����������������������������������������������Shader���������������

�����GPU�����������������������������GPU��������������if-else�for�while

����������������GPU������CPU�������������������������������������������

�������������GPU������CPU����������������������������������������������

�����������Shader�����������������GPU��������������GPU���������

�����Shader������������������Shader����������������������������������

�������������������������������CPU��������������Shader������������������

����������������

����������������������Shader������������

������������������

������������

5.7.5 ����0



������C#����������������������0��������������������������������Shader

�������������

������Shader��������

fixed4 frag(v2f i) : SV_Target 

{ 

    return fixed4(0.0/0.0,0.0/0.0, 0.0/0.0, 1.0); 

} 

 

����������������������������������Shader�����������������������������

���������1.0����������������������Shader���������������������������������

�����������������������

����������������0����������0��������������������if����������0���������

���������������0.000001�������0��������������



5.8 ����

������GPU��2���GPU ���� ��[1] ������������������

GPU��������5.7.3������Shader���������������������

Shader Model����������������������������������/����

�������������������Wiki�����[2] �HLSL���[3]���������

[1]Mark Harris, Ian Buck. "GPU Flow-Control Idioms." In

GPU Gems 2. ����GPU��2����������������������������

��2007��

[2]High-Level Shading Language�Wiki

�https://en.wikipedia.org/wiki/High-Level_Shading_Language

��

[3]Shader Models vs Shader Profiles�HLSL��

�https://msdn.microsoft.com/en-

us/library/windows/desktop/bb509626(v=vs.85).aspx ��

https://en.wikipedia.org/wiki/High-Level_Shading_Language
https://msdn.microsoft.com/en-us/library/windows/desktop/bb509626(v=vs.85).aspx


�6� Unity������

�����������������������������������������������

�������������������������������������������������

������6.1��������������������������������������

�������6.2�����������������������Unity Shader�������

���6.3������������������������6.4��6.5�������������

��������������������������6.6��������Unity���������

����������

����������� �������������������Shader�����������

����������������������������9.5�������������������

Unity Shader�



6.1 ������������

����������������“�����������”�������������������

����������������������“��������”�������������������

���������������������������������������������������

���������������

�����������������������������3������

�������� �light source� �������

�������������������������������������������

���������������������

���������������������

6.1.1 ��

������������������������������������������������

�l �������������������������������������������������

������� �irradiance� ���������������������������l ���

���������������������������������������������������

�l ��������������������������������l �����n ���������

�����������������������1��6.1���������������

▲�6.1 ��������������������������������������������������������������

��d/cos���������������������



����������������������d /cos������������cos ����

cos ��������l �����n ������������������������

6.1.2 �����

����������������������������������� �scattering�

��� �absorption� �

�����������������������������������������������

������������������������������������������

�refraction� ��� �transmission� ���������������������

�reflection� ���������������������������������������

���������������������������������������������������

����������6.2�����������

▲�6.2 ��������������������������������������������������������������

�����������������������������������������

�specular� ��������������������� �diffuse� ����������

���������������������������������������������������

�� �exitance� ��������������������������������������

���������



������������������������������������������������

�����������������

6.1.3 ��

�� �shading� ����������������������������������

����������������������������������������� �Lighting

Model� ��������������������������������������������

6.1.4 BRDF����

������������������������������������������������

���������������������������������������������������

������BRDF�Bidirectional Reflectance Distribution

Function� ��������������������������BRDF�����������

����������BRDF������������������������������������

����������������BRDF�������������������������BRDF�

���������������������������������������������������

�����������������������������������������������3D��

�����������������3D Math Primer For Graphics And Game

Development��������������������

������������������������������

������������������������������������BRDF�������

�18�����������������������



6.2 ������

������������������������������������������������

�����BRDF������������������������

�1975����������Bui Tuong Phong�������������������

�������������direct light�����������������������������

������������������

���������������������4������������������������4�

����

��� �emissive� ������� c emissive ������������������

����������������������������������������global

illumination�������������������������������������

��

���� �specular� ������� c specular ������������������

������������������������������

��� �diffuse� ������� c diffuse ���������������������

������������������������

��� �ambient� ������� c ambient �������������������

6.2.1 ���

��������������������������������������� �indirect

light� ���������������������������������������������

���������������������������������������������������

��������������������������

������������������������������������������������

��������������������������������������������



6.2.2 ���

������������������������������������������������

���������������������������������

������������������������������������������������

Unity 5��������������������������������������18�����

6.2.3 ���

������������������������������������������������

��������������������������������������������������

��

������������ �Lambert’s law� �������������������

�������������������������

���  ������  ����������� m diffuse ���������� c light ��

���������������������������������������������������

��0�������������������

6.2.4 ����

������������������������������������������������

���������������������������������������

������������������������������������������������

������������6.3����������



▲�6.3 ��Phong��������

��������������������3������������——�����������

������

����������Phong�������������

��� m gloss ������� �gloss� �������� �shininess� ���

��������“��”���� m gloss ��������� m specular �����������

��������������������� c light ���������������������  ·

�������

����Phong�����Blinn�����������������������������

��������  ����Blinn�����������  ������  �  .����������

����



�����  �  ������������  �  ��������6.4���

▲�6.4 Blinn��

�����Blinn��������

�������������������������Blinn�����Phong��������

������  �  �������  �����������  ��  ������Phong�����

���������������������������������������Blinn����“��

�”Phong�����������������Blinn����������



6.2.5 ��������

������������������������������������������������

����������������������� �per-pixel lighting� ���������

����������� �per-vertex lighting� �
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��������������������������������������������Phong �

� �Phong shading� �����Phong�����������������������

Phong�����

��������������������� �Gouraud shading� �������

���������������������������������������������������
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6.2.6 ��

������������������������������������������������

���������������������������������������������������

�����������������Phong ���� �������Bui Tuong Phong��
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���������������Blinn-Phong ���� �

����������������������������Blinn-Phong����������

���� �Fresnel reflection� ����Blinn-Phong�������

�isotropic� ����������������������������������������

���������� �anisotropic� �������������������18������

�������������������������������������������



6.3 Unity���������

�������������������������

�Unity������������Window -> Lighting ->Ambient

Source/Ambient Color/Ambient Intensity ������6.5����

Shader���������Unity�����UNITY_LIGHTM ODEL_AMBIENT

�����������������

▲�6.5 �Unity�Window -> Lighting ����������Ambient Source/Ambient

Color/Ambient Intensity ����������������

��������������������������Shader���������������

��������������������������������������������������

��



6.4 �Unity Shader����������

����������������������Unity������������������������������������

�6.2.3��������������������������

������������������4�������������� c light ��������� m diffuse �����  ������

�

������������������max����Cg����������������Cg�����������������

saturate���

�� �saturate(x )

�� �x ����������������float�float2�float3����

�� ��x ���[0, 1]������x �������������������������

6.4.1 ��������

����������������������������������������6.6�����

▲�6.6 �����������

��������������

�1��Unity��������������������Scene_6_4��Unity 5.2����������������������

����������������Window -> Lighting -> Skybox������������

�2��������������������DiffuseVertexLevelMat�



�3�����Unity Shader���������Shader��Chapter6-DiffuseVertexLevel����Shader

���2��������

�4����������������2������������

�5������

������������Shader������������������3�����Unity Shader����������������

��

�1�����������Shader������

Shader "Unity Shaders Book/Chapter 6/Diffuse Vertex-Level" { 

 

�2�����������������������Shader�Properties ���������Color���������������

���

Properties { 

    _Diffuse ("Diffuse", Color) = (1, 1, 1, 1) 

} 

 

�3�������SubShader ���������Pass ����������/������������Pass ������

SubShader �����������Pass��������Pass������

SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�������������9������������������

����������������LightMode���������Unity����������������_LightColor0�

�4��������CGPROGRAM �ENDCG ���Cg��������������������������������

#pragma�����Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6����Shader���Properties �������������������������������

fixed4 _Diffuse; 

 

����������������������������——�������������������0�1�����������fixed�

���������



�7����������������������������������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    fixed3 color : COLOR; 

}; 

 

���������������a2v�����normal��������NORMAL�����Unity��������������

normal�������������������������������������v2f�����color�����������COLOR�

����������TEXCOORD0���

�8�����������������������������������������������������������

v2f vert(a2v v) { 

    v2f o; 

    // Transform the vertex from object space to projection space 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    // Get ambient term 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    // Transform the normal fram object space to world space 

    fixed3 worldNormal = normalize(mul(v.normal, (float3x3)_World2Object)); 

    // Get the light direction in world space 

    fixed3 worldLight = normalize(_WorldSpaceLightPos0.xyz); 

    // Compute diffuse term 

    fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * saturate(dot(worldNormal, worldLight)); 

 

    o.color = ambient + diffuse; 

 

    return o; 

} 

 

���������������o����������������������������������������������������

Unity�����*��*����UNITY_MATRIX_MVP�������������������Unity�����

UNITY_LIGHTMODEL_AMBIENT���������

��������������������������������������4���������������������������

_Diffuse������v.normal�������������������������Unity�����������_LightColor0��

��Pass��������������������������������LightMode������������

_WorldSpaceLightPos0������������������������������������������������������

������������������������������������_WorldSpaceLightPos0���������������6.6

������������������������

���������������������������������������������������������������������

�����a2v��������������������������������������4.7������������������������

��������������������������������������_World2Object���������mul����������

���������������������������������_World2Object����������

��������������������������������������������������������������������

saturate���saturate���Cg���������������������[0, 1]�������������������������

��������������������



�����������������������������

�9�����������������������������������������������������

fixed4 frag(v2f i) : SV_Target { 

    return fixed4(i.color, 1.0); 

} 

 

�10�����������Unity Shader���shader������Diffuse�

Fallback "Diffuse" 

 

���������������������������������������������������������������������

����������������������������6.6������������������������������������������

�������

6.4.2 ��������

������Shader�����������������������6.7���

▲�6.7 �����������

��������������

�1���6.4.1��������

�2��������������������DiffusePixelLevelMat�

�3�����Unity Shader���������Shader��Chapter6-DiffusePixelLevel����Shader��

�2��������

�4���2�������������



Chapter6-DiffusePixelLevel����6.4.1����������������6.4.1����������Chapter6-

DiffusePixelLevel����������

�1��������������v2f�

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

}; 

 

�2���������������������������������������

v2f vert(a2v v) { 

    v2f o; 

    // Transform the vertex from object space to projection space 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    // Transform the normal fram object space to world space 

    o.worldNormal = mul(v.normal, (float3x3)_World2Object); 

 

    return o; 

} 

 

�3������������������

fixed4 frag(v2f i) : SV_Target { 

    // Get ambient term 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    // Get the normal in world space 

    fixed3 worldNormal = normalize(i.worldNormal); 

    // Get the light direction in world space 

    fixed3 worldLightDir = normalize(_WorldSpaceLightPos0.xyz); 

 

    // Compute diffuse term 

    fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * saturate(dot(worldNormal, worldLightDir));

 

    fixed3 color = ambient + diffuse; 

 

    return fixed4(color, 1.0); 

} 

 

��������6.4.1�������������

���������������������������������������������������������������������

������������������������������������������������������������������������

������������������������������������� �Half Lambert� ���� �

6.4.3 ������

�6.4.1��������������������������������������——����������������������

�����������������6.4.2����������Valve�������������������������������������

��������������������������� �

�����������������



���������������������������max�������������������������������������

���������������0.5������

�������������  ·  ������[−1, 1]���[0, 1]���������������������������������

���������0������������������������������������������

�����������������������������������

�6.4.2������������������������������

�1�����6.4.1���������

�2��������������������HalfLambertMat�

�3�����Unity Shader���������Shader��Chapter6-HalfLambert����Shader���2��

������

�4���2�������������

��Chapter6-HalfLambert������Shader����6.4.2���Chapter6-DiffusePixelLevel���

��������������������������������

fixed4 frag(v2f i) : SV_Target { 

    ... 

 

    // Compute diffuse term 

    fixed halfLambert = dot(worldNormal, worldLightDir) * 0.5 + 0.5; 

    fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * halfLambert; 

 

    fixed3 color = ambient + diffuse; 

 

    return fixed4(color, 1.0); 

} 

 

�������������������������������6.8���������������������������������



▲�6.8 �����������������������������



6.5 �Unity Shader�����������

�6.2.4���������������������������

�������������������4�������������� c light ���������� m specular �����  ������  �

�������  �������  �����  �����

��������������Cg������������reflect�

�� �reflect(i, n)

�� �i������n���������float�float2�float3����

�� ��������i�����n��reflect������������6.9���������������

▲�6.9 Cg�reflect��

6.5.1 ��������

�����������������������������������������6.10�����



▲�6.10 ������������

�������������

�1��Unity��������������������Scene_6_5��Unity 5.2��������������������������

������������Window -> Lighting -> Skybox������������

�2��������������������SpecularVertexLevelMat�

�3�����Unity Shader���������Shader��Chapter6-SpecularVertexLevel����Shader���

2��������

�4����������������2������������

�5������

������������Shader�������������������3�����Chapter6-SpecularVertexLevel�����

�������������

�1�����������Shader������

Shader "Unity Shaders Book/Chapter 6/Specular Vertex-Level" { 

 

�2��������������������������Shader�Properties ������������

Properties { 

    _Diffuse ("Diffuse", Color) = (1, 1, 1, 1) 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 

    _Gloss ("Gloss", Range(8.0, 256)) = 20 

} 

 

�������_Specular���������������_Gloss������������

�3�������SubShader ���������Pass ����������/������������Pass ������

SubShader �����������Pass��������Pass������



SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�������������9����������������������

������������LightMode���������Unity����������_LightColor0�

�4��������CGPROGRAM �ENDCG ���CG��������������������������������

#pragma�����Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6����Shader���Properties ������������������������������

fixed4 _Diffuse; 

fixed4 _Specular; 

float _Gloss; 

 

����������0�1�������_Diffuse�_Specular��������fixed�����������_Gloss���������

���float������

�7����������������������������������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    fixed3 color : COLOR; 

}; 

 

�8��������������������������

v2f vert(a2v v) { 

    v2f o; 

    // Transform the vertex from object space to projection space 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    // Get ambient term 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    // Transform the normal fram object space to world space 

    fixed3 worldNormal = normalize(mul(v.normal, (float3x3)_World2Object)); 

    // Get the light direction in world space 

    fixed3 worldLightDir = normalize(_WorldSpaceLightPos0.xyz); 

 

    // Compute diffuse term 

    fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * saturate(dot(worldNormal, worldLightDir)); 

 



    // Get the reflect direction in world space 

    fixed3 reflectDir = normalize(reflect(-worldLightDir, worldNormal)); 

    // Get the view direction in world space 

    fixed3 viewDir = normalize(_WorldSpaceCameraPos.xyz - mul(_Object2World, v.vertex).xyz); 

 

    // Compute specular term 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(saturate(dot(reflectDir, viewDir)), _Gloss

 

    o.color = ambient + diffuse + specular; 

 

    return o; 

} 

 

�����������6.4�������������������������������������������reflectDir���Cg�

reflect���������������������������worldLightDir������reflect����������

_WorldSpaceCameraPos���������������������������������������

_WorldSpaceCameraPos�����������������

�������������4�����������������������������������������������

�9������������������������������

fixed4 frag(v2f i) : SV_Target { 

    return fixed4(i.color, 1.0); 

} 

 

�10�����������Unity Shader���Shader������Specular�

Fallback "Specular" 

 

�����������������������������6.10����������������������������������������

���������������������������������������������������������������������

▲�6.11 ������������

6.5.2 ��������



��������������������������6.11���

����������������

�1����6.5.1��������

�2��������������������SpecularPixelLevelMat�

�3�����Unity Shader���������Shader��Chapter6-SpecularPixelLevel����Shader���2

��������

�4���2�������������

��Chapter6-SpecularPixelLevel������Shader�����6.5.1��������������������������

����

�1��������������v2f�

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

}; 

 

�2������������������������������������������

v2f vert(a2v v) { 

    v2f o; 

    // Transform the vertex from object space to projection space 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    // Transform the normal fram object space to world space 

    o.worldNormal = mul(v.normal, (float3x3)_World2Object); 

    // Transform the vertex from object space to world space 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    return o; 

} 

 

�3������������������

fixed4 frag(v2f i) : SV_Target { 

    // Get ambient term 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(_WorldSpaceLightPos0.xyz); 

 

    // Compute diffuse term 

    fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * saturate(dot(worldNormal, worldLightDir)); 

 

    // Get the reflect direction in world space 

    fixed3 reflectDir = normalize(reflect(-worldLightDir, worldNormal)); 

    // Get the view direction in world space 

    fixed3 viewDir = normalize(_WorldSpaceCameraPos.xyz - i.worldPos.xyz); 

    // Compute specular term 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(saturate(dot(reflectDir, viewDir)), _Gloss

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 



������6.5.1���������������

��������������������������������������������Phong�����

6.5.3 Blinn-Phong����

�6.5.2���������Phong�����Unity�������6.2.4���������������������——Blinn���

�������Blinn���������������������  ����������  �����  ������������

�Blinn��������������

Blinn-Phong������6.5.2������������

�1������6.5.2�������

�2��������������������BlinnPhongMat�

�3�����Unity Shader���������Shader��Chapter6-BlinnPhong����Shader���2������

��

�4���2�������������

��Chapter6-BlinnPhong������Shader�����6.5.2���Chapter6-Specular PixelLevel�����

������������������������������

fixed4 frag(v2f i) : SV_Target { 

    ... 

 

    // Get the view direction in world space 

    fixed3 viewDir = normalize(_WorldSpaceCameraPos.xyz - i.worldPos.xyz); 

    // Get the half direction in world space 

    fixed3 halfDir = normalize(worldLightDir + viewDir); 

    // Compute specular term 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(worldNormal, halfDir)), _Gloss)

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 

�6.12�������������������������Phong����Blinn-Phong������������



▲�6.12 ����������������������Phong������Blinn-Phong�����������

�����Blinn-Phong�����������������������������������������Blinn-Phong�������

���������������������������������Blinn-Phong����“���”Phong�������������������

�18�•���������Blinn-Phong����������



6.6 �������Unity�����

��������������������������������������������������������

�������������normalize(_WorldSpace LightPos0.xyz)��������������

�����������normalize(_WorldSpace CameraPos.xyz -

i.worldPosition.xyz)�������������������������������������������

����������������������������������������9.2�����

��������������������������������������������Unity�������

���������������5.3.1��������UnityCG.cginc��������������������

��������6.1�������������������������

�6.1 UnityCG.cginc����������

� � � � �

float3 WorldSpaceViewDir

(float4 v)

������������������������������������������

UnityWorldSpaceViewDir��

float3

UnityWorldSpaceViewDir

(float4 v)

����������������������������������

float3 ObjSpaceViewDir

(float4 v)
����������������������������������

float3 WorldSpaceLightDir

(float4 v)

��������� �����������������������������������

�������UnityWorldSpaceLightDir���������

float3

UnityWorldSpaceLightDir

(float4 v)

��������� �����������������������������������

������

float3 ObjSpaceLightDir

(float4 v)

��������� �����������������������������������

������

float3

UnityObjectToWorldNormal

(float3 norm)

������������������



� � � � �

float3 UnityObjectToWorldDir

(float3 dir)
������������������

float3

UnityWorldToObjectDir(float3

dir)

������������������

�����UnityXXX������Unity 5�������������������������������

��������������������������������������������������������9��

������5����������������WorldSpaceViewDir�������

// Computes world space view direction, from object space position 

inline float3 UnityWorldSpaceViewDir( in float3 worldPos ) 

{ 

    return _WorldSpaceCameraPos.xyz - worldPos; 

} 

 

��������������������������� ����������������������������

�������������

��������3����WorldSpaceLightDir�UnityWorldSpaceLightDir�

ObjSpace

LightDir�������������Unity���������������������� ��3���������

��������������9.1��������������������3�����������

_WorldSpaceLightPos0�����������������������������������9.1.1

��

������������Unity Shader�

������������������������������������������������������

Unity���������������������������“��”�

�����������������6.5.3�����Blinn-Phong�����Unity Shader����

�1��Unity��������������������Scene_6_6��Unity 5.2���������

�����������������������������Window -> Lighting -> Skybox ����

��������

�2��������������������BlinnPhongUseBuildInFunctionMat�



�3�����Unity Shader���������Shader��Chapter6-

BlinnPhongUseBuildIn unction����Shader���2��������

�4������������2�����������

Chapter6-BlinnPhongUseBuildInFunction�������Chapter6-

BlinnPhong���������������Unity����������������

�1����������������UnityObjectToWorldNormal��������������

��

v2f vert(a2v v) { 

    v2f o; 

    ... 

    // Use the build-in function to compute the normal in world space 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 

    ... 

    return o; 

} 

 

�2����������������UnityWorldSpaceLightDir���

UnityWorldSpaceView

Dir����������������������

fixed4 frag(v2f i) : SV_Target { 

    ... 

 

    fixed3 worldNormal = normalize(i.worldNormal); 

    //  Use the build-in function to compute the light direction in world space 

    // Remember to normalize the result 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

 

    ... 

 

    // Use the build-in function to compute the view direction in world space 

    // Remember to normalize the result 

    fixed3 viewDir = normalize(UnityWorldSpaceViewDir(i.worldPos)); 

    ... 

} 

 

���������������������������������normalize��������������

���������



�7� ����

������������������������������ �texture

mapping� �� ���������“�”��������� �texel� ����������

����������������

����������������������������������� �texture-

mapping coordinates� ����������������������������

2D������������������(u, v)������u�������v�����������

��������UV���

���������������������256×256��1024×1024����UV

�������������[0, 1]����������������������������[0, 1]

������������[0, 1]����������������������������������

�����������[0, 1]����������������������7.1.2���������

���

���������������������OpenGL�DirectX������������

��������������������������OpenGL�����������������

DirectX���������������Unity�����������������5.6�����

�����������������������������OpenGL������DirectX��

������Unity��������������Unity����������OpenGL�����

�����������������7.1���



▲�7.1 Unity������

��������Unity���������������������7.1�����������

Unity Shader��������������������������7.2�����������

����������Unity�������������7.3��7.4����������������

���������������������������

����������� �������������������Shader�����������

������������������������������9.5������������������

������Unity Shader�



7.1 ����

������������������������������������Unity Shader��������������������������

������7.2�����

▲�7.2 ������

7.1.1 ��

�����������Blinn-Phong�����������������

�1��Unity��������������������Scene_7_1��Unity 5.2��������������������������

������������Window -> Lighting -> Skybox������������

�2��������������������SingleTextureMat�

�3�����Unity Shader���������Unity Shader��Chapter7-SingleTexture����Unity

Shader���2��������

�4����������������2������������

�5������

�����Chapter7-SingleTexture������������������

�1�����������Unity Shader������

Shader "Unity Shaders Book/Chapter 7/Single Texture" { 

 

�2�������������Properties�������������

Properties { 

    _Color ("Color Tint", Color) = (1,1,1,1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 

    _Gloss ("Gloss", Range(8.0, 256)) = 20 

} 

 

������������_MainTex�����3.3.2���������2D���������������������������������

��“white”����������������������������������������_Color���



�3�������SubShader���������Pass����������Pass��������Pass������

SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�����������

�4��������CGPROGRAM�ENDCG����Cg��������������������������������

#pragma�����Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6������Cg������������������������������������

fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 

fixed4 _Specular; 

float _Gloss; 

 

�����������������������������float4�����_MainTex_ST����_MainTex_ST��������

���Unity����������� _ST �����������������ST����scale�����translation�����

_MainTex_ST����������������������_MainTex_ST.xy���������_MainTex_ST.zw���������

��������������������7.3����7.1.2�������������������

▲�7.3 ��������������������

�7��������������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

    float4 texcoord : TEXCOORD0; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    float2 uv : TEXCOORD2; 

}; 

 

�������������a2v������TEXCOORD0�����������texcoord���Unity���������������

������������v2f������������������uv����������������������



�8���������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    o.uv = v.texcoord.xy * _MainTex_ST.xy + _MainTex_ST.zw; 

    // Or just call the built-in function 

    //      o.uv = TRANSFORM_TEX(v.texcoord, _MainTex); 

 

    return o; 

} 

 

������������������_MainTex_ST�������������������������������������

_MainTex_ST.xy���������������������_MainTex_ST.zw��������Unity��������

TRANSFORM_TEX�����������TRANSFORM_TEX��UnityCG.cginc�����

// Transforms 2D UV by scale/bias property 

#define TRANSFORM_TEX(tex,name) (tex.xy * name##_ST.xy + name##_ST.zw) 

 

�������������������������������������������� _ST ���������������

�9��������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

 

    // Use the texture to sample the diffuse color 

    fixed3 albedo = tex2D(_MainTex, i.uv).rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(worldNormal, worldLightDir)); 

 

    fixed3 viewDir = normalize(UnityWorldSpaceViewDir(i.worldPos)); 

    fixed3 halfDir = normalize(worldLightDir + viewDir); 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(worldNormal, halfDir)), _Gloss)

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 
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�10��������Shader������Fallback�

Fallback "Specular" 
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����������������������������Texture ��������������������Normal map �������

�����������Cubemap ��������������������������������������Unity���������Unity

Shader������������������Unity���������

▲�7.4 �����

���������Texture ��������Alpha from Grayscale �������������������������������
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▲�7.5 Wrap Mode����������[0, 1]����������

�7.5����������Tiling����(3, 3)�������Wrap Mode���������Repeat���������������

��������Clamp����������������������������������

�������������������������������������_MainTex_ST����Unity Shader�����������

�������������������������

o.uv = v.texcoord.xy * _MainTex_ST.xy + _MainTex_ST.zw; 

// Or just call the built-in function 

o.uv = TRANSFORM_TEX(v.texcoord, _MainTex); 
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7.2 ����

����������������� �bump mapping� ���������������������������������������

�����������������������������“����”��������������“��”�

�������������������������������� �height map� ������� �displacement� �����

���������������������� �height mapping� ���������������� �normal map� ������

���������������� �normal mapping� �����������������������������������������

7.2.1 ����
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����������������������������������������������������������������������������

�������������������������������������������������7.11���������

▲�7.11 ���
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7.2.2 ����
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normal =pixel ×2−1
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�bitangent�b��������7.12���
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7.2.3 ��
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�1��Unity��������������������Scene_7_2_3��Unity 5.2������������������������

��������������Window -> Lighting -> Skybox������������

�2��������������������NormalMapTangentSpaceMat�

�3�����Unity Shader���������Unity Shader��Chapter7-NormalMapTangentSpace����

Unity Shader���2��������



▲�7.14 ������

�4����������������2������������

�5������

�����Chapter7-NormalMapTangentSpace������������������

�1��������Unity Shader�������

Shader "Unity Shaders Book/Chapter 7/Normal Map In Tangent Space" { 

 

�2�������Properties�����������������������������

Properties { 

    _Color ("Color Tint", Color) = (1,1,1,1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _BumpMap ("Normal Map", 2D) = "bump" {} 

    _BumpScale ("Bump Scale", Float) = 1.0 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 

    _Gloss ("Gloss", Range(8.0, 256)) = 20 

} 

 

������_BumpMap�����"bump"��������"bump"�Unity�������������������

��"bump"��������������_BumpScale���������������0����������������������

�3����SubShader���������Pass�������Pass��������Pass������

SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�����������

�4��������CGPROGRAM�ENDCG����Cg��������������������������������

#pragma�����Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 



�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6����Properties���������������Cg��������������������

fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 

sampler2D _BumpMap; 

float4 _BumpMap_ST; 

float _BumpScale; 

fixed4 _Specular; 

float _Gloss; 

 

�����������������������_MainTex�_BumpMap���_MainTex_ST�_BumpMap_ST���

�7������������������������������������������������������������������a2v�

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

    float4 tangent : TANGENT; 

    float4 texcoord : TEXCOORD0; 

}; 

 

����TANGENT�����float4���tangent������Unity�����������tangent��������������

��normal���tangent����float4���float3�����������tangent.w�����������������——���

�����

�8���������������������������������v2f��������������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    float4 uv : TEXCOORD0; 

    float3 lightDir: TEXCOORD1; 

    float3 viewDir : TEXCOORD2; 

}; 

 

�9���������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv.xy = v.texcoord.xy * _MainTex_ST.xy + _MainTex_ST.zw; 

    o.uv.zw = v.texcoord.xy * _BumpMap_ST.xy + _BumpMap_ST.zw; 

 

    // Compute the binormal 

//  float3 binormal = cross( normalize(v.normal), normalize(v.tangent.xyz) ) * v.tangent.w; 

//  // Construct a matrix which transform vectors from object space to tangent space 

//  float3x3 rotation = float3x3(v.tangent.xyz, binormal, v.normal); 

    // Or just use the built-in macro 

    TANGENT_SPACE_ROTATION; 

 

    // Transform the light direction from object space to tangent space 

    o.lightDir = mul(rotation, ObjSpaceLightDir(v.vertex)).xyz; 

    // Transform the view direction from object space to tangent space 

    o.viewDir = mul(rotation, ObjSpaceViewDir(v.vertex)).xyz; 

 

    return o; 



} 

 

�������������������������������v2f��uv��������float4�����xy�����_MainTex���

����zw�����_BumpMap����������_MainTex�_BumpMap����������������������������

�����������������������������������������������������������������������

rotation�������������������v.tangent.w���������������������������������w�������

��������Unity���������TANGENT_SPACE_ROTATION��UnityCG.cginc����������������

rotation��������������������������Unity�����ObjSpaceLightDir�ObjSpaceViewDir�����

�������������������rotation�����������������

�10���������������������������������������������������������������

fixed4 frag(v2f i) : SV_Target {                 

    fixed3 tangentLightDir = normalize(i.lightDir); 

    fixed3 tangentViewDir = normalize(i.viewDir); 

 

    // Get the texel in the normal map 

    fixed4 packedNormal = tex2D(_BumpMap, i.uv.zw); 

    fixed3 tangentNormal; 

    // If the texture is not marked as "Normal map" 

//  tangentNormal.xy = (packedNormal.xy * 2 - 1) * _BumpScale; 

//  tangentNormal.z = sqrt(1.0 - saturate(dot(tangentNormal.xy, tangentNormal.xy))); 

 

    // Or mark the texture as "Normal map", and use the built-in funciton 

    tangentNormal = UnpackNormal(packedNormal); 

    tangentNormal.xy *= _BumpScale; 

    tangentNormal.z = sqrt(1.0 - saturate(dot(tangentNormal.xy, tangentNormal.xy))); 

 

    fixed3 albedo = tex2D(_MainTex, i.uv).rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(tangentNormal, tangentLightDir)); 

 

    fixed3 halfDir = normalize(tangentLightDir + tangentViewDir); 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(tangentNormal, halfDir)), _Glos

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 

��������������tex2D�����_BumpMap����������������������������������������

����������������������Unity�������������Normal map���7.2.4��������������������

����packedNormal�xy����������������������_BumpScale�����������tangentNormal�

xy����������������tangentNormal.z�����tangentNormal.xy������������������������

�����������z����� �Unity������Unity�������������������������������Normal map �

Unity������������������������������������������������_BumpMap�rgb�����������

�����xyz����7.2.4������������������������Unity�����UnpackNormal�����������

�11��������Unity Shader�����Fallback�

Fallback "Specular" 
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▲�7.15 ��Bump Scale������������
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�1�������������

�2��������������������NormalMapWorldSpaceMat�

�3�����Unity Shader���������Shader��Chapter7-NormalMapWorldSpace����Shader�

��2��������

�4���2�������������

��Chapter7-NormalMapWorldSpace����������������������

�1������������������v2f���������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    float4 uv : TEXCOORD0; 

    float4 TtoW0 : TEXCOORD1;   

    float4 TtoW1 : TEXCOORD2;   

    float4 TtoW2 : TEXCOORD3;  

}; 

 

���3.3.2������������������float4�������������������������������������������

TtoW0�TtoW1�TtoW2�������������������������������������������3×3������������

�������float3�����������������������������������������������w����

�2���������������������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv.xy = v.texcoord.xy * _MainTex_ST.xy + _MainTex_ST.zw; 

    o.uv.zw = v.texcoord.xy * _BumpMap_ST.xy + _BumpMap_ST.zw; 

 

    float3 worldPos = mul(_Object2World, v.vertex).xyz;   

    fixed3 worldNormal = UnityObjectToWorldNormal(v.normal);   

    fixed3 worldTangent = UnityObjectToWorldDir(v.tangent.xyz);   

    fixed3 worldBinormal = cross(worldNormal, worldTangent) * v.tangent.w;  



 

    // Compute the matrix that transform directions from tangent space to world space 

    // Put the world position in w component for optimization 

    o.TtoW0 = float4(worldTangent.x, worldBinormal.x, worldNormal.x, worldPos.x); 

    o.TtoW1 = float4(worldTangent.y, worldBinormal.y, worldNormal.y, worldPos.y); 

    o.TtoW2 = float4(worldTangent.z, worldBinormal.z, worldNormal.z, worldPos.z); 

 

    return o; 

} 

 

������������������������������������������ �������������������������������

����TtoW0�TtoW1�TtoW2���������������xyz�������������w���������������������

�3����������������������

fixed4 frag(v2f i) : SV_Target { 

    // Get the position in world space       

    float3 worldPos = float3(i.TtoW0.w, i.TtoW1.w, i.TtoW2.w); 

    // Compute the light and view dir in world space 

    fixed3 lightDir = normalize(UnityWorldSpaceLightDir(worldPos)); 

    fixed3 viewDir = normalize(UnityWorldSpaceViewDir(worldPos)); 

 

    // Get the normal in tangent space 

    fixed3 bump = UnpackNormal(tex2D(_BumpMap, i.uv.zw)); 

    bump.xy *= _BumpScale; 

    bump.z = sqrt(1.0 - saturate(dot(bump.xy, bump.xy))); 

    // Transform the normal from tangent space to world space 

    bump = normalize(half3(dot(i.TtoW0.xyz, bump), dot(i.TtoW1.xyz, bump), dot(i.TtoW2.xyz, bump))); 

 

    ... 

} 

 

�����TtoW0�TtoW1�TtoW2�w����������������������UnityWorldSpaceLightDir�

UnityWorldSpaceViewDir����������������������������UnpackNormal��������������

��������������Normal map�����_BumpScale��������������TtoW0�TtoW1�TtoW2�����

�������������������������������������������

����������������������������������Unity 4.x����������Cubemap��������������

Unity Shader�����������������������Unity 5.x�������Unity Shader�����������������

�����Unity 5.x����������������������������������������������������������������

��19.2���

7.2.4 Unity��������

���������������������Normal map������Unity�����UnpackNormal�������������

7.16���



▲�7.16 ���UnpackNormal��������������������������Normal map

��������������������Unity Shader���������������������Normal map�����������

�������Unity�������������������������Unity Shader�������UnpackNormal����������

��������������Normal map�������������������

�����������Unity������������������DXT5nm���������������http://tech-

artists.org/wiki/Normal_map_compression �����UnpackNormal�����������������������

�������UnityCG.cginc���UnpackNormal��������

inline fixed3 UnpackNormalDXT5nm (fixed4 packednormal) 

{ 

    fixed3 normal; 

    normal.xy = packednormal.wy * 2 - 1; 

    normal.z = sqrt(1 - saturate(dot(normal.xy, normal.xy))); 

    return normal; 

} 

 

inline fixed3 UnpackNormal(fixed4 packednormal) 

{ 

#if defined(UNITY_NO_DXT5nm) 

    return packednormal.xyz * 2 - 1; 

#else 

    return UnpackNormalDXT5nm(packednormal); 

#endif 

} 

 

��������������������DXT5nm�������������������������DXT5nm������������a�

���w ���������x ���g��������y �������r�b�����������z �����xy������������������

�����������������DXT5nm����������������������������������������������������

�������������������������������������������������������z ��������������������

�������������

�����������Normal map����������Create from Grayscale ����������������������

����������������������������������������������������������������������������

����������������������Unity����������������Normal map�������Create from

Grayscale�����������7.17��������������������������������

▲�7.17 ����Create from Grayscale ��Unity���������������������

http://tech-artists.org/wiki/Normal_map_compression


����Create from Grayscale����������—Bumpiness �Filtering ���Bumpiness�������

���Filtering����������������������������Smooth ����������������������Sharp ����

�Sobel�����������������������Sobel������������������3×3�������x�y������������

������������������������������������������������������������x�y�������������

����������������r�g�����



7.3 ����

�������������������������������������������������������������������������

����������������������������������������������������������������������������

������������������2�������Team Fortress 2������������Valve��������������������

��������������������������Valve�����������������������2��������

�������Gooch���1998��������������A Non-Photorealistic Lighting Model For

Automatic Technical Illustration��������������������������� �cool-to-warm tones� ��

����������������������������������������������������������������������������

��������������������14.1������������������Unity Shader�

����������������������������������������������7.18�����

▲�7.18 ���������������������������������

�������������������������������������������������������������������������

������������������2���������������������������������������������������������

���������������������������������������������������������������������������

��

����������������������

�1��Unity��������������������Scene_7_3��Unity 5.2��������������������������

������������Window -> Lighting -> Skybox������������

�2��������������������RampTextureMat�

�3�����Unity Shader���������Unity Shader��Chapter7-RampTexture����Unity

Shader���2��������

�4���������Suzanne������2�����������

�5������

�����Chapter7-RampTexture������������������

�1�����������Shader������

Shader "Unity Shaders Book/Chapter 7/Ramp Texture" { 

 

�2����Properties��������������������

Properties { 

    _Color ("Color Tint", Color) = (1,1,1,1) 

    _RampTex ("Ramp Tex", 2D) = "white" {} 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 



    _Gloss ("Gloss", Range(8.0, 256)) = 20 

} 

 

�3�������SubShader���������Pass������Pass��������Pass������

SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�����������

�4��������CGPROGRAM�ENDCG����Cg�����������������������������#pragma��

���Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6�����������Properties��������������

fixed4 _Color; 

sampler2D _RampTex; 

float4 _RampTex_ST; 

fixed4 _Specular; 

float _Gloss; 

 

�������_RampTex�����������_RampTex_ST�

�7������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

    float4 texcoord : TEXCOORD0; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    float2 uv : TEXCOORD2; 

}; 

 

�8���������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 



 

    o.uv = TRANSFORM_TEX(v.texcoord, _RampTex); 

 

    return o; 

} 

 

��������TRANSFORM_TEX������������������

�9��������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    // Use the texture to sample the diffuse color 

    fixed halfLambert  = 0.5 * dot(worldNormal, worldLightDir) + 0.5; 

    fixed3 diffuseColor = tex2D(_RampTex, fixed2(halfLambert, halfLambert)).rgb * _Color.rgb; 

 

    fixed3 diffuse = _LightColor0.rgb * diffuseColor; 

 

    fixed3 viewDir = normalize(UnityWorldSpaceViewDir(i.worldPos)); 

    fixed3 halfDir = normalize(worldLightDir + viewDir); 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(worldNormal, halfDir)), _Gloss)

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 

������������6.4.3������������������������������0.5��������0.5��������������

halfLambert���������halfLambert��������[0�1]����������halfLambert���������������

��������_RampTex�������_RampTex�������������������������������u�v��������

halfLambert����������������������_Color���������������������������������������

����������������������

�10��������Unity Shader�����Fallback�

Fallback "Specular" 

 

���������������������������Ramp_Texture0.psd�Ramp_Texture1.psd������������

����������������

������ �����������Wrap Mode��Clamp�����������������������������7.19���

Wrap Mode���Repeat�Clamp��������



▲�7.19 Wrap Mode���Repeat�Clamp�������

����������Repeat�������������������������������fixed2(halfLambert,

halfLambert)����������������halfLambert���[0, 1]��������1.000 01���������������

Repeat����������������������������0.000 01�����������������������������������

�������������������Wrap Mode��Clamp������������



7.4 ����

���� �mask texture� ������������������������������������������������������

����������������������������������������������������������������������������

����������������������������������������������������������������������������

������������������������������������������������������������������

�������������������������������������������������texel.r�������������������

�����0����������������������������������������������������������

7.4.1 ��

������������������������������������������17.20��������������������������

����������

▲�7.20 �����������������������������������������

�����������7.21��������������������������������������

▲�7.21 �����������

���Unity Shader���������������������



�1��Unity��������������������Scene_7_4��Unity 5.2��������������������������

������������Window -> Lighting -> Skybox������������

�2��������������������MaskTextureMat�

�3�����Unity Shader���������Unity Shader��Chapter7-MaskTexture����Unity Shader

���2��������

�4����������������2������������

�5������

�����Chapter7-MaskTexture������������������

�1�����������Shader������

Shader "Unity Shaders Book/Chapter 7/Mask Texture" { 

 

�2������Properties�������������������

Properties { 

    _Color ("Color Tint", Color) = (1,1,1,1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _BumpMap ("Normal Map", 2D) = "bump" {} 

    _BumpScale("Bump Scale", Float) = 1.0 

    _SpecularMask ("Specular Mask", 2D) = "white" {} 

    _SpecularScale ("Specular Scale", Float) = 1.0 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 

    _Gloss ("Gloss", Range(8.0, 256)) = 20 

} 

 

������_SpecularMask������������������_SpecularScale���������������

�3�������SubShader���������Pass������Pass��������Pass������

SubShader { 

    Pass {  

        Tags { "LightMode"="ForwardBase" } 

 

LightMode���Pass�������������Pass�Unity�����������

�4��������CGPROGRAM�ENDCG����Cg�����������������������������#pragma��

���Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6�����������Properties��������������



fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 

sampler2D _BumpMap; 

float _BumpScale; 

sampler2D _SpecularMask; 

float _SpecularScale; 

fixed4 _Specular; 

float _Gloss; 

 

������_MainTex�����_BumpMap�����_SpecularMask����������������_MainTex_ST�

�������������������������������3��������������������������������������������

����������TextureName_ST����������������������������������������������������

���������������������������������������������������������������

�7������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

    float4 tangent : TANGENT; 

    float4 texcoord : TEXCOORD0; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float2 uv : TEXCOORD0; 

    float3 lightDir: TEXCOORD1; 

    float3 viewDir : TEXCOORD2; 

}; 

 

�8���������������������������������������������������������������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv.xy = v.texcoord.xy * _MainTex_ST.xy + _MainTex_ST.zw; 

 

    TANGENT_SPACE_ROTATION; 

    o.lightDir = mul(rotation, ObjSpaceLightDir(v.vertex)).xyz; 

    o.viewDir = mul(rotation, ObjSpaceViewDir(v.vertex)).xyz; 

 

    return o; 

} 

 

�9�������������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 tangentLightDir = normalize(i.lightDir); 

    fixed3 tangentViewDir = normalize(i.viewDir); 

 

    fixed3 tangentNormal = UnpackNormal(tex2D(_BumpMap, i.uv)); 

    tangentNormal.xy *= _BumpScale; 

    tangentNormal.z = sqrt(1.0 - saturate(dot(tangentNormal.xy, tangentNormal.xy))); 

 

    fixed3 albedo = tex2D(_MainTex, i.uv).rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(tangentNormal, tangentLightDir)); 

 

    fixed3 halfDir = normalize(tangentLightDir + tangentViewDir); 



    // Get the mask value 

    fixed specularMask = tex2D(_SpecularMask, i.uv).r * _SpecularScale; 

    // Compute specular term with the specular mask 

    fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(tangentNormal, halfDir)), _Glos

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 

������������������������������������������_SpecularMask�������������������

���rgb����������������������������������r����������������������_SpecularScale�

���������������

������ �����������������������——��rgb�����������������������������������

������������������������7.4.2�����������

�10��������Unity Shader������Fallback�

Fallback "Specular" 

 

7.4.2 ������

�������������������������������������������������������������������������

���RGBA���������������������������������R��������������G����������������B�

�������������A���

����DOTA 2������������������4��������������������������������������������

�������8��������������������������������������������������������DOTA 2������

��������������������������������������



�8� ����
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��Alpha Channel� ���������������������������������

���������������——���������1�������������������0��

�������������

�Unity��������������������������������Alpha

Test� ������������������������������Alpha Blending�

�

�����������������������������������������������

�����A����B������C������������������������opaque��

������������������������������������depth buffer����

�z-buffer�������������������������visibility�����������

��������������������������������������������������

��������������������������������������������������

��������������������������������������������������
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�����������������������������A��B��������A���B

�����B����A���������������B�����������������������

��������������������������������������������

�ZWrite��

������������������������

����� ������“����”����������������������������

�����������������������������������������������
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�����������������������������������������������
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��
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�����������������������������������������������

�����������������������������������������������

���������������������
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����������������������A�B���8.1�����A��������B�
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�������������������
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A�����������B�����A�����������

�����������������������������������������������

��������������������������������������������������

�����A�B���8.2�����A�B��������



▲�8.1 �����������A�����������B����������

▲�8.2 �����������A�B�������

���������������������

�����������B����A���B������������A��������B���

���������������

�����������A����B���A�����������B��������A���

���������������������B�A������������������

�������������������������������
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���������������2��������������——“��������������

�”���������������������������������“������������”�

��������������������������������������������������

������������A���B�������A���B���������������������
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����”��”����8.4������

▲�8.3 ������������������������



▲�8.4 ���������������������������������������������

�����������������������������������������������

��������������������������������������������������

�������������������������������8.4�����������������

��������������A�B��������A�����B������������������
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���������8.5���

����������Unity�����������



8.2 Unity Shader�����

Unity������������������ �render queue� ���������

����SubShader�Queue ��������������������Unity�����

��������������������������������Unity 5��Unity�����5

�������Unity 5�����������AlphaTest������������������

���������8.1����5������������������

�8.1 Unity�����5�����

��
����

�
� �

Background 1000
�������������������������������������������

��

Geometry 2000 ��������������������������������

AlphaTest 2450
������������������Unity 5���Geometry�������

�����������������������������

Transparent 3000

������������Geometry�AlphaTest�������������

����������������������������Shader���������

���

Overlay 4000 ����������������������������������

��������������������������������������

SubShader { 

    Tags { "Queue"="AlphaTest" } 

    Pass { 

        ... 

    } 



} 

 

������������������������������������

SubShader { 

    Tags { "Queue"="Transparent" } 

    Pass { 

        ZWrite Off 

        ... 

    } 

} 

 

���ZWrite Off ��������������������Pass����������

�SubShader�������SubShader����Pass���������



8.3 �����

���������Unity���������������������������������

������ ��������������������������������������������������������

������������������������������������������

���������������clip�����������clip�Cg��������������

�� �void clip(float4 x); void clip(float3 x); void clip(float2 x); void clip(float1

x); void clip(float x);

�� ���������������

�� ������������������������������������������

void clip(float4 x) 

{ 

    if (any(x &lt; 0)) 

        discard; 

} 

 

����������8.5����������������������������transparent_texture.psd��

����������������������������������

�����������������8.6�����

▲�8.5 ��������������������



▲�8.6 �����

����������������

�1��Unity��������������������Scene_8_3��Unity 5.2����������������

����������������������Window -> Lighting -> Skybox������������

�2��������������������AlphaTestMat�

�3�����Unity Shader���������Unity Shader��Chapter8-AlphaTest����

Unity Shader���2��������

�4����������������2������������������������������

�5������

�����Chapter8-AlphaTest������������������

�1�����������Shader������

Shader "Unity Shaders Book/Chapter 8/Alpha Test" { 

 

�2��������������������������Properties�����������[0, 1]�����

_Cutoff�

Properties { 

    _Color ("Main Tint", Color) = (1,1,1,1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _Cutoff ("Alpha Cutoff", Range(0, 1)) = 0.5 



} 

 

_Cutoff����������clip���������������������[0�1]�������������������

��

�3�������SubShader���������Pass����

SubShader { 

    Tags {"Queue"="AlphaTest" "IgnoreProjector"="True" "RenderType"="TransparentCutout"} 

 

    Pass { 

        Tags { "LightMode"="ForwardBase" } 

 

���8.2��������������������Unity����������������AlphaTest���������

��Queue�����AlphaTest��RenderType�����Unity���Shader��������������

TransparentCutout��������Shader������������Shader�RenderType��������

�����������IgnoreProjector���True�������Shader��������Projectors������

�����������Shader����SubShader������������LightMode���Pass���������

����Pass�Unity�������������������LightMode�����������Unity����������

_LightColor0�

�4��������CGPROGRAM�ENDCG����Cg�����������������������������

���#pragma�����Unity������������������������������������vert�frag�

CGPROGRAM 

 

#pragma vertex vert 

#pragma fragment frag 

 

�5�����Unity���������_LightColor0�������Unity�����Lighting.cginc�

#include "Lighting.cginc" 

 

�6����Properties����������������������������������

fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 

fixed _Cutoff; 

 

��_Cutoff����[0, 1]���������fixed�������

�7����������������������������������

struct a2v { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 



    float4 texcoord : TEXCOORD0; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    float2 uv : TEXCOORD2; 

}; 

 

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    o.uv = TRANSFORM_TEX(v.texcoord, _MainTex); 

 

    return o; 

} 

 

���������������������������������������������������������������

���

�8���������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

 

    fixed4 texColor = tex2D(_MainTex, i.uv); 

 

    // Alpha test 

    clip (texColor.a - _Cutoff); 

    // Equal to  

//  if ((texColor.a - _Cutoff) < 0.0) { 

//      discard; 

//  } 

 

    fixed3 albedo = texColor.rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(worldNormal, worldLightDir)); 

 

    return fixed4(ambient + diffuse, 1.0); 

} 

 

���������clip����������������texColor.a - _Cutoff������������������

��������texColor.a������_Cutoff�������������������clip����������������

������discard������������������������������������������������������

���

�9�����������Unity Shader�����Fallback�



Fallback "Transparent/Cutout/VertexLit" 

 

������Diffuse�Specular������������Transparent/Cutout/VertexLit�����

Shader��������������SubShader�������������������Shader�������������

��������������������������9.4.5��

������Alpha cutoff�����������������������������������������������

�����������������������8.7���

▲�8.7 ��Alpha cutoff���������������������������

��8.6��8.7������������������“��”——�����������������������������

������������������������������������������������������������������

���������������



8.4 �����

���������������������������������������������������������������

����������������������������������������������������������

������ ���������������������������������������������������������

�����������������������������������������

�������������Unity�������——Blend�Blend�Unity�������������������

������������������������������������������������������8.2���Blend��

����

�8.2 ShaderLab�Blend��

� � � �

Blend Off ����

Blend SrcFactor DstFactor
�����������������������������SrcFactor���������������

��������DstFactor�����������������

Blend SrcFactor DstFactor,

SrcFactorA DstFactorA
������������������������

BlendOp BlendOperation ������������������������BlendOperation���������

�����������������Blend SrcFactor DstFactor�������������������������

�����������������������������������������Unity�����Blend�����������

�����������������������������������������Pass���Blend��������������

��������������������������������SrcFactor��SrcAlpha�����������

DstFactor��OneMinusSrcAlpha�����������������

DstColornew = SrcAlpha × SrcColor + ( 1 − SrcAlpha ) × DstColorold

����������������������8.6������������������

�����8.3���������������������������8.8������



▲�8.8 �����

���Unity���������������������

�1��Unity��������������������Scene_8_4��Unity 5.2����������������

����������������������Window -> Lighting -> Skybox������������

�2��������������������AlphaBlendMat�

�3�����Unity Shader���������Unity Shader��Chapter8-AlphaBlend����

Unity Shader���2��������

�4����������������2������������������������������

�5������

�����Chapter8-AlphaBlend������������8.3��Chapter8-AlphaTest�������

����������������������

�1���Properties����

Properties { 

    _Color ("Main Tint", Color) = (1,1,1,1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _AlphaScale ("Alpha Scale", Range(0, 1)) = 1 

} 

 

����������_AlphaScale������_Cutoff���_AlphaScale������������������

������������Pass������������

fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 



fixed _AlphaScale; 

 

�2���SubShader������

SubShader { 

    Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent"} 

 

��������������Unity����������������Transparent�����������Queue��

���Transparent�RenderType�����Unity���Shader��������������Transparent

���������Shader������������Shader�RenderType�������������������

IgnoreProjector���True�������Shader��������Projectors�����������������

Shader����SubShader����3����

�3������������������Pass�������������������

Pass { 

    Tags { "LightMode"="ForwardBase" } 

 

    ZWrite Off 

    Blend SrcAlpha OneMinusSrcAlpha 

 

Pass������������LightMode��ForwardBase������Unity����������������

��������������������Pass������ZWrite���������Off��������������������

��������������������Pass������������������������������������������

SrcAlpha����������������������������OneMinusSrcAlpha�������������

�4���������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

 

    fixed4 texColor = tex2D(_MainTex, i.uv); 

 

    fixed3 albedo = texColor.rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(worldNormal, worldLightDir)); 

 

    return fixed4(ambient + diffuse, texColor.a * _AlphaScale); 

} 

 

�����8.3�������������������������������������������������������

�����_AlphaScale�������������������Blend����������������������������

���������������������

�5������Unity Shader�Fallback�



Fallback "Transparent/VertexLit" 

 

������������Alpha Scale�������������8.9�����Alpha Scale����������

▲�8.9 ��Alpha Scale���������������

���8.1���������������������������������������������������������

���������������������8.10��������Unity Shader��Knot���������

▲�8.10 ������������������������������

�������������������������������������������8.1�����������������

����������“����”���������������������������������������������������

����������������������



8.5 ������������

�8.4������������������������������������������Pass ���������

Pass������������������������������������������Pass����������������

Pass������������������Pass���������������������������������������

Pass���������������������������8.11�������������������������������

������������������������������

▲�8.11 �������������

����������������

�1��Unity��������������������Scene_8_5��Unity 5.2���������������

�����������������������Window -> Lighting -> Skybox������������

�2��������������������AlphaBlendZWriteMat�

�3�����Unity Shader���������Unity Shader��Chapter8-

AlphaBlendZWrite����Unity Shader���2��������

�4����������������2������������������������������

�5������

��������8.4����Chapter8-AlphaBlend����������Chapter8- AlphaBlend��

��������Chapter8-AlphaBlendZWrite�������������Pass���������Pass���



Shader "Unity Shader Book/Chapter8-Alpha Blending ZWrite" { 

    Properties { 

        _Color ("Main Tint", Color) = (1,1,1,1) 

        _MainTex ("Main Tex", 2D) = "white" {} 

        _AlphaScale ("Alpha Scale", Range(0, 1)) = 1 

    } 

    SubShader { 

        Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent"} 

 

        // Extra pass that renders to depth buffer only 

        Pass { 

            ZWrite On 

            ColorMask 0 

        } 

 

        Pass { 

            // �8.4������ 

        } 

    }  

    Fallback "Diffuse" 

} 

 

������Pass�������������������������������������������Pass������

������������������������——ColorMask ��ShaderLab��ColorMask������

�������write mask���������

ColorMask RGB | A | 0 | ����R�G�B�A��� 

 

�ColorMask��0������Pass����������������������������——�Pass����

�������



8.6 ShaderLab�����

�8.4��������������Blend�������������������������

���������������������������������

������������������������������������������������

����������������������� �source color� �����

�destination color� ��������S ����������������������

�����D ���������������������������������������O ���

��������������������������������������������������

RGBA�������������RGB���

������������������Unity�������Blend�Blend Off�����

����������������������������API���������������

OpenGL��������glEnable(GL_BLEND)��������Unity�������

�����������

8.6.1 �������

�2.3.8������������������������������������������

�����������������������������������������������

����������������S�����D���������O��������������

�������������blend equation� ����������������������

�����RGB���������A��������������������������������

� �������������������������������������������������

�������������������RGB���A�����������������������

���������������������4�����8.3���ShaderLab���������

��

�8.3 ShaderLab����������

� � � �



� � � �

Blend SrcFactor

DstFactor

�����������������������������SrcFactor���

��������������������DstFactor������������

�����

Blend SrcFactor

DstFactor, SrcFactorA

DstFactorA

������������������������

������������������������������������RGB���A����

��SrcFactorA���SrcFactor�DstFactorA���DstFactor��������

������������������

������������������8.4���ShaderLab����������

�8.4 ShaderLab������

� � � �

One ���1

Zero ���0

SrcColor
�������������RGB���������SrcColor�RGB������

��������A���������SrcColor�A��������

SrcAlpha ������������A���



� � � �

DstColor
��������������RGB�����������DstColor�RGB���

�����������A�����������DstColor�A���������

DstAlpha �������������A���

OneMinusSrcColor
���(1-���)������RGB������������RGB���������

�����A������������A��������

OneMinusSrcAlpha ���(1-��������)

OneMinusDstColor
���(1-����)������RGB������������RGB�������

�������A������������A��������

OneMinusDstAlpha ���(1-���������)

�������������RGB��������A����������������������

��������A����������Blend SrcFactor DstFactor,

SrcFactorA DstFactorA �����������������������������

�����������������

Blend SrcAlpha OneMinusSrcAlpha, One Zero 

 

8.6.2 ����

������������������������������������������������

�������������������������������������������

ShaderLab�BlendOp BlendOperation ������������8.5���

ShaderLab���������

�8.5 ShaderLab������



� � � �� � � �

Add

���������������������������������

Sub

����������������������������

RevSub

����������������������������

Min
���������������������������������

Max
���������������������������������

������ ��DirectX 11.1���

���������������������������������Min �Max ����

�������������������������������������������

8.6.3 �������

���������������������������Photoshop�����������

// ���Normal�������� 

Blend SrcAlpha OneMinusSrcAlpha 

 

// �����Soft Additive� 

Blend OneMinusDstColor One 

 

// �����Multiply����� 



Blend DstColor Zero 

 

// �����2x Multiply� 

Blend DstColor SrcColor 

 

// ���Darken� 

BlendOp Min 

Blend One One 

 

// ���Lighten� 

BlendOp Max 

Blend One One 

 

// ���Screen� 

Blend OneMinusDstColor One 

// ��� 

Blend One OneMinusSrcColor 

 

// �����Linear Dodge� 

Blend One One 

 

�8.12���������������������������Scene_8_6_3�����

�����

▲�8.12 �������������



�������������Min�Max���������������������������

��������Min�Max������������������������������������

�������������������������BlendOp Add�



8.7 ���������

��������������������������������������������������������������

������������������������������������������������������������������

������������������������������������������������������������Cull ��

�����������������Unity��Cull��������

Cull Back | Front | Off 

 

�����Back������������������������������������������Front�������

��������������������Off ������������������������������������������

���������������������������������������������

8.7.1 ����������

�������������������������������������������Pass��������Cull����

�������������������������������Scene_8_7_1����������������������

Unity Shader����AlphaTestBothSidedMat�Chapter8-AlphaTestBothSided�

Chapter8-AlphaTestBothSided����8.3���Chapter8-AlphaTest��������������

��

Pass { 

    Tags { "LightMode"="ForwardBase" } 

 

    // Turn off culling 

    Cull Off 

 

�������������������������������������������������8.13�����



▲�8.13 �������������

���������������������������

8.7.2 ����������

���������������������������������������������������“�������”���

�������������������������——�������������������������������������

������������������������������������������������������������������

�����������������8.7.1��������������������������������������������

��������������

�������������������Pass——���Pass���������Pass��������Unity�����

SubShader����Pass����������������������������������������

����������������������Scene_8_7_2��������������������Unity

Shader����AlphaBlendBothSidedMat�Chapter8-AlphaBlendBothSided����8.4�

�Chapter8-AlphaBlend����Chapter8-AlphaTestBothSided����������

�1����Pass���������Pass�

�2����Pass�����Cull ��������������

Shader "Unity Shaders Book/Chapter 8/Alpha Blend With Both Side" { 

    Properties { 

        _Color ("Main Tint", Color) = (1,1,1,1) 

        _MainTex ("Main Tex", 2D) = "white" {} 

        _AlphaScale ("Alpha Scale", Range(0, 1)) = 1 

    } 

    SubShader { 

        Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent"} 

 



        Pass { 

            Tags { "LightMode"="ForwardBase" } 

 

            // First pass renders only back faces  

            Cull Front 

 

            // �������� 

        } 

 

        Pass { 

            Tags { "LightMode"="ForwardBase" } 

 

            // Second pass renders only front faces  

            Cull Back 

 

            // �������� 

        } 

    }  

    Fallback "Transparent/VertexLit" 

} 

 

���������������8.14�����

▲�8.14 �������������



�3� ���

��������������Unity�����������������������������

����������

�9� ������

��������������������������������������������

Unity��3������3������������������������������������

����������������������������������������Unity

Shader�

�10� ����

����������Unity Shader�������������������������

�11� ������

�������������������������Shader����������������

���������



�9� ������

�������������������������������Unity Shader�����

�����������������������������Shader���������������

������������������Unity Shader����������������������

�������������������������� �����������������������

������������������9.5�������������Unity Shader�

�����������������������������������������������

��������������������������������������������������

���������������������Unity���������

���������������Unity����������������������������

���������Unity��������������Shader����������9.1����

��Unity�������������9.2���������������������������

9.3�������Unity Shader�������������������������9.4��

�����Unity�������������Unity Shader����������������

���������9.5�����������Unity Shader���Unity Shader���

����������������������Shader�������



9.1 Unity�����

�Unity������ �Rendering Path� �����������Unity Shader���������

��������������Pass������������������Unity���“�������������������

���������������������������������”����������Shader��������������

����Shader�������������

Unity�������������Unity 5.0��������3�������� �Forward

Rendering Path� ������� �Deferred Rendering Path� ���������

�Vertex Lit Rendering Path� ���Unity 5.0�����Unity����������������

�������������Unity�������������������������Unity Shader����������

�������������������������������������

��������������������������������������������������Unity�Edit →

Project Settings → Player → Other Settings → Rendering Path�������������

����������������������9.1���

������������������������A������������������B���������������

�������������������������������������Project Settings�������9.2���

▲�9.1 ��Unity�������



▲�9.2 ������Rendering Path��������Project Settings����

�������������Use Player Settings�����������Project Settings�������

�����Project Settings��������������������������������Unity���������

�������������GPU����������Unity���������

������������������Pass���������Pass��������������Pass�

LightMode �����������������������������������������

Pass { 

    Tags { "LightMode" = "ForwardBase" } 

 

��������Unity��Pass����������ForwardBase ������������������

ForwardAdd ��9.1���Pass�LightMode��������������

�9.1 LightMode�������������

� � � � �

Always ������������Pass����������������

ForwardBase ������ ��Pass������������������/SH���Lightmaps

ForwardAdd ������ ��Pass��������������Pass������

Deferred ������ ��Pass���G���G-buffer�

ShadowCaster ������������������shadowmap���������



� � � � �

PrepassBase ��������� ��Pass���������������

PrepassFinal ��������� ��Pass�����������������������

Vertex�VertexLMRGBM�VertexLM �����������

��������������������Pass���������������������������������

Unity��������������������������Pass�������������������Unity�“����

���������������������������������������”���������Unity����������

���������������������������Unity 5.x����������������Pass���������

������������������������Pass������������������������������������

����

���Unity������������������������������������������

9.1.1 ������

��������������������������������������������������������Unity

���������������������Unity Shader������������������

1����������

������������������������������������������������������������

��������������������������������������������������������������

Pass { 

    for (each primitive in this model) { 

        for (each fragment covered by this primitive) { 

            if (failed in depth test) { 

                // ��������������������� 

                discard; 

            } else { 

                // ������� 

                // ������� 

                float4 color = Shading(materialInfo, pos, normal, lightDir, viewDir); 

                // ����� 

                writeFrameBuffer(fragment, color); 

            } 

        } 

    } 

} 

 



������������������������������������������������������������

��Pass���Pass�������������������������������������������������N

���������M ��������������������N *M �Pass�����������������������

�Pass���������������������������������

2�Unity������

������Pass��������������������������������������������������

���������������������Unity���������������������������

�Unity���������3�������������������������������� �Spherical

Harmonics�SH� �� ����������������������������������������������

��������������������������� �Important� ����������������

Important��������Unity�“���������������������������������������”�

�������Light������������9.3���

▲�9.3 ������������

������������������Unity��������������������������������������

�������������������������������������������������4�������������

��������SH�����Unity����������

�������������������

��������Not Important �����������SH���

��������Important ������������

��������������������Quality Setting ���������(Pixel Light Count)�

�������������������

������������������Pass���������������Pass�Base Pass�Additional

Pass���������Pass��������������������9.4���



▲�9.4 �������Pass

�9.4������������

���������������������Pass���������#pragma multi_

compile_fwdbase ����������#pragma multi_compile_fwdbase �

#pragma multi_compile_fwdadd ���������������������������

Bass Pass�Additional Pass�������������������Pass����������������

������

Base Pass��������Base Pass��������������Base Pass������������

�lightmap��

Base Pass�������������������������������Additional Pass��������

��������������������Light����������Shadow Type �������

Additional Pass��� #pragma multi_compile_ fwdadd_fullshadows��

#pragma multi_compile_fwdadd������������������������Unity�����

���Shader���

����������Base Pass������������������������������������������

��Additional Pass����������������������������������

�Additional Pass��������������������������������Additional Pass��

�������������������������������������������������������

Additional Pass�����������������������������������������������

����Blend One One �



�����������Unity Shader�������Base Pass�Base Pass��������������

����������Additional Pass���Base Pass������������Base Pass����

������Additional Pass��������������������������������������

Additional Pass�

�9.4������������ ������Pass����������������������Unity�Pass���

������������������������������������_LightColor0�����������������

�����������������������Unity��������Base Pass��������������������

�Additional Pass����������������������������

3�����������

������������������Pass���LightMode����Unity������������

Shader�

�Unity 5����������LightMode �ForwardBase �ForwardAdd �����

9.2��������Shader����������

�9.2 ���������������

� � � � � �

_LightColor0 float4 �Pass�����������

_WorldSpaceLightPos0 float4

_WorldSpaceLightPos0.xyz��Pass�������������

�����������_WorldSpaceLightPos0.w�0�������

w��1

_LightMatrix0 float4×4
����������������������cookie�����

�attenuation���

unity_4LightPosX0,

unity_4LightPosY0,

unity_4LightPosZ0

float4 ���Base Pass��4�����������������

unity_4LightAtten0 float4 ���Base Pass�����4�������������

unity_LightColor half4[4] ���Base Pass�����4�����������

���6.6�������������������������WorldSpaceLightDir�

UnityWorldSpaceLightDir�ObjSpaceLightDir �����������9.3�������������

����������

�9.3 ���������������



� � � � �

float3

WorldSpaceLightDir

(float4 v)

��������� ������������������������������������������

UnityWorldSpaceLightDir���������

float3

UnityWorldSpaceLightDir

(float4 v)

��������� �����������������������������������������

float3 ObjSpaceLightDir

(float4 v)
��������� �����������������������������������������

float3 Shade4PointLights

(...)

��������� �����������������������������������9.2�����

���unity_4LightPosX0, unity_4LightPosY0, unity_4LightPosZ0�

unity_LightColor�unity_4LightAtten0�����������������������

������������������������������������������������������������

�����������������������������������

9.1.2 ��������

�����������������������������������������������������������

���������������������������������������������������������������

���������������������������������������������������������������

������������������������������������������������Unity�����������

��������������������������

1�Unity��������

�������������Pass����������������Pass������������������������

�����������������Unity���������������������������������������

����������������������������Unity 5�����Unity�����������

�http://forum.unity3d.com/threads/official-dropping-vertexlit-rendering-

path- for-unity-5-0.275248/ �������������Unity 5.0��������������������

������������������Unity 5���������������������������������������

�����������

2������������

�Unity��������������Pass������8������������������������������

�����9.4��������������������������8��������������������

http://forum.unity3d.com/threads/official-dropping-vertexlit-rendering-path-for-unity-5-0.275248/


�9.4 ������������������

� � � � � �

unity_LightColor half4[8] ����

unity_LightPosition float4[8] xyz�������������������������z����0�������z����1

unity_LightAtten half4[8]

����������������x���cos(spotAngle/2)�y���

1/cos(spotAngle/4)������������x���−1�y���1�z�������

��w�������������

unity_SpotDirection float4[8] ��������������������������������������(0, 0, 1, 0)

����������������������������unity_LightColor������������������

�����������

�9.5����������������������

�9.5 ������������������

� � � � �

float3 ShadeVertexLights (float4

vertex, float3 normal)

������������������������������������������

��ShadeVertexLightsFull��

float3 ShadeVertexLightsFull (float4

vertex, float3 normal, int lightCount,

bool spotLight)

������������������lightCount��������������

spotLight��true�����������������������������

��������������

9.1.3 ������

������������������������������������������������������������

�����������������������������������������������Pass�������������

�������������������������������������Pass�����������������������

����

������������������������������������������������������������

������������������������������G���G-buffer����G���Geometry����G

�������������������������������������������������������������

1��������



�����������Pass�����Pass�������������������������������������

���������������������������������G������������Pass������G������

����������������������������������

����������������������

Pass 1 { 

    // ���Pass���������� 

    // ���������������G��� 

 

    for (each primitive in this model) { 

        for (each fragment covered by this primitive) { 

            if (failed in depth test) { 

                // ��������������������� 

                discard; 

            } else { 

                // ������� 

                // ����������G��� 

                writeGBuffer(materialInfo, pos, normal, lightDir, viewDir); 

            } 

        } 

    } 

} 

 

Pass 2 { 

    // ��G��������������� 

 

    for (each pixel in the screen) { 

        if (the pixel is valid) { 

            // ��������� 

            // ������G������ 

            readGBuffer(pixel, materialInfo, pos, normal, lightDir, viewDir); 

 

            // �������������� 

            float4 color = Shading(materialInfo, pos, normal, lightDir, viewDir); 

            // ����� 

            writeFrameBuffer(pixel, color); 

        } 

    } 

} 

 

������������Pass��������������������������������������������

�������������������������������������������������������������2D

�������������������������

2�Unity������

Unity������������������������Unity 5�����������������Unity5.x��

���������������������������������������������������������

����������������������������������������������������Unity 5��

����Standard Shader��������Unity 5�������������������������������



��http://docs.unity3d.com/ Manual/RenderTech-DeferredLighting.html �����

����

������������������������������������������������������������

������������������������������

����������anti-aliasing����

����������

���������������������������MRT�Multiple Render Targets��Shader

Mode 3.0��������������������

���������Unity��������Pass�

�1����Pass����G������Pass�����������������������������������

�����������G����������������Pass�������

�2����Pass��������������Pass������Pass�����������������������

���

���G���������Unity�����������������������������Render Texture�

RT��

RT0����ARGB32�RGB������������A��������

RT1����ARGB32�RGB�������������A����������������

RT2����ARGB2101010�RGB���������A��������

RT3����ARGB32��HDR��ARGBHalf�HDR���������+lightmap+����

�reflection probes��

����������

�����Pass�����������������Unity���Standard�������������������

�����������Internal-DeferredShading.shader�����������������

�http://docs.unity3d.com/Manual/RenderTech-DeferredShading.html ��

3������������

� 9.6 �����������������������������UnityDeferred Library.cginc����

�������

�9.6 ����������������

� � � � � �

_LightColor float4 ����

_LightMatrix0 float4×4 ����������������������cookie�������

http://docs.unity3d.com/Manual/RenderTech-DeferredLighting.html
http://docs.unity3d.com/Manual/RenderTech-DeferredShading.html


9.1.4 ��������

Unity������http://docs.unity3d.com/Manual/RenderingPaths.html �����

4��������������������������������������������������������������

���������������������������

����������������������������������������������Unity����������

������

�����������Unity��������

http://docs.unity3d.com/Manual/RenderingPaths.html


9.2 Unity�����

�����������������������������������������������������������������������

�������������������Unity Shader�����������������������������������Unity�����

� �point light� ���� �spot light� �

Unity����4��������������������� �area light� �����������������������������

��������������������������������������������������Unity��������������������

���������������������������������

9.2.1 ���������

�����������������Shader�������������Shader��������������������������� ��

� ������������������ ������� ����������������������������5������������������

����

1����

������������������������������������������������������������������9.5���

Unity�����Scene��������Light������

�����������������������������������������������������������������������

��������������������Transform����Rotation�����������������������������������

��������������������������������������������������������������

2����

�������������������������������������������������������9.6���Unity�����

Scene��������Light������

▲�9.5 ���



▲�9.6 ���

����������������Scene�����������������������������9.7�����Scene��������

������������Range����������Scene���������������������������������������

������������Transform����Position��������������������������������������������

�����������Light�����������������������������������������������������������

���������������0������������������

3����

�����3�����������������������������������������������������������������

������������������9.8���Unity�����Scene��������Light������

▲�9.7 ��Scene������



▲�9.8 ���

��������������Range��������������Spot Angle�������������Scene�����������

�����������������������������������������Transform����Position���������������

���������������������������������������������������������������������������

�0�������������������������������������������������������������

9.2.2 ���������������

����3�������������������Unity Shader������5������ ��� ��� ������� ��������

�������������������

�����������������9.9�����

▲�9.9 ���������������������������������������������

1���

���������������������

�1��Unity��������������������Scene_9_2_2_1��Unity 5.2���������������������

�����������������Window → Lighting → Skybox������������



�2��������������������ForwardRenderingMat�

�3�����Unity Shader���������Shader��Chapter9-ForwardRendering����Unity

Shader���2��������

�4����������������2������������

�5���������������������������������������������

�6������

��������Blinn-Phong��������������Base Pass�Additional Pass�����������������

�����������������������������������������������

�1����������Pass——Base Pass�����������Pass��������

Pass { 

    // Pass for ambient light & first pixel light (directional light) 

    Tags { "LightMode"="ForwardBase" } 

 

    CGPROGRAM 

 

    // Apparently need to add this declaration  

    #pragma multi_compile_fwdbase 

 

�����������������������#pragma �����#pragma multi_ compile_fwdbase ��

�������Shader����������������������������

�2��Base Pass�����������������������

// Get ambient term 

fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

��������������������Additional Pass���������������������������������������

��������

�3�������Base Pass������������������������������������������������Unity��

����������Base Pass���������������������Additional Pass����������������������

����Base Pass�����������������������5������ ��� ������ ���� ���Base Pass������

���������������������_WorldSpaceLightPos0����������������������������

_LightColor0�����������_LightColor0�������������������������������������������

��1.0��������

// Compute diffuse term 

fixed3 diffuse = _LightColor0.rgb * _Diffuse.rgb * max(0, dot(worldNormal, worldLightDir)); 

 

... 

 

// Compute specular term 

fixed3 specular = _LightColor0.rgb * _Specular.rgb * pow(max(0, dot(worldNormal, halfDir)), _Gloss);

 

// The attenuation of directional light is always 1 

fixed atten = 1.0; 

 

return fixed4(ambient + (diffuse + specular) * atten, 1.0); 

 



���Base Pass��������

�4����������������������Additional Pass������������Pass��������

Pass { 

    // Pass for other pixel lights 

    Tags { "LightMode"="ForwardAdd" } 

 

    Blend One One 

 

    CGPROGRAM 

 

    // Apparently need to add this declaration  

    #pragma multi_compile_fwdadd 

 

�������������������#pragma multi_compile_fwdadd ��������������������

Additional Pass�������������Base Pass����������Blend����������������������

Additional Pass�����������������������������������Blend�����Additional Pass�����

������������������������Blend One One ���������������Unity���������������

Blend SrcAlpha One �

�5������Additional Pass������Base Pass������������������Base Pass����������

����Additional Pass�������������������������Base Pass���������������SH�������

�������������������Additional Pass�������������������������Additional Pass�����

��������������������������5���——����������� ���� ���������������_LightColor0

�����������������������������������������������������

#ifdef USING_DIRECTIONAL_LIGHT 

        fixed3 worldLightDir = normalize(_WorldSpaceLightPos0.xyz); 

#else 

        fixed3 worldLightDir = normalize(_WorldSpaceLightPos0.xyz - i.worldPosition.xyz); 

#endif 

 

�����������������������������������#ifdef���������

USING_DIRECTIONAL_LIGHT�������������Pass��������������Unity�����������

USING_DIRECTIONAL_LIGHT�����������������������_WorldSpaceLightPos0.xyz������

����������_WorldSpaceLightPos0.xyz�������������������������������������������

�������

�6������������������

#ifdef USING_DIRECTIONAL_LIGHT 

    fixed atten = 1.0; 

#else 

    float3 lightCoord = mul(_LightMatrix0, float4(i.worldPosition, 1)).xyz; 

    fixed atten = tex2D(_LightTexture0, dot(lightCoord, lightCoord).rr).UNITY_ATTEN_CHANNEL; 

#endif 

 

�������������USING_DIRECTIONAL_LIGHT��������������������������1.0������

���������������������������������������������������������������������������

��Unity���������������Lookup Table�LUT��������������������������������������

�������������������Unity������������9.3��

������������������������������� ����������������������������������������

���9.5�������������Unity Shader�



2����Base Pass�Additional Pass���

���9.1.1����������Unity�����������������������SH���������������������

Unity������������������

�1��Unity��������������������Scene_9_2_2_2��Unity 5.2���������������������

�����������������Window -> Lighting -> Skybox������������

�2�������������

�3��������������������ForwardRenderingMat���������

�4���4�������������������

�5������

���������9.10�����

▲�9.10 ��1���� + 4����������

���������������������������������Render Mode ����Light�������Auto ����

��Unity�����������������������������SH��������������Edit → Project Settings →

Quality → Pixel Light Count�����������������������������4���������������������5

����������������Chapter9-Forward Rendering�Base Pass��������������4���������

���Render Mode �Auto �������4������Chapter9-ForwardRendering�Additional Pass��

������������������Additional Pass�

�Unity 5������������� �Frame Debugger� ��������������������Window ->

Frame Debugger����������9.11���

�����������������Unity�����6�����������������������6��������������������

��������������������������Unity����������9.12������Unity���6������



▲�9.11 ���������������

▲�9.12 ����6�����������������������

��9.12�����Unity�����������������������������Unity�����������������������

������������Unity��Chapter9-ForwardRendering����Pass��Base Pass��������������

������4�������Unity��Chapter9-ForwardRendering����Pass��Additional Pass����4���

���������������������

������Unity�������������������������������������������������������������

�����������9.12������������������������������������������������������������

����������������0.2��������������������������������������������������������

�����Unity������������������������������������������������������������

���������������������������Unity����������Pass��������������������������

�������������������������������������������������9.13����������������������

��Unity�������������������



▲�9.13 ���������������������������������������������Unity�����Additional Pass�����������

������������������������Additional Pass�����������������������Render

Mode ��Not Important ���Unity����������������������������4�����Render

Mode ���Not Important ������9.14�����

▲�9.14 �����Render Mode ��Not Important � ����������������

�����Chapter9-ForwardRendering����Bass Pase�������SH���������4�����������

��������������������Render Mode ���Not Important �������������������������

������������

���������������Base Pass�������SH���������9.1.1�������������������������



9.3 Unity�����

�9.2�������Unity������������������������������������������������

����������������������������������������������

�����������������������������

���������������������������������������������

������������������������������������������Unity�����������������

�����������������

9.3.1 ���������

Unity���������_LightTexture0� ����������������������������cookie���

�������_LightTextureB0�������������������_LightTexture0���������������

����������������������(0, 0)�������������������(1, 1)����������������

��������

���_LightTexture0������������������������������������������

_LightMatrix0���������9.1.1���������_LightMatrix0����������������������

�����_LightMatrix0����������������������������

float3 lightCoord = mul(_LightMatrix0, float4(i.worldPosition, 1)).xyz; 

 

����������������������������������

fixed atten = tex2D(_LightTexture0, dot(lightCoord,  lightCoord).rr).UNITY_ATTEN_CHANNEL; 

 

���������������������������������dot���������������������������

�����������������������UNITY_ATTEN_CHANNEL�����������������������

����

9.3.2 ����������

���������������������������������������������������������������

������

float distance = length(_WorldSpaceLightPos0.xyz - i.worldPosition.xyz); 

atten = 1.0 / distance; // linear attenuation 

 

�����Unity������������������������������������������������������

���Shader���������������������������������������������������������

�����������������������������������Unity����������Additional Pass���



���������������������Shader�����������������������Unity������������

���������



9.4 Unity���

������������������������������������������������������������Unity

�������������������������������������

9.4.1 ��������

�����������������������������������������������������������������

����������������������������������������������������

�������������������Shadow Map ���������������������������������

�����������������������������������Unity����������

���������������������������Unity�����������������shadowmap������

�����������������������������������������������������

�����������������������������������������������������������������

��Base Pass�Additional Pass��������������������������������������������

���������Base Pass�Additional Pass��������������������Unity���������Pass

�����������������Pass��LightMode ������ShadowCaster �Pass���Pass���

������������������������Unity���������������������Pass���������������

���������������������������������������������������������Unity Shader

���LightMode �ShadowCaster �Pass����������Fallback ���Unity Shader���

�����������������������������������������������������LightMode �

ShadowCaster �Pass��Unity����Pass�������������

������������������������Pass�������������������������������������

���xy���������������������������������������������������z�����������

���������Unity 5��Unity������������������������������ �Screenspace

Shadow Map� �����������������������������������������Unity���������

��������������������MRT����������������

�����������������Unity�������LightMode �ShadowCaster �Pass������

��������������������������������������������������������������������

��������������������������������������������������������������������

�������������������������������������Shader������������������������

����������������������������������������������

���������������������������������������

��������������������������Shader���������������������������������

���������������

�����������������������������������������������������������������

�����������Unity���������������LightMode �ShadowCaster �Pass���

�������������������Unity������Pass�������������

����������������Unity����������



9.4.2 ��������

��������������

�1��Unity��������������������Scene_9_4_2��Unity 5.2����������������

����������������������Window → Lighting → Skybox������������

�2��������������������ShadowMat����9.2���Chapter9-ForwardRendering

����

�3���������������������2�������������������������������������

Standard����

�4������

���������������������������������������Light����������9.15���

��������������Soft Shadows��

1��������

�Unity�����������������������������Mesh Renderer ����Cast

Shadows �Receive Shadows ���������9.16���

▲�9.15 ���������

▲�9.16 Mesh Renderer���Cast Shadows �Receive Shadows �������������/����



Cast Shadows ���������On�����Off�������Cast Shadows �����Unity��

��������������������������������������������������������������������

����LightMode �ShadowCaster �Pass�����Receive Shadows ������������

����������������Receive Shadows ��������Unity�����������������������

����������������������������������������

������������Cast Shadows �Receive Shadows �������������9.17���

��

▲�9.17 ��Cast Shadows �Receive Shadows ����������������

��9.17������������������Chapter9-ForwardRendering�����������������

��������������������“�����Unity���LightMode �ShadowCaster �Pass����

�������������Chapter9-ForwardRendering��������Pass��”������Chapter9-

Forward Rendering�SubShader������Pass——��Base Pass���Additional Pass���

����������������������Chapter9- ForwardRendering��Fallback ���

Fallback "Specular" 

 

�Chapter9-ForwardRendering�������Fallback���������Unity Shader�����

Specular���Specular�����������Pass�������Fallback���VertexLit������������

�����VertexLit������Unity�����������builtin-shaders-xxx-

>DefaultResourcesExtra->Normal- VertexLit.shader������������“���”�

LightMode �ShadowCaster �Pass��

// Pass to render object as a shadow caster 

Pass { 

    Name "ShadowCaster" 

    Tags { "LightMode" = "ShadowCaster" } 

 

    CGPROGRAM 



    #pragma vertex vert 

    #pragma fragment frag 

    #pragma multi_compile_shadowcaster 

    #include "UnityCG.cginc" 

 

    struct v2f {  

        V2F_SHADOW_CASTER; 

    }; 

 

    v2f vert( appdata_base v ) 

    { 

        v2f o; 

        TRANSFER_SHADOW_CASTER_NORMALOFFSET(o) 

        return o; 

    } 

 

    float4 frag( v2f i ) : SV_Target 

    { 

        SHADOW_CASTER_FRAGMENT(i) 

    } 

    ENDCG 

 

} 

 

���������������������������������������������������������Unity 5��

��Pass�����������������������������

�����Chapter9-ForwardRendering��Fallback���������������������������

�������Fallback�����SubShader������LightMode �ShadowCaster �Pass����

���Pass�����������������������Pass�����������Unity Shader���������

Fallback�������������������������Fallback������Diffuse���Diffuse���������

��Pass�������Fallback���VertexLit���Unity���������LightMode �

ShadowCaster �Pass�����������������9.4.2����������LightMode �

ShadowCaster �Pass�������������

�9.17��������������������������������������Cast Shadows ��������

��������������������������������������������������������������������

������������������frontface�����������������������Cast Shadows ���

Two Sided �������������������9.18����������Cast Shadows ���Two

Sided �����



▲�9.18 �Cast Shadows ���Two Sided ����������������

������������������������������Standard Shader�������Shader��������

��������������Chapter9-ForwardRendering������������������������������

���������������������������

2��������

���������������������Unity Shader�������������Chapter9-Shadow����

Chapter9-Shadow����������ShadowMat���Chapter9- Shadow������Chapter9-

ForwardRendering����������������������������������������������

�1�������Base Pass�������������

#include "AutoLight.cginc"� 

 

������������������������������

�2���������������v2f���������SHADOW_COORDS �

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    SHADOW_COORDS(2) 

}; 

 

�����������������������������������������������������������������

�����2�

�3������������������������TRANSFER_SHADOW �

v2f vert(a2v v) { 

    v2f o;   



    ...      

    // Pass shadow coordinates to pixel shader 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

����������������������������

�4������������������������������SHADOW_ ATTENUATION �

// Use shadow coordinates to sample shadow map 

fixed shadow = SHADOW_ATTENUATION(i); 

 

SHADOW_COORDS �TRANSFER_SHADOW �SHADOW_ATTENUATION ��

�����“���”���������������������������AutoLight.cginc���������

  // ---------------- 

//  Shadow helpers 

// ---------------- 

 

// ---- Screen space shadows 

#if defined (SHADOWS_SCREEN) 

    UNITY_DECLARE_SHADOWMAP(_ShadowMapTexture); 

    #define SHADOW_COORDS(idx1) unityShadowCoord4 _ShadowCoord : TEXCOORD##idx1; 

    #if defined(UNITY_NO_SCREENSPACE_SHADOWS) 

        #define TRANSFER_SHADOW(a) a._ShadowCoord = mul( unity_World2Shadow[0],    

        mul( _Object2World, v.vertex ) ); 

        inline fixed unitySampleShadow (unityShadowCoord4 shadowCoord) 

        { 

            ... 

        } 

    #else // UNITY_NO_SCREENSPACE_SHADOWS 

        #define TRANSFER_SHADOW(a) a._ShadowCoord = ComputeScreenPos(a.pos); 

        inline fixed unitySampleShadow (unityShadowCoord4 shadowCoord) 

        { 

            fixed shadow = tex2Dproj( _ShadowMapTexture, UNITY_PROJ_COORD(shadowCoord) ).r; 

            return shadow; 

        } 

    #endif 

    #define SHADOW_ATTENUATION(a) unitySampleShadow(a._ShadowCoord) 

#endif 

 

// ---- Spot light shadows 

#if defined (SHADOWS_DEPTH) && defined (SPOT) 

        ... 

#endif 

 

 

// ---- Point light shadows 

#if defined (SHADOWS_CUBE) 

    ... 

#endif 

 

// ---- Shadows off 

#if !defined (SHADOWS_SCREEN) && !defined (SHADOWS_DEPTH) && !defined (SHADOWS_CUBE) 

    #define SHADOW_COORDS(idx1) 

    #define TRANSFER_SHADOW(a) 

    #define SHADOW_ATTENUATION(a) 1.0 



#endif 

 

��������������������Unity����������������������������������

SHADOW_COORDS ������������_ShadowCoord�����������

TRANSFER_SHADOW �����������������������������������������������

UNITY_NO_SCREENSPACE_ SHADOWS �����TRANSFER_SHADOW ������

ComputeScreenPos�����_ShadowCoord���������������������������������

��TRANSFER_SHADOW ����������������������_ShadowCoord�����

SHADOW_ATTENUATION����_ShadowCoord������������������

�����������������������������������������SHADOW_COORDS �

TRANSFER_SHADOW ����������SHADOW_ATTENUATION ��������1�

��������� ������������������������TRANSFER_ SHADOW���v.vertex�

a.pos��������������������������������������������������������a2f�����

����������vertex ������������v2f�����v ��v2f�������������pos �

�5�����������������������shadow�����������������

�������Unity������������������������������9.19���

▲�9.19 ����������������

��������������������Base Pass��������������������Additional Pass����

�������Additional Pass������Base Pass���������9.4.4���������������������

�������������������������������9.5���������������Unity Shader�

9.4.3 ��������������



��������������������������������������������������Unity 5���������

——���������9.2.2��������Pass��������������������������

��������Window -> Frame Debugger���������9.20���Scene_9_4_2������

������

��9.20����������������20����������������4����UpdateDepthTexture��

�����������RenderShadowmap�����������������CollectShadows�����������

������������������������

▲�9.20 ��������������

��������������������������4������������������������������9.21����

�������������



▲�9.21 �������������

������������������������������9.21���������Unity���Shader: Unity

Shader Book/Chapter9 Shadow pass #3 ���������Chapter9-Shadow�����

Pass���Chapter9-Shadow�������Pass�����������Unity����Fallback������

Pass��LightMode �ShadowCaster �Pass��������������������������������

����������Unity�������Pass�������������

��������Unity�����������������������9.22���

�����������������������������������������Shader������������������

����9.23�������Unity�������������������

▲�9.22 ��������



▲�9.23 Unity���������

9.4.4 �����������

�9.2��9.3������������Unity Shader��������������——�Base Pass�������

�������1���Additional Pass���������Pass��������������������������������

�����������������������——������������������������������������������

��������������������Unity�Shader�������������������

UNITY_LIGHT_ATTENUATION ������

�������������

�1���9.4.2�������������������Scene_9_4_4�

�2��������������������AttenuationAndShadowUseBuildInFunctionsMat�

�3�����Unity Shader���������Shader��Chapter9-

AttenuationAndShadowUse BuildInFunctions����Shader���2��������

�4���2�������������

�5������

��Chapter9-AttenuationAndShadowUseBuildInFunctions��Chapter9-Shadow�

����������Chapter9-Shadow�����������������������������Unity����������

������������������������



�1�������������

// Need these files to get built-in macros 

#include "Lighting.cginc" 

#include "AutoLight.cginc" 

 

�2��v2f���������SHADOW_COORDS �������

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    SHADOW_COORDS(2) 

}; 

 

�3�������������TRANSFER_SHADOW ����������������

v2f vert(a2v v) { 

    v2f o; 

    ... 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

�4��9.4.2������������������������UNITY_LIGHT_ ATTENUATION �����

������

fixed4 frag(v2f i) : SV_Target { 

    ... 

 

    // UNITY_LIGHT_ATTENUATION not only compute attenuation, but also shadow infos 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    return fixed4(ambient + (diffuse + specular) * atten, 1.0); 

} 

 

UNITY_LIGHT_ATTENUATION �Unity�������������������������

AutoLight.cginc�������������3�����������������������������������������

����������atten �����UNITY_LIGHT_ATTENUATION ���������������������

�v2f���������9.4.2�����SHADOW_ATTENUATION ����������������������

�������9.3������������������������������������������������������

AutoLight.cginc�UNITY_LIGHT_ ATTENUATION �����������Unity�����������

��cookie�������������UNITY_LIGHT_ATTENUATION ���������������������

������������������

�5������UNITY_LIGHT_ATTENUATION ����Base Pass�Additional Pass����

���——������Base Pass�������������Additional Pass����������������������

�UNITY_LIGHT_ATTENUATION ���������Unity�������������������Additional

Pass�������������#pragma multi_compile_fwdadd_fullshadows�������



Additional Pass��#pragma multi_compile_fwdadd��������Unity��������������

��������Shader�

9.4.5 ��������

�������������Unity������������������������Unity Shader�����

LightMode �ShadowCaster �Pass����������������VertexLit ����

ShadowCaster ������VertexLit ��ShadowCaster �����������������������

������������������������������������

��������������Fallback ��VertexLit �������������������������������

�����������������������������������������Fallback�

������������������������VertexLit�Diffuse�Specular������������������

��������������������������VertexLit���������������������������

Scene_9_4_5_a���������������������������� + ���������������������

Unity Shader���AlphaTestWithShadowMat�Chapter9-AlphaTestWithShadow�

Chapter9-AlphaTestWithShadow����8.3������������������������������

�1�������������

#include "Lighting.cginc" 

#include "AutoLight.cginc" 

 

�2��v2f������SHADOW_COORDS ���������

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 worldNormal : TEXCOORD0; 

    float3 worldPos : TEXCOORD1; 

    float2 uv : TEXCOORD2; 

    SHADOW_COORDS(3) 

}; 

 

������������� 3 ���������TEXCOORD0�TEXCOORD1�TEXCOORD2�������

��SHADOW_COORDS �������3�����������������������TEXCOORD3�

�3����������������TRANSFER_SHADOW ������������������

v2f vert(a2v v) { 

    v2f o; 

    ... 

    // Pass shadow coordinates to pixel shade 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

�4��������������UNITY_LIGHT_ATTENUATION ����������



fixed4 frag(v2f i) : SV_Target { 

    ... 

    // UNITY_LIGHT_ATTENUATION not only compute attenuation, but also shadow infos 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    return fixed4(ambient + diffuse * atten, 1.0); 

} 

 

�5����������Fallback���VertexLit������Shader�

Fallback "VertexLit" 

 

������transparent_texture.psd���������������������9.24�����

�����������������������������������������������������������������

��������������������������������������������������VertexLit ����

ShadowCaster ���������Pass�����������������������������������������

�����������������������������������������������ShadowCaster Pass ��

���������������Pass���������������Unity Shader�������

�����������������������������Unity Shader����������Fallback���

Transparent/Cutout/VertexLit ������8.3���������������������Unity

Shader������ShadowCaster Pass ������������������������������������

��������� ���Transparent/Cutout/VertexLit ���������������_Cutoff������

���������������Shader��������_Cutoff���������������������

����Fallback���������9.25�����

▲�9.24 �����������������



▲�9.25 �����Fallback�����������

�����������������������������������������������������������������

��������������������������������������������������������������������

�����������Mesh Renderer����Cast Shadows�����Two Sided ���Unity������

����������������9.26��������������

▲�9.26 �����Cast Shadow�������������

�������������������������������������������������������Unity

Shader��Transparent/VertexLit������������Pass��������������������������

���������������������������������������������������Scene_9_4_5_b����

������������������������ + ��������������������� Unity Shader ���

AlphaBlendWithShadowMat � Chapter9-AlphaBlendWithShadow�Chapter9-

AlphaBlendWithShadow����8.4����������������������������������Fallback�

���Transparent/VertexLit��9.27��������



Unity������������������������������������������������������������

��������������������������������������������������������������������

�Unity����������Shader������������������������dirty trick���������������

��������Fallback���VertexLit�Diffuse����������Unity Shader���Unity�����

Fallback���������Pass�������������Mesh Renderer����Cast Shadows�Receive

Shadows�����������������������9.28����Fallback��VertexLit��������������

�����������

▲�9.27 ����������Unity Shader�Fallback������Transparent/VertexLit�������������������������������

����������������

▲�9.28 �Fallback��VertexLit�������������



�����������������������������������������������������������������

�������������������



9.5 �������Unity Shader

������������������������������������Unity�������

������������������������������������������Unity����

��������������������������������������������������

������Assets/ Shaders/Common��������������Unity

Shader——BumpedDiffuse�BumpedSpecular����Unity

Shader����������������������������������

BumpedDiffuse���Phong������BumpedSpecular���Blinn-

Phong��������������������������������������������

Unity Shader���������Assets/Material/Objects�

Assets/Material/Walls���������������������������������

�Unity Shader��������Unity Shader�



�10� ����

����7������������������������������������������

�������������������������������������������10.1����

��������������Cubemap���������������10.2����������

——�����Render Texture���������������������10.3�����

����Procedure Texture��



10.1 �����

����������� �Cubemap� ����� �Environment Mapping� ��������������������

�������������������������������������

���������������������6�����������������6��������������������������������

���������������������������������������������������������������������������

������������������������������3D����������������������������������6��������

�����������������������10.1���������������������

▲�10.1 ���������

������������������������������������������������������������������������

���������������������������������������������������������������������������

������������������Unity 5�������������������������18�����������������������

���������������������������������������

�����������������������������Skybox��������

10.1.1 ����

���� �Skybox� ����������������������������������������������������������

���������������������������������������������������������������������

�Unity������������������������Skybox�������������������

������������Skybox���

�1�������������������SkyboxMat�

�2��SkyboxMat�Unity Shader�������Unity���Skybox/6 Sided������6����

�3���������Assets/Textures/Chapter10/Cubemaps�����6�����2�����������6�����

�����posz�����Front [+Z] ����������������������6����Wrap Mode ���Clamp �����

������������

�����������10.2���



▲�10.2 ������

���������6��������3����Tint Color ��������������Exposure �������������

Rotation ����������+y���������

����������������Skybox�

�1�������������������Scene_10_1_1�

�2��Window → Lighting�����SkyboxMat��Skybox�����10.3���

�������������������������������Camera����Clear Flags����Skybox ����������

���10.4���



▲�10.3 �������������

▲�10.4 ����������

��������Window → Lighting → Skybox����������������������������������������

�����������������Skybox ����������������������������Component → Rendering →

Skybox����������������

�Unity����������������������������������������������

10.1.2 ��������������

������������������������������������������������

�Unity 5��������������������������������������������������������Cubemap�

����6������������������

���������������������������������������������������������������Texture

Type ���Cubemap ���Unity�������������������������������HDR���������

Cubemap����18������������http://docs.unity3d.com/Manual/class-Cubemap.html �����

�����

������Unity 5����������������������������Cubemap����6�������������Unity 5

����������������������������������������������������������glossy reflection��

http://docs.unity3d.com/Manual/class-Cubemap.html


HDR����

������������������������������������������������������������������������

����������������������������Unity���������������Unity���

Camera.RenderToCubemap �������Camera.RenderToCubemap��������������������

�6�����������������������

�Unity�����

�http://docs.unity3d.com/ScriptReference/Camera.RenderToCubemap.html ���������

Camera.RenderToCubemap�������������������������

Assets/Editor/Chapter10/RenderCubemapWizard.cs�����������������

void OnWizardCreate () { 

    // create temporary camera for rendering 

    GameObject go = new GameObject( "CubemapCamera"); 

    go.AddComponent<Camera>(); 

    // place it on the object 

    go.transform.position = renderFromPosition.position; 

    // render into cubemap       

    go.GetComponent<Camera>().RenderToCubemap(cubemap); 

 

    // destroy temporary camera 

    DestroyImmediate( go ); 

} 

 

�����������renderFromPosition�����������������������

Camera.RenderToCubemap���������������������������cubemap������������������

���������������������Editor�����������

���������������Cubemap�����

�1������10.1.1���������������GameObject���������GameObject��������������

�2�����������������Project����������Create → Legacy → Cubemap�������������

�������Cubemap_0������������������������������������Readable ���

�3��Unity�����GameObject -> Render into Cubemap���������������������������

�1�����GameObject��2�����Cubemap_0���������Render From Position �Cubemap

�����10.5���

�4�������Render! ���������������������6������Cubemap_0����10.6���

http://docs.unity3d.com/ScriptReference/Camera.RenderToCubemap.html


▲�10.5 �����������

▲�10.6 �����������

������������Cubemap�������10.6��Face size ���Face size��������������������

��������������������������������������

��������������������������������������������������

10.1.3 ��

������������������������������������������������������������������������

���������������������������10.7�����



▲�10.7 ��������Teapot��

���������������

�1��������������������Scene_10_1_3������Unity 5�������������10.1.1��������

������Window → Lighting → Skybox������������������Skybox��������������

�2���������Teapot�����������10.1.2����Cubemap_0�����GameObject������

�3��������������������ReflectionMat�������2�����Teapot���

�4�����Unity Shader���������Shader��Chapter10-Reflection��Chapter10-Reflection

���3��������

������������Chapter10-Reflection������������������

�1���������3������

Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _ReflectColor ("Reflection Color", Color) = (1, 1, 1, 1) 

    _ReflectAmount ("Reflect Amount", Range(0, 1)) = 1 

    _Cubemap ("Reflection Cubemap", Cube) = "_Skybox" {} 

} 

 

���_ReflectColor���������_ReflectAmount���������������_Cubemap������������

����

�2�����������������������������CG�reflect �������

v2f vert(a2v v) { 

    v2f o; 

 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 



 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    o.worldViewDir = UnityWorldSpaceViewDir(o.worldPos); 

 

    // Compute the reflect dir in world space 

    o.worldRefl = reflect(-o.worldViewDir, o.worldNormal); 

 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

��������������������������������������������������������������������

�3�������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos));       

    fixed3 worldViewDir = normalize(i.worldViewDir);         

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    fixed3 diffuse = _LightColor0.rgb * _Color.rgb * max(0, dot(worldNormal, worldLightDir)); 

 

    // Use the reflect dir in world space to access the cubemap 

    fixed3 reflection = texCUBE(_Cubemap, i.worldRefl).rgb * _ReflectColor.rgb; 

 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    // Mix the diffuse color with the reflected color 

    fixed3 color = ambient + lerp(diffuse, reflection, _ReflectAmount) * atten; 

 

    return fixed4(color, 1.0); 

} 

 

�������������CG�texCUBE �������������������������i.worldRefl�������������

�������������������texCUBE������������������������������_ReflectAmount������

��������������������

������������������������������������������������������������������������

�������������������������������������������

���������������Cubemap_0���Reflection Cubemap �������������������10.7��

���

10.1.4 ��

��������������Unity Shader���������������——���

������������������������������������������������������������������������

����������������������� �Snell's Law� ������������1����������θ 1 ��������2����

��������������������θ 2 �

η 1 sinθ 1 =η 2 sinθ 2

���η 1 �η 2 ����������� �index of refraction� ������������������������1������

�����1.5��10.8�������������



������������������������������������������������������������������������

��—— ����������������������������������������������������������������������

������“��������”����������——�������“�����������������”���������������������

��

�����������������10.9�����

▲�10.8 �����

▲�10.9 ��������Teapot��

���������������

�1��������������������Scene_10_1_4������Unity 5�������������10.1.1��������

������Window → Lighting → Skybox������������������Skybox��������������

�2���������Teapot�����������



�3��������������������RefractionMat�������2�����Teapot���

�4�����Unity Shader���������Shader��Chapter10-Refraction��Chapter10-

Refraction���3��������

����������������Chapter10-Refraction������������������

�1���������4�����

Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _RefractColor ("Refraction Color", Color) = (1, 1, 1, 1) 

    _RefractAmount ("Refraction Amount", Range(0, 1)) = 1 

    _RefractRatio ("Refraction Ratio", Range(0.1, 1)) = 0.5 

    _Cubemap ("Refraction Cubemap", Cube) = "_Skybox" {} 

} 

 

���_RefractColor�_RefractAmount�_Cubemap�10.1.3���������������������������

���_RefractRatio�������������������������������

�2����������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = UnityObjectToWorldNormal(v.normal); 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    o.worldViewDir = UnityWorldSpaceViewDir(o.worldPos); 

 

    // Compute the refract dir in world space 

    o.worldRefr = refract(-normalize(o.worldViewDir), normalize(o.worldNormal), _RefractRatio); 

 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

�����CG�refract ���������������������������������������������������������

���������������������������������������������������������������������������

���������������1/1.5�������������������������������

�3������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

    fixed3 worldViewDir = normalize(i.worldViewDir); 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    fixed3 diffuse = _LightColor0.rgb * _Color.rgb * max(0, dot(worldNormal, worldLightDir)); 

 

    // Use the refract dir in world space to access the cubemap 

    fixed3 refraction = texCUBE(_Cubemap, i.worldRefr).rgb * _RefractColor.rgb; 

 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    // Mix the diffuse color with the refract color 

    fixed3 color = ambient + lerp(diffuse, refraction, _RefractAmount) * atten; 



 

    return fixed4(color, 1.0); 

} 

 

���������i.worldRefr������������������������������������_RefractAmount�����

���������������������

���������������Cubemap_0���Reflection Cubemap �������������������10.9��

���

10.1.5 �����

������������������� �Fresnel reflection� ����������������������������������

���������������������������������������������������������������������������

���������������������������������������������������������������������������

���������������������������������������������������������������������������

��������������������������������������������18��������John Hable����������

Everything Has Fresnel �http://filmicgames.com/archives/557 ��������������������

������������������������������������������������������������������������

�����������Schlick ������� �

���F 0 ��������������������� v ������ n �������������������Empricial ������

� �

���bias �scale �power �����

��������������������������������/���������������������������������������

�������������

����������Schlick�������������������������������10.10�������������������

��

http://filmicgames.com/archives/557


▲�10.10 ���������Teapot��

���������������

�1��������������������Scene_10_1_5������Unity 5�������������10.1.1��������

������Window → Lighting → Skybox������������������Skybox��������������

�2���������Teapot�����������

�3��������������������FresnelMat�������2�����Teapot���

�4�����Unity Shader���������Shader��Chapter10-Fresnel��Chapter10- Fresnel���3

��������

��Chapter10-Fresnel������������������

�1�������Properties��������������������������Cubemap�

Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _FresnelScale ("Fresnel Scale", Range(0, 1)) = 0.5 

    _Cubemap ("Reflection Cubemap", Cube) = "_Skybox" {} 

} 

 

�2�������������������������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.worldNormal = mul(v.normal, (float3x3)_World2Object); 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    o.worldViewDir = UnityWorldSpaceViewDir(o.worldPos); 

 

    o.worldRefl = reflect(-o.worldViewDir, o.worldNormal); 

 

    TRANSFER_SHADOW(o); 



 

    return o; 

} 

 

�3�����������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

    fixed3 worldViewDir = normalize(i.worldViewDir); 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz; 

 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    fixed3 reflection = texCUBE(_Cubemap, i.worldRefl).rgb; 

 

    fixed fresnel = _FresnelScale + (1 - _FresnelScale) * pow(1 - dot(worldViewDir, worldNormal), 5);

 

    fixed3 diffuse = _LightColor0.rgb * _Color.rgb * max(0, dot(worldNormal, worldLightDir)); 

 

    fixed3 color = ambient + lerp(diffuse, reflection, saturate(fresnel)) * atten; 

 

    return fixed4(color, 1.0); 

} 

 

������������Schlick����������fresnel������������������������������fresnel���

�������������������������

���������������Cubemap_0���Cubemap �������������������10.10���������

_FresnelScale���1���������Cubemap������_FresnelScale�0������������������������

��15.2�����������������������������������



10.2 ����

������������������������������������������GPU��������������������������

��� �Render Target Texture�RTT� ����������������back buffer��������������

�Multiple Render Target�MRT� ��������GPU����������������������������������

��������������������������������

Unity�������������������——���� �Render Texture� ��Unity�����������������

����Project�����������������������������������������������������������������

�����������������������������������������������������GrabPass���

OnRenderImage������������Unity��������������������������������������Pass���

������������������������������������Unity�����OnRenderImage�����12������

10.2.1 ����

������������������������������������������10.11�����

�10.11 ����

���������������

�1��������������������Scene_10_2_1��Unity 5.2����������������������������

����������Window → Lighting → Skybox������������

�2��������������������MirrorMat�

�3�����Unity Shader���������Shader��Chapter10-Mirror����Shader���2��������

�4�������6���������������������������������6���������9.5���������������

�������������3��������������������������

�5���3����������������������������9.5������������������������

�6���������Quad���������������������2�����������



�7��Project����������������Create → Render Texture����������������

MirrorTexture�����������10.12�����

�8���������������������������������������������������������������������

��������������������������������������7�����MirrorTexture��������Target Texture

���10.12�������������������

�10.12 ��������Target Texture��������������������������

�����������������������������������������������������������Chapter10-

Mirror��������������������

�1��Properties���������������������������������

Properties { 

    _MainTex ("Main Tex", 2D) = "white" {} 

} 

 

�2���������������

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord; 

    // Mirror needs to filp x 

    o.uv.x = 1 - o.uv.x; 

 

    return o; 

} 

 

�������������x�����������������������������

�3���������������������

fixed4 frag(v2f i) : SV_Target { 

    return tex2D(_MainTex, i.uv); 

} 

 

���������������MirrorTexture����������Main Tex����������10.11�����



������������������������256×256����������������������������������������

������������������������������������������

10.2.2 ����

�Unity��������Unity Shader��������Pass����������������GrabPass�����Shader�

�����GrabPass��Unity��������������������������Pass������������GrabPass������

�������������������������GrabPass������������������������������������������

�������������

����������GrabPass��������������������� ��������GrabPass����������������

�����������������������������������"Queue"="Transparent"��������������������

����������������������������

�����������GrabPass���������������������������10.13���������������������

������������������������10.1�������������Cubemap���������������������

GrabPass�������������������������������������������������������

���������������

�1��������������������Scene_10_2_2��Unity 5.2����������������������������

����������Window → Lighting→ Skybox������������

�2��������������������GlassRefractionMat�

�3�����Unity Shader���������Shader��Chapter10-GlassRefraction����Unity

Shader���2��������

�4���������������������������������6�����������������������������������

���������������������������2�������������

�5�����������������������10.1.2������������������Gameobject → Render into

Cubemap��������������10.14�����������Cubemap��Glass_Cubemap�

▲�10.13 ����



▲�10.14 ����������

����������Chapter10-GlassRefraction������������

�1�����������Shader��������

Properties { 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _BumpMap ("Normal Map", 2D) = "bump" {} 

    _Cubemap ("Environment Cubemap", Cube) = "_Skybox" {} 

    _Distortion ("Distortion", Range(0, 100)) = 10 

    _RefractAmount ("Refract Amount", Range(0.0, 1.0)) = 1.0 

} 

 

���_MainTex������������������_BumpMap���������_Cubemap�������������

_Distortion������������������_RefractAmount����������_RefractAmount��0��������

������_RefractAmount��1�������������

�2��������������GrabPass��������

SubShader { 

    // We must be transparent, so other objects are drawn before this one. 

    Tags { "Queue"="Transparent" "RenderType"="Opaque" } 

 

    // This pass grabs the screen behind the object into a texture. 

    // We can access the result in the next pass as _RefractionTex 

    GrabPass { "_RefractionTex" } 

 



�����SubShader������������Transparent�������RenderType�����Opaque�������

������������������������Queue���Transparent��������������������������������

�����������“���������”����RenderType�������������Shader Replacement���������

���������������������������������������13�����

����������GrabPass������������Pass����Pass������������������������������

�����������������������������������������������������������������������

�3����������Pass����Shader������������������������

sampler2D _MainTex; 

float4 _MainTex_ST; 

sampler2D _BumpMap; 

float4 _BumpMap_ST; 

samplerCUBE _Cubemap; 

float _Distortion; 

fixed _RefractAmount; 

sampler2D _RefractionTex; 

float4 _RefractionTex_TexelSize; 

 

�������������_RefractionTex�_RefractionTex_TexelSize����������GrabPass�������

��_RefractionTex_TexelSize�����������������������256×512�����������(1/256,

1/512)���������������������������

�4���������������

v2f vert (a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.scrPos = ComputeGrabScreenPos(o.pos); 

 

    o.uv.xy = TRANSFORM_TEX(v.texcoord, _MainTex); 

    o.uv.zw = TRANSFORM_TEX(v.texcoord, _BumpMap); 

 

    float3 worldPos = mul(_Object2World, v.vertex).xyz;   

    fixed3 worldNormal = UnityObjectToWorldNormal(v.normal);   

    fixed3 worldTangent = UnityObjectToWorldDir(v.tangent.xyz);   

    fixed3 worldBinormal = cross(worldNormal, worldTangent) * v.tangent.w;  

 

    o.TtoW0 = float4(worldTangent.x, worldBinormal.x, worldNormal.x, worldPos.x);   

    o.TtoW1 = float4(worldTangent.y, worldBinormal.y, worldNormal.y, worldPos.y);   

    o.TtoW2 = float4(worldTangent.z, worldBinormal.z, worldNormal.z, worldPos.z);   

 

    return o; 

} 

 

������������������������ComputeGrabScreenPos��������������������������

UnityCG.cginc�����������������ComputeScreenPos�����������������������������

5.6.1����������������_MainTex�_BumpMap�����������������float4�����xy�zw�����

���������������������������������������������Cubemap����������������������

�������������������������������TtoW0�TtoW1�TtoW2�xyz����������������������

���3�����xyz������������������������������������� �����������TtoW0���w����

��������������������

�5������������

fixed4 frag (v2f i) : SV_Target {        

    float3 worldPos = float3(i.TtoW0.w, i.TtoW1.w, i.TtoW2.w); 



    fixed3 worldViewDir = normalize(UnityWorldSpaceViewDir(worldPos)); 

 

    // Get the normal in tangent space 

    fixed3 bump = UnpackNormal(tex2D(_BumpMap, i.uv.zw));    

 

    // Compute the offset in tangent space 

    float2 offset = bump.xy * _Distortion * _RefractionTex_TexelSize.xy; 

    i.scrPos.xy = offset + i.scrPos.xy; 

    fixed3 refrCol = tex2D(_RefractionTex, i.scrPos.xy/i.scrPos.w).rgb; 

 

    // Convert the normal to world space 

    bump = normalize(half3(dot(i.TtoW0.xyz, bump), dot(i.TtoW1.xyz, bump), dot(i.TtoW2.xyz, bump)));

    fixed3 reflDir = reflect(-worldViewDir, bump); 

    fixed4 texColor = tex2D(_MainTex, i.uv.xy); 

    fixed3 reflCol = texCUBE(_Cubemap, reflDir).rgb * texColor.rgb; 

 

    fixed3 finalColor = reflCol * (1 - _RefractAmount) + refrCol * _RefractAmount; 

 

return fixed4(finalColor, 1); 

} 

 

������TtoW0����w�������������������������������������������������������

������_Distortion����_RefractionTex_TexelSize�����������������������_Distortion��

���������������������������������������������������������������������������

���������scrPos�������������������4.9.3�����������������_RefractionTex��������

�������

�������������������������������������TtoW0�TtoW1�TtoW2����������������

�������������������������������������Cubemap�������������������������

�������_RefractAmount�������������������������

�������������Glass_Diffuse.jpg�Glass_Normal.jpg�������Main Tex�Normal Map���

������Glass_Cubemap��Environment Cubemap������_RefractAmount���������10.13�

������

�����������GrabPass�������������������������������������GrabPass�������

����GrabPass { }�������Pass�����_GrabTexture������������������������������

���������������������������������Unity����������������������������������

�������������������������������������

��GrabPass { "TextureName" }������������������Pass���TextureName����������

��������������Unity���������������TextureName���������������������������

���Pass������������������������������������Unity������������������������

���������������������������

10.2.3 ���� vs. GrabPass

��GrabPass�10.2.1��������� + ��������������������������������GrabPass����

������������Shader���������������������������������������������������������

����Render Target���������������������������Shader�

����������������������GrabPass������������������������������������������

��������������������������������������������������������������GrabPass�����

���������������������������������������������������GrabPass����������������

�CPU���������back buffer���������CPU�GPU��������������������������������



�Unity 5��Unity������� �Command Buffers� �������Unity��������������������

���������������������������������������������������������������������������

�����������������������������������������Unity����������� ��

�http://docs.unity3d.com/Manual/Graphics CommandBuffers.html ���������Unity������

����������

http://docs.unity3d.com/Manual/GraphicsCommandBuffers.html


10.3 ����

���� �Procedural Texture� ���������������������������������������������

������������������������������������������������������������������������

��������������������������������������������������������������Unity�������

�������——�����

10.3.1 �Unity����������

���������������������������10.15��������������������������������������

�����

▲�10.15 ���������

����������������

�1��������������������Scene_10_3_1��Unity 5.2��������������������������

������������Window → Lighting → Skybox������������

�2��������������������ProceduralTextureMat�

�3������7����Unity Shader——Chapter7-SingleTexture������2��������

�4������������2���������

�5�������ProceduralTextureMat�����������������������������������������

ProceduralTextureGeneration.cs��������4��������

������������������������������ProceduralTextureGeneration.cs��������

�1�����������������������������������

[ExecuteInEditMode] 

public class ProceduralTextureGeneration : MonoBehaviour { 

 



�2���������������������������

public Material material = null; 

 

�3�������������������

#region Material properties 

[SerializeField, SetProperty("textureWidth")] 

private int m_textureWidth = 512; 

public int textureWidth { 

    get { 

        return m_textureWidth; 

    } 

    set { 

        m_textureWidth = value; 

        _UpdateMaterial(); 

    } 

} 

 

[SerializeField, SetProperty("backgroundColor")] 

private Color m_backgroundColor = Color.white; 

public Color backgroundColor { 

    get { 

        return m_backgroundColor; 

    } 

    set { 

        m_backgroundColor = value; 

        _UpdateMaterial(); 

    } 

} 

 

[SerializeField, SetProperty("circleColor")] 

private Color m_circleColor = Color.yellow; 

public Color circleColor { 

    get { 

        return m_circleColor; 

    } 

    set { 

        m_circleColor = value; 

        _UpdateMaterial(); 

    } 

} 

 

[SerializeField, SetProperty("blurFactor")] 

private float m_blurFactor = 2.0f; 

public float blurFactor { 

    get { 

        return m_blurFactor; 

    } 

    set { 

        m_blurFactor = value; 

        _UpdateMaterial(); 

    } 

} 

#endregion 

 

#region �#endregion �������������������������������������������������

���4�����������������2���������������������������������������������������

���get/set��������������������set��������������SetProperty

�https://github.com/LMNRY/SetProperty/blob/master/Scripts/SetPropertyExample.cs ���

������������������_UpdateMaterial������������������

https://github.com/LMNRY/SetProperty/blob/master/Scripts/SetPropertyExample.cs


�4�������������������Texture2D��������

private Texture2D m_generatedTexture = null; 

 

�5��������������������Start���������������������������

void Start () { 

    if (material == null) { 

        Renderer renderer = gameObject.GetComponent<Renderer>(); 

        if (renderer == null) { 

            Debug.LogWarning("Cannot find a renderer."); 

            return; 

        } 

 

        material = renderer.sharedMaterial; 

    } 

 

    _UpdateMaterial(); 

} 

 

���������������material�����������������������������������������

_UpdateMaterial������������

�6�_UpdateMaterial��������

private void _UpdateMaterial() { 

    if (material != null) { 

        m_generatedTexture = _GenerateProceduralTexture(); 

        material.SetTexture("_MainTex", m_generatedTexture); 

    } 

} 

 

���material��������_GenerateProceduralTexture���������������

m_generatedTexture���������Material.SetTexture���������������material��������

_MainTex������

�7�_GenerateProceduralTexture��������

private Texture2D _GenerateProceduralTexture() { 

    Texture2D proceduralTexture = new Texture2D(textureWidth, textureWidth); 

 

 // ���������� 

    float circleInterval = textureWidth / 4.0f; 

    // ������ 

    float radius = textureWidth / 10.0f; 

    // ������ 

    float edgeBlur = 1.0f / blurFactor; 

 

    for (int w = 0; w <textureWidth; w++) { 

        for (int h = 0; h <textureWidth; h++) { 

            // ����������� 

            Color pixel = backgroundColor; 

 

            // ���9�� 

            for (inti = 0; i< 3; i++) { 

                for (int j = 0; j < 3; j++) { 

                    // �������������� 

                    Vector2 circleCenter = new Vector2(circleInterval * (i + 1), circleInterval   

                       * (j + 1)); 



 

                    // ������������ 

                    float dist = Vector2.Distance(new Vector2(w, h), circleCenter) - radius; 

 

                    // ������ 

                    Color color = _MixColor(circleColor, new Color(pixel.r, pixel.g,    

                    pixel.b, 0.0f), Mathf.SmoothStep(0f, 1.0f, dist * edgeBlur)); 

 

                    // ������������ 

                    pixel = _MixColor(pixel, color, color.a); 

                } 

            } 

 

             proceduralTexture.SetPixel(w, h, pixel); 

        } 

    } 

 

       proceduralTexture.Apply(); 

 

    return proceduralTexture; 

} 

 

���������������������������������������������������������������������9

���������Texture2D.Apply������������������������

�������������������������10.15����������������������������������10.16�

��

▲�10.16 �������������������

�����������������������������������

10.3.2 Unity�����

�Unity����������������������� �Procedural Materials� �������������������

����������������������������������������������������������Unity�����������

���Substance Designer ����Unity������

Substance Designer �����������������3A����������������������Unity�����

���������������Substance����������.sbsar�������10.17��������

https://www.assetstore.unity3d.com/en/#!/ content/1352 ����������������������

Unity����

https://www.assetstore.unity3d.com/en/#!/content/1352


▲�10.17 ���.sbsar�Substance��

��������Unity��Unity������������ �Procedural Material Asset� ������������

������������10.18�����������——Cereals�Cereals_1��������������������Unity��

��������������Cereals_Diffuse�Cereals_1_Diffuse��

▲�10.18 ������

������������������������������Unity Shader���������������������������

��������������������������������������������Scene_10_3_2��������������

�����������������������������������������������������������10.19�����

Cereals���������������������



▲�10.19 �������������������������

���������������������Shader����������������������������



�11� ������

�������������������������������Unity Shader�����

��������������11.1����������Unity Shader������������

��������������������11.2���������������������������

����11.3�������������������������������������������

����������



11.1 Unity Shader�����������

�����������������������������������������Unity

Shader������������������������Shader���������������

���11.1�������������

�11.1 Unity�������

� � � � � �

_Time float4 t����������������4��������(t/20, t, 2t, 3t)�

_SinTime float4 t��������4��������(t/8, t/4, t/2, t)

_CosTime float4 t��������4��������(t/8, t/4, t/2, t)

unity_DeltaTime float4
dt������4��������(dt, 1/dt, smoothDt,

1/smoothDt)

��������������������������������



11.2 ����

������������������������������������������������������������������

11.2.1 �����

������������������������������������������������������������������

���������������������������������������������������������������������

�����������������������������������������

������������������������������������������������

�Assets/Textures/Chapter11/Boom.png����11.1���
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�1��������������������Scene_11_2_1��Unity 5.2����������������������

����������������Window → Lighting → Skybox������������

�2��������������������ImageSequenceAnimationMat�

�3�����Unity Shader���������Shader��Chapter11-

ImageSequenceAnimation����Shader���2��������

�4�������������Quad���������������������2����������

����������������������������������������������������������

Chapter11-ImageSequenceAnimation�������������������

�1����������������������������

Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _MainTex ("Image Sequence", 2D) = "white" {} 

    _HorizontalAmount ("Horizontal Amount", Float) = 4 

    _VerticalAmount ("Vertical Amount", Float) = 4 

    _Speed ("Speed", Range(1, 100)) = 30 

} 

 

_MainTex����������������_HorizontalAmount�_VerticalAmount������������

�������������������_Speed�����������������

�2����������������������Pass��������������

SubShader { 

    Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent"} 

 

    Pass { 

        Tags { "LightMode"="ForwardBase" } 

 

        ZWrite Off 

        Blend SrcAlpha OneMinusSrcAlpha 

 

��������������������������������������������“��”�����SubShader����

�Queue�RenderType���Transparent��IgnoreProjector���True��Pass������ Blend�

����������������������

�3���������������������������������������v2f�����

v2f vert (a2v v) {   

    v2f o;   

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex);   

    o.uv = TRANSFORM_TEX(v.texcoord, _MainTex);   

    return o; 

} 

 

�4��������������



fixed4 frag (v2f i) : SV_Target { 

    float time = floor(_Time.y * _Speed);   

    float row = floor(time / _HorizontalAmount); 

    float column = time - row * _HorizontalAmount; 

 

//  half2 uv = float2(i.uv.x /_HorizontalAmount, i.uv.y / _VerticalAmount); 

//  uv.x += column / _HorizontalAmount; 

//  uv.y -= row / _VerticalAmount; 

    half2 uv = i.uv + half2(column, -row); 

    uv.x /=  _HorizontalAmount; 

    uv.y /= _VerticalAmount; 

 

    fixed4 c = tex2D(_MainTex, uv); 

    c.rgb *= _Color; 

 

    return c; 

} 

 

������������������������������������������������������������������

���������������������������3����������������Unity�������_Time��11.1���

���_Time.y���������������������_Time.y�����_Speed��������������CG�floor

���������������time��������time��_HorizontalAmount���������������������

���������������������������������������������������������������������

������������������������i.uv������������������������������������������

����������������������������������������������������Unity������������

���������������������������������������������������������������������

�����������������������������������

�5�������Fallback������Transparent/VertexLit��������Fallback��

Fallback "Transparent/VertexLit" 
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11.2.2 �����

��2D�����������������������������������������layers����������������

��������������������������������������2D�����������������OpenGameArt
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����

http://opengameart.org/


▲�11.3 �������������forest-background © 2012-2013 Julien Jorge julien.jorge@stuff-o-matic.com�

����������������

�1��������������������Scene_11_2_2��Unity 5.2����������������������

����������������Window → Lighting → Skybox��������������������2D�������

�������������������������

�2��������������������ScrollingBackgroundMat�

�3�����Unity Shader���������Shader��Chapter11-ScrollingBackground����

Shader���2��������

�4�������������Quad�����������������������������2����������������

��������

�����Chapter11-ScrollingBackground�������������������

�1�������������

Properties { 

    _MainTex ("Base Layer (RGB)", 2D) = "white" {} 

    _DetailTex ("2nd Layer (RGB)", 2D) = "white" {} 

    _ScrollX ("Base layer Scroll Speed", Float) = 1.0 

    _Scroll2X ("2nd layer Scroll Speed", Float) = 1.0 

    _Multiplier ("Layer Multiplier", Float) = 1 

} 

 

���_MainTex�_DetailTex�������������������������_ScrollX�_Scroll2X������

�������_Multiplier���������������

�2����������������



v2f vert (a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv.xy = TRANSFORM_TEX(v.texcoord, _MainTex) + frac(float2(_ScrollX, 0.0) * _Time.y); 

    o.uv.zw = TRANSFORM_TEX(v.texcoord, _DetailTex) + frac(float2(_Scroll2X, 0.0) * _Time.y);

 

    return o; 

} 

 

��������������������������������������������������������������

TRANSFORM_TEX���������������������_Time.y��������������������������

����������������������o.uv����������������

�3�����������������

fixed4 frag (v2f i) : SV_Target { 

    fixed4 firstLayer = tex2D(_MainTex, i.uv.xy); 

    fixed4 secondLayer = tex2D(_DetailTex, i.uv.zw); 

 

    fixed4 c = lerp(firstLayer, secondLayer, secondLayer.a); 

    c.rgb *= _Multiplier; 

 

    return c; 

} 

 

��������i.uv.xy�i.uv.zw���������������������������������������CG�lerp

����������_Multiplier��������������������

�4�������Fallback������VertexLit��������Fallback��

Fallback "VertexLit" 
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11.3 ����

�������������������������������������������������������������������������

����������������������������������������——���������������������������������

����������

11.3.1 �����

��������������������������������������������������������������2D���������

��������������11.4���������������������������

▲�11.4 ���������2D���

����������������

�1��������������������Scene_11_3_1��Unity 5.2������������������������������

��������Window → Lighting → Skybox��������������������2D����������������������

����

�2��������������������WaterMat����������������������WaterMat1�WaterMat2�

��

�3�����Unity Shader���������Shader��Chapter11-Water����Shader���2��������

�4���������Water���������������������2�����������

�����Chapter11-Water�������������������

�1����������������

Properties { 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _Magnitude ("Distortion Magnitude", Float) = 1 

    _Frequency ("Distortion Frequency", Float) = 1 

    _InvWaveLength ("Distortion Inverse Wave Length", Float) = 10 

    _Speed ("Speed", Float) = 0.5 

} 

 

���_MainTex������_Color���������_Magnitude������������_Frequency���������

_InvWaveLength����������_InvWaveLength���������_Speed��������������

�2��������������������SubShader���



SubShader { 

    // Need to disable batching because of the vertex animation 

    Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent" "DisableBatching"="

 

�������������������Queue�IgnoreProjector�RenderType������������——

DisableBatching ����3.3.3��������������SubShader���Unity����������������������

���������SubShader����������������Shader������������������Shader������������

������������������������������������������������������������������Shader����

���

�3���������Pass������

Pass {  

    Tags { "LightMode"="ForwardBase" } 

 

    ZWrite Off 

    Blend SrcAlpha OneMinusSrcAlpha 

    Cull Off 

 

����������������������������������������������

�4������������������������

v2f vert(a2v v) { 

    v2f o; 

 

    float4 offset; 

    offset.yzw = float3(0.0, 0.0, 0.0); 

    offset.x = sin(_Frequency * _Time.y + v.vertex.x * _InvWaveLength + v.vertex.y * _InvWaveLength + v

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex + offset); 

 

    o.uv = TRANSFORM_TEX(v.texcoord, _MainTex); 

    o.uv +=  float2(0.0, _Time.y * _Speed); 

 

    return o; 

} 

 

���������������������x���������yzw��������0��������_Frequency������_Time.y

����������������������������������������������������_InvWaveLength�����������

������_Magnitude�������������������������������������������������������

����������������������_Time.y�_Speed���������������

�5����������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed4 c = tex2D(_MainTex, i.uv); 

    c.rgb *= _Color.rgb; 

 

   return c; 

} 

 

�6�������Fallback������Transparent/VertexLit��������Fallback��

Fallback "Transparent/VertexLit" 
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11.3.2 ���

����������������� �Billboarding� ������������������������������������������

���������������������������������������������������������

������������������������������3������������������������ �normal� �������

�up� �������� �right� ����������������� �anchor location� ���������������������

�������������

��������������������3����������������������������������������������������

�������������������������������������������������������(0, 1, 0)���������������

����������������������������������������������������������������������������

��������������������������������

right=up×normal

�����������������������������������

up'=normal×right

���������������3�������11.5������������������������������������

▲�11.5 �������������������������3�������

�������Unity�������������������������������11.6�����

▲�11.6 ���������������5������������������������������������Vertical Restraints ���1�������������������

����������������������������Vertical Restraints ���0�����������(0, 1, 0)����������������������������������

���������

����������������

�1��������������������Scene_11_3_2��Unity 5.2������������������������������

��������Window → Lighting → Skybox������������



�2��������������������BillboardMat�

�3�����Unity Shader���������Shader��Chapter11-Billboard����Shader���2��������

�4�������������Quad�����������������2������������������������������

�����Chapter11-Billboard������������������

�1���������������

Properties { 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _VerticalBillboarding ("Vertical Restraints", Range(0, 1)) = 1  

} 

 

���_MainTex������������_Color�����������_VerticalBillboarding�����������������

���������������

�2��������������������SubShader���

SubShader { 

    // Need to disable batching because of the vertex animation 

    Tags {"Queue"="Transparent" "IgnoreProjector"="True" "RenderType"="Transparent" "DisableBatching"="

 

�������������������Queue�IgnoreProjector�RenderType������������——

DisableBatching ����3.3.3��������������SubShader���Unity����������������������

���������SubShader����������������Shader������������������Shader������������

��������������������������������������������������������������������������

Shader�������

�3���������Pass������

Pass {  

    Tags { "LightMode"="ForwardBase" } 

 

    ZWrite Off 

    Blend SrcAlpha OneMinusSrcAlpha 

    Cull Off 

 

�����������������������������������������������

�4����������������������������������������������������������������������

��

// Suppose the center in object space is fixed 

float3 center = float3(0, 0, 0); 

float3 viewer = mul(_World2Object,float4(_WorldSpaceCameraPos, 1)); 

 

���������3��������������������������������_VerticalBillboarding�������������

��

float3 normalDir = viewer - center; 

// If _VerticalBillboarding equals 1, we use the desired view dir as the normal dir 

// Which means the normal dir is fixed 

// Or if _VerticalBillboarding equals 0, the y of normal is 0 

// Which means the up dir is fixed 



normalDir.y =normalDir.y * _VerticalBillboarding; 

normalDir = normalize(normalDir); 

 

�_VerticalBillboarding�1������������������_VerticalBillboarding�0������������(0, 1,

0)���������������������������������

�������������������������������������������������������������y �����������

����������������������������������������������������������������������������

���������

// Get the approximate up dir 

// If normal dir is already towards up, then the up dir is towards front 

float3 upDir = abs(normalDir.y) > 0.999 ? float3(0, 0, 1) : float3(0, 1, 0); 

float3 rightDir = normalize(cross(upDir, normalDir)); 

upDir = normalize(cross(normalDir, rightDir)); 

 

�����������3���������������������������3�������������������

float3 centerOffs = v.vertex.xyz - center; 

float3 localPos = center + rightDir * centerOffs.x + upDir * centerOffs.y + normalDir * centerOffs.z; 

 

����������������������

    o.pos = mul(UNITY_MATRIX_MVP, float4(localPos, 1)); 

 

�5�������������������������������������

fixed4 frag (v2f i) : SV_Target { 

    fixed4 c = tex2D (_MainTex, i.uv); 

    c.rgb *= _Color.rgb; 

 

    return c; 

} 

 

�6�������Fallback������Transparent/VertexLit��������Fallback��

Fallback "Transparent/VertexLit" 
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��������������������������������������������������������������v.vertex��������

������������

���������������Assets/Textures/Chapter11/star.png������Main Tex���������11.6��

���

11.3.3 ����

������������������������������

����11.3.2������������������������������������������������������SubShader�

DisableBatching���������Unity Shader���������������������������Draw Call��������

����������������������������������������������������������������������������

�������������������



��������������������������������9.4���������Diffuse������Pass��������������

��������������������������������Unity�����������ShadowCaster Pass�������������

ShadowCaster Pass���Pass����������������Unity���������������������������������

�������������ShadowCaster Pass����Pass���������������������������������������

������Fallback����Transparent/VertexLit��Transparent/VertexLit����ShadowCaster Pass��

������������9.4.5���

������Scene_11_3_3������������������������������������11.3.1��������������

��������������������������������������“��”����������Unity Shader�Fallback������

�VertexLit��� Unity ���Fallback����VertexLit��ShadowCaster Pass�������11.7���������

▲�11.7 ������������������ShadowCaster Pass������������������

���������Water���������������������������������������������������

ShadowCaster Pass�����������Chapter11-VertexAnimationWithShadow������Unity

Shader����Shader���������11.8���

▲�11.8 ������ShadowCaster Pass������������

���Shader���������ShadowCaster Pass��������

// Pass to render object as a shadow caster 

Pass { 

    Tags { "LightMode" = "ShadowCaster" } 

 

    CGPROGRAM 

 

    #pragma vertex vert 



    #pragma fragment frag 

 

    #pragma multi_compile_shadowcaster 

 

    #include "UnityCG.cginc" 

 

    float _Magnitude; 

    float _Frequency; 

    float _InvWaveLength; 

    float _Speed; 

 

    struct a2v { 

        float4 vertex : POSITION; 

        float4 texcoord : TEXCOORD0; 

    }; 

 

    struct v2f {  

        V2F_SHADOW_CASTER; 

    }; 

 

    v2f vert(a2v i) { 

        v2f o; 

 

        float4 offset; 

 

        offset.yzw = float3(0.0, 0.0, 0.0); 

 

        offset.x = sin(_Frequency * _Time.y + v.vertex.x * _InvWaveLength + v.vertex.y    

        * _InvWaveLength + v.vertex.z * _InvWaveLength) * _Magnitude; 

 

        v.vertex = v.vertex + offset; 

 

        TRANSFER_SHADOW_CASTER_NORMALOFFSET(o) 

 

        return o; 

    } 

 

    fixed4 frag(v2f i) : SV_Target { 

        SHADOW_CASTER_FRAGMENT(i) 

    } 

    ENDCG 

} 

 

����������������Pass����������������������������������������������Pass����

�����Unity������V2F_SHADOW_CASTER�TRANSFER_SHADOW_CASTER_NORMALOFFSET��

������TRANSFER_SHADOW_CASTER��SHADOW_CASTER_FRAGMENT�������������������

���������������������������v2f������V2F_SHADOW_CASTER����������������������

������������������������������������������������������

TRANSFER_SHADOW_CASTER_NORMALOFFSET��Unity�������������������������

SHADOW_CASTER_FRAGMENT��Unity������������������������������

��Unity����3������UnityCG.cginc��������������������������Pass��������������

������������������������������TRANSFER_SHADOW_CASTER_NORMALOFFSET�����v�

�������v���������v.vertex�����v.normal���������������appdata_base��������������

������������������������������v.vertex�����

TRANSFER_SHADOW_CASTER_NORMALOFFSET����15.1�����������������Pass���������

������������
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�12� �������

���������Unity����������������������������������

��������������

�13� ���������

��������Unity������������������

�14� ������

�����������������������������������

�15� ����

��������������“��”��������������������

�16� Unity��������
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�12� �������

������� �screen post-processing effects� ��������

���������������������Unity������������������������

12.1�����������Unity������������������������������

�����12.2����������������������������������������

12.3�������������������� Sobel����������������������

���������12.4����������������������12.5�12.6�������

�������Bloom��������



12.1 ����������������

���������������������������������������������������������������������

���������������Depth of Field�������Motion Blur���

�����������������������������������Unity���������������——

OnRenderImage �� ����������

MonoBehaviour.OnRenderImage (RenderTexture src, RenderTexture dest) 

 

��������������Unity���������������������������������������������������

���������������������OnRenderImage�����������Graphics.Blit �� ������������

��3������

public static void Blit(Texture src, RenderTexture dest); 

public static void Blit(Texture src, RenderTexture dest, Material mat, int pass = -1); 

public static void Blit(Texture src, Material mat, int pass = -1); 

 

�����src����������������������������������������������������dest������

��������null����������������mat����������������Unity Shader���������������

src��������Shader���_MainTex��������pass�����-1���������Shader����Pass����

���������Pass�

�������OnRenderImage��������������Pass�������������������������������

���������Pass����������2500�Pass����Background�Geometry�AlphaTest��������

������������OnRenderImage��������������������������OnRenderImage�����

ImageEffectOpaque�����������13.4������������13.4�������������������������

���������������������

�����Unity����������������� ��������������������������������������

OnRenderImage���������������������Graphics.Blit�������Unity Shader���������

����������������������������������������Graphics.Blit��������������������

�����������������������������������������������������������Unity

Shader������������������������������������������������������������������

������Assets/Scripts/Chapter12/PostEffectsBase.cs�������

PostEffectsBase.cs��������

�1�����������������������������������������������������

[ExecuteInEditMode] 

[RequireComponent (typeof(Camera))] 

public class PostEffectsBase : MonoBehaviour { 

 

�2����������������������Start�����CheckResources���

// Called when start 

protected void CheckResources() { 

    bool isSupported = CheckSupport(); 



 

    if (isSupported == false) { 

        NotSupported(); 

    } 

} 

 

// Called in CheckResources to check support on this platform 

protected bool CheckSupport() { 

    if (SystemInfo.supportsImageEffects == false || SystemInfo.supportsRenderTextures == false) {

        Debug.LogWarning("This platform does not support image effects or render textures."); 

        return false; 

    } 

 

    return true; 

} 

 

// Called when the platform doesn't support this effect 

protected void NotSupported() { 

    enabled = false; 

} 

 

protected void Start() { 

    CheckResources(); 

} 

 

�������������������������������Start�CheckResources�CheckSupport���

�3���������������������Shader��������������������������������

// Called when need to create the material used by this effect 

protected Material CheckShaderAndCreateMaterial(Shader shader, Material material) { 

    if (shader == null) { 

        return null; 

    } 

 

    if (shader.isSupported && material && material.shader == shader) 

        return material; 

 

    if (!shader.isSupported) { 

        return null; 

    } 

    else { 

        material = new Material(shader); 

        material.hideFlags = HideFlags.DontSave; 

        if (material) 

            return material; 

        else  

            return null; 

    } 

} 

 

CheckShaderAndCreateMaterial�������������������������Shader������������

�������������Shader�������������������Shader��������null�

�12.2�������������PostEffectsBase.cs�������������������������������



12.2 ���������������

�12.1�������������������������������������������������——���������

����������������������12.1�����

▲�12.1 ������������������1.2��������1.6��������1.2�����

����������������

�1��������������������Scene_12_2��Unity 5.2�������������������������

�������������Window → Lighting → Skybox������������

�2��������Assets/Textures/Chapter12/Sakura0.jpg�����������������������

�����Sakura0.jpg����������Sprite��������������

�3��������������������BrightnessSaturationAndContrast.cs�������������

�4� ����Unity Shader���������Shader��Chapter12-

BrightnessSaturationAndContrast�

�������BrightnessSaturationAndContrast.cs�����������������

�1������12.1��������

public class BrightnessSaturationAndContrast : PostEffectsBase { 

 

�2���������Shader������������

public Shader briSatConShader; 

private Material briSatConMaterial; 

public Material material {   

    get { 

        briSatConMaterial = CheckShaderAndCreateMaterial(briSatConShader, briSatConMaterial);

        return briSatConMaterial; 

    }   

} 

 

�������briSatConShader������Shader�����������Chapter12-

BrightnessSaturationAndContrast�briSatConMaterial��������������material�����



���material�get��������CheckShaderAndCreateMaterial�����������

�3���������������������������

[Range(0.0f, 3.0f)] 

public float brightness = 1.0f; 

 

[Range(0.0f, 3.0f)] 

public float saturation = 1.0f; 

 

[Range(0.0f, 3.0f)] 

public float contrast = 1.0f; 

 

����Unity���Range������������������

�4��������OnRenderImage�������������

void OnRenderImage(RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        material.SetFloat("_Brightness", brightness); 

        material.SetFloat("_Saturation", saturation); 

        material.SetFloat("_Contrast", contrast); 

 

        Graphics.Blit(src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

��OnRenderImage������������������������������������Graphics.Blit���

�������������������������

��������Shader������Chapter12-BrightnessSaturationAndContrast��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _Brightness ("Brightness", Float) = 1 

    _Saturation("Saturation", Float) = 1 

    _Contrast("Contrast", Float) = 1 

} 

 

�12.1�������Graphics.Blit(src, dest, material)����������Shader���_MainTex�

����������������_MainTex����������������������������������������������

������������Properties�������Properties����������������������������������

��������������������������������������Unity Shader�

�2�����������Pass�

SubShader { 

    Pass {   

        ZTest Always Cull Off ZWrite Off 

 



������������������������������������������������������������������

���������������“��”�������������������OnRenderImage���������Pass�����

����������������������Pass�����������������������Shader�“��”�

�3�������������������CG������������

sampler2D _MainTex;   

half _Brightness; 

half _Saturation; 

half _Contrast; 

 

�4����������������������������������������������������������������

������������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv: TEXCOORD0; 

}; 

 

v2f vert(appdata_img v) { 

    v2f o; 

 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord;  

 

    return o; 

} 

 

����������������Unity���appdata_img�������������������UnityCG.cginc�

������������������������������������

�5������������������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed4 renderTex = tex2D(_MainTex, i.uv);   

 

    // Apply brightness 

    fixed3 finalColor = renderTex.rgb * _Brightness; 

 

    // Apply saturation 

    fixed luminance = 0.2125 * renderTex.r + 0.7154 * renderTex.g + 0.0721 * renderTex.b; 

    fixed3 luminanceColor = fixed3(luminance, luminance, luminance); 

    finalColor = lerp(luminanceColor, finalColor, _Saturation); 

 

    // Apply contrast 

    fixed3 avgColor = fixed3(0.5, 0.5, 0.5); 

    finalColor = lerp(avgColor, finalColor, _Contrast); 

 

    return fixed4(finalColor, renderTex.a);   

} 

 

�����������������_MainTex�������renderTex������_Brightness�����������

����������������������_Brightness��������������������luminance���������

�������������������������������������0��������_Saturation��������������



����������������������������������������0����������0.5�����_Contrast���

�����������������������������

�6���������Unity Shader�Fallback�

Fallback Off 

 

�����������Chapter12-BrightnessSaturationAndContrast�������Brightness

SaturationAndContrast.cs����briSatConShader����������������������12.1���

��

▲�12.2 �����Shader����

���������������Shader���������������������������������������

Shader��������������Shader���������12.2���



12.3 ����

�12.2�������������������������������������������������——�����������

���������������������������12.3�����

▲�12.3 ���12.2��������������������

������������������������� �convolution� ����������������

12.3.1 �����

���������������������� �kernel� �������������������������������������

2×2�3×3�����������������������������������������������������������12.4�

���������������������������������������������������

▲�12.4 �����������3×3���������5×5�������������������������������������������������������������

��������������������������������

�������������������������������������������������������������������

3×3���������������1/9�

12.3.2 ���������

��������������������������������������������������������������������

������������������������������������������������������������������������

� �gradient� ����������������������������������������������������



�12.5 3����������

3������������12.5����������������������������������������������������

����������������������������Gx �Gy �������������������

��������������������������������������������

�����G ��������������������������������������

12.3.3 ��

������Sobel��������������������������������

�1��������������������Scene_12_3��Unity 5.2���������������������������

�����������Window ->Lighting -> Skybox������������

�2��������Assets/Textures/Chapter12/Sakura0.jpg�������������������������

���Sakura0.jpg����������Sprite��������������

�3��������������������EdgeDetection.cs�������������

�4�����Unity Shader���������Shader��Chapter12-EdgeDetection�

�������EdgeDetection.cs�����������������

�1������12.1��������

public class EdgeDetection : PostEffectsBase { 

 

�2���������Shader������������

public Shader edgeDetectShader; 

private Material edgeDetectMaterial = null; 

public Material material {   

    get { 

        edgeDetectMaterial = CheckShaderAndCreateMaterial(edgeDetectShader, edgeDetectMaterial);

        return edgeDetectMaterial; 

    }   

} 

 



�������edgeDetectShader������Shader�����������Chapter12-EdgeDetection�

�3�������������������������������

[Range(0.0f, 1.0f)] 

public float edgesOnly = 0.0f; 

 

public Color edgeColor = Color.black; 

 

public Color backgroundColor = Color.white; 

 

�edgesOnly��0�����������������edgesOnly��1��������������������������

�backgroundColor��������edgeColor���

�4��������OnRenderImage�������������

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        material.SetFloat("_EdgeOnly", edgesOnly); 

        material.SetColor("_EdgeColor", edgeColor); 

        material.SetColor("_BackgroundColor", backgroundColor); 

 

        Graphics.Blit(src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

��OnRenderImage������������������������������������Graphics.Blit������

����������������������

��������Shader������Chapter12-EdgeDetection��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _EdgeOnly ("Edge Only", Float) = 1.0 

    _EdgeColor ("Edge Color", Color) = (0, 0, 0, 1) 

    _BackgroundColor ("Background Color", Color) = (1, 1, 1, 1) 

} 

 

_MainTex�����������

�2�����������Pass�����������

SubShader { 

    Pass {   

        ZTest Always Cull Off ZWrite Off 

 

�3�������������������CG������������

sampler2D _MainTex;   

half4 _MainTex_TexelSize; 

fixed _EdgeOnly; 



fixed4 _EdgeColor; 

fixed4 _BackgroundColor; 

 

��������������������_MainTex_TexelSize�xxx_TexelSize�Unity��������xxx����

��������������512×512�����������0.001953��1/512������������������������

������_MainTex_TexelSize���������������

�4������������������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv[9] : TEXCOORD0; 

}; 

 

v2f vert(appdata_img v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    half2 uv = v.texcoord;  

 

    o.uv[0] = uv + _MainTex_TexelSize.xy * half2(-1, -1); 

    o.uv[1] = uv + _MainTex_TexelSize.xy * half2(0, -1); 

    o.uv[2] = uv + _MainTex_TexelSize.xy * half2(1, -1); 

    o.uv[3] = uv + _MainTex_TexelSize.xy * half2(-1, 0); 

    o.uv[4] = uv + _MainTex_TexelSize.xy * half2(0, 0); 

    o.uv[5] = uv + _MainTex_TexelSize.xy * half2(1, 0); 

    o.uv[6] = uv + _MainTex_TexelSize.xy * half2(-1, 1); 

    o.uv[7] = uv + _MainTex_TexelSize.xy * half2(0, 1); 

    o.uv[8] = uv + _MainTex_TexelSize.xy * half2(1, 1); 

 

    return o; 

} 

 

���v2f������������9�����������Sobel��������9�������������������������

����������������������������������������������������������������������

�5��������������������

fixed4 fragSobel(v2f i) : SV_Target { 

    half edge = Sobel(i); 

 

    fixed4 withEdgeColor = lerp(_EdgeColor, tex2D(_MainTex, i.uv[4]), edge); 

    fixed4 onlyEdgeColor = lerp(_EdgeColor, _BackgroundColor, edge); 

    return lerp(withEdgeColor, onlyEdgeColor, _EdgeOnly); 

} 

 

������Sobel������������edge�����������������������������_EdgeOnly����

������������Sobel�����Sobel�������������������

fixed luminance(fixed4 color) { 

    return  0.2125 * color.r + 0.7154 * color.g + 0.0721 * color.b;  

} 

 

half Sobel(v2f i) { 

    const half Gx[9] = {-1, -2, -1, 

                        0,  0,  0, 

                        1,  2,  1}; 

    const half Gy[9] = {-1,  0,  1, 



                        -2,  0,  2, 

                        -1,  0,  1};         

 

    half texColor; 

    half edgeX = 0; 

    half edgeY = 0; 

    for (int it = 0; it < 9; it++) { 

        texColor = luminance(tex2D(_MainTex, i.uv[it])); 

        edgeX += texColor * Gx[it]; 

        edgeY += texColor * Gy[it]; 

    } 

 

    half edge = 1 - abs(edgeX) - abs(edgeY); 

 

    return edge; 

} 

 

����������������������Gx �Gy ���������9����������������������Gx �Gy ��

�������������������������1�����������������������edge�edge�������������

������������������

�6�����������Shader�Fallback�

Fallback Off 

 

�����������Chapter12-EdgeDetection�������EdgeDetection.cs����

edgeDetectShader������������EdgeDetection.cs�������edgeDetectShader�������

��Chapter12-EdgeDetection����������������������12.6���edgeOnly���1�������

��

▲�12.6 ����������

��������������������������������������������������������������������

���������������������������������������������������13.4���������



12.4 ����

�12.3������������������������������������������������������——�����������

������������������������������������������������������1���������������������

������������������������������������������������������������������������12.7

�����

▲�12.7 ������������������

12.4.1 ����

����������������������������������������������������������������

G (x,y)=

���σ �����������1��x �y ��������������������������������������������������

���������������������������������������������������������������1���������e ��

�����������������12.8����������1�5×5�������

����������������������������——������������������������������NxN��������

���������N×N×W×H�W�H�����������������N����������������������������������

������������������������������������12.8�����������������������������������

����������2×N×W×H��������������������������������������5����������������3�

������

▲�12.8 ��5×5�����������������1�������������������������������������

������������5×5������������������������Pass����Pass����������������������

���Pass���������������������������������������������������������������������

��������������������



12.4.2 ��

����������������

�1��������������������Scene_12_4��Unity 5.2�������������������������������

�������Window → Lighting →Skybox������������

�2��������Assets/Textures/Chapter12/Sakura1.jpg���������������������������

Sakura1.jpg����������Sprite��������������

�3��������������������GaussianBlur.cs�������������

�4�����Unity Shader���������Shader��Chapter12-GaussianBlur�

�������GaussianBlur.cs�����������������

�1������12.1��������

public class GaussianBlur : PostEffectsBase { 

 

�2���������Shader������������

public Shader gaussianBlurShader; 

private Material gaussianBlurMaterial = null; 

 

public Material material {   

    get { 

        gaussianBlurMaterial = CheckShaderAndCreateMaterial(gaussianBlurShader, gaussianBlurMaterial);

        return gaussianBlurMaterial; 

    }   

} 

 

�������gaussianBlurShader������shader�����������Chapter12-GaussianBlur�

�3������������������������������������

// Blur iterations - larger number means more blur. 

[Range(0, 4)] 

public int iterations = 3; 

 

// Blur spread for each iteration - larger value means more blur 

[Range(0.2f, 3.0f)] 

public float blurSpread = 0.6f; 

 

[Range(1, 8)] 

public int downSample = 2; 

 

blurSpread�downSample�����������������������_BlurSize��������������������

������_BlurSize��������������������downSample��������������������������������

downSample����������

�4�������������OnRenderImage����������������������OnRenderImage����

/// 1st edition: just apply blur 

void OnRenderImage(RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        int rtW = src.width; 

        int rtH = src.height; 



        RenderTexture buffer = RenderTexture.GetTemporary(rtW, rtH, 0); 

 

        // Render the vertical pass 

        Graphics.Blit(src, buffer, material, 0); 

        // Render the horizontal pass 

        Graphics.Blit(buffer, dest, material, 1); 

 

        RenderTexture.ReleaseTemporary(buffer); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

����������������RenderTexture.GetTemporary��������������������������������

����Pass�������������������Pass�������������������������Graphics.Blit(src, buffer,

material, 0)���Shader�����Pass��������������������src�������������buffer��������

Graphics.Blit(buffer, dest, material, 1)���Shader�����Pass��������������������buffer��

�����������������������RenderTexture.ReleaseTemporary�����������

�5�����������������������OnRenderImage����������������������������������

�����������

/// 2nd edition: scale the render texture 

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        int rtW = src.width/downSample; 

        int rtH = src.height/downSample; 

        RenderTexture buffer = RenderTexture.GetTemporary(rtW, rtH, 0); 

        buffer.filterMode = FilterMode.Bilinear; 

 

        // Render the vertical pass 

        Graphics.Blit(src, buffer, material, 0); 

        // Render the horizontal pass 

        Graphics.Blit(buffer, dest, material, 1); 

 

        RenderTexture.ReleaseTemporary(buffer); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

�����������������������������������������������������������������������

Pass������������������������������������������������������������������������

�����downSample�������������downSample�����������

�6������������������������

/// 3rd edition: use iterations for larger blur 

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        int rtW = src.width/downSample; 

        int rtH = src.height/downSample; 

 

        RenderTexture buffer0 = RenderTexture.GetTemporary(rtW, rtH, 0); 

        buffer0.filterMode = FilterMode.Bilinear; 

 

        Graphics.Blit(src, buffer0); 

 

        for (int i = 0; i < iterations; i++) { 

            material.SetFloat("_BlurSize", 1.0f + i * blurSpread); 

 

            RenderTexture buffer1 = RenderTexture.GetTemporary(rtW, rtH, 0); 

 

            // Render the vertical pass 



            Graphics.Blit(buffer0, buffer1, material, 0); 

 

            RenderTexture.ReleaseTemporary(buffer0); 

            buffer0 = buffer1; 

            buffer1 = RenderTexture.GetTemporary(rtW, rtH, 0); 

 

            // Render the horizontal pass 

            Graphics.Blit(buffer0, buffer1, material, 1); 

 

            RenderTexture.ReleaseTemporary(buffer0); 

            buffer0 = buffer1; 

        } 

 

        Graphics.Blit(buffer0, dest); 

        RenderTexture.ReleaseTemporary(buffer0); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

��������������������������������������������������buffer0���src����������

buffer0��������������������buffer1�������Pass�����buffer0����buffer1�������

buffer0��������buffer1���buffer0������buffer1���������Pass��������������buffer0��

������������Graphics.Blit(buffer0, dest)����������������

��������Shader������Chapter12-GaussianBlur��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _BlurSize ("Blur Size", Float) = 1.0 

} 

 

_MainTex�����������

�2��������������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG��������

���

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 

������������Pass����������������Pass���������������������������CGINCLUDE�

��C++��������������������Pass�����������������������CGINCLUDE��������������

�frag���

�3��CG����������������

sampler2D _MainTex;   

half4 _MainTex_TexelSize; 

float _BlurSize; 

 

�������������������������Unity���_MainTex_TexelSize�������������������

�4�������Pass�������������������������



struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv[5]: TEXCOORD0; 

}; 

 

v2f vertBlurVertical(appdata_img v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    half2 uv = v.texcoord;  

 

    o.uv[0] = uv; 

    o.uv[1] = uv + float2(0.0, _MainTex_TexelSize.y * 1.0) * _BlurSize; 

    o.uv[2] = uv - float2(0.0, _MainTex_TexelSize.y * 1.0) * _BlurSize; 

    o.uv[3] = uv + float2(0.0, _MainTex_TexelSize.y * 2.0) * _BlurSize; 

    o.uv[4] = uv - float2(0.0, _MainTex_TexelSize.y * 2.0) * _BlurSize; 

 

    return o; 

} 

 

���������5×5�������������������12.4.1������5×5����������������5���������

�������5��������������v2f���������5�����������������������������������������

����������������������_BlurSize�����������������������_BlurSize����������������

����������_BlurSize�����������������������������������������������������������

�����������������������������������������������

������������������������4�������������������������

�5�����Pass���������

fixed4 fragBlur(v2f i) : SV_Target { 

    float weight[3] = {0.4026, 0.2442, 0.0545}; 

 

    fixed3 sum = tex2D(_MainTex, i.uv[0]).rgb * weight[0]; 

 

    for (int it = 1; it < 3; it++) { 

        sum += tex2D(_MainTex, i.uv[it]).rgb * weight[it]; 

        sum += tex2D(_MainTex, i.uv[2*it]).rgb * weight[it]; 

    } 

 

    return fixed4(sum, 1.0); 

} 

 

�12.4.1������5×5����������������5������������������������3�������������

weight���������������������weight�������sum��������������������������������

���������������������������������sum�������������sum�

�6������������������Pass�

ZTest Always Cull Off ZWrite Off 

 

Pass { 

    NAME "GAUSSIAN_BLUR_VERTICAL" 

 

    CGPROGRAM 

 

    #pragma vertex vertBlurVertical   

    #pragma fragment fragBlur 

 

    ENDCG   

} 

 

Pass {   



    NAME "GAUSSIAN_BLUR_HORIZONTAL" 

 

    CGPROGRAM   

 

    #pragma vertex vertBlurHorizontal   

    #pragma fragment fragBlur 

 

    ENDCG 

} 

 

��������������������������������Pass��NAME����3.3.3����������������������

�������������������������������Bloom����12.5����Pass����������Shader���������

�����Pass�������������

�7�������Shader�Fallback�

Fallback Off 

 

�����������Chapter12-GaussianBlur�������GaussianBlur.cs����gaussianBlurShader�

�����������GaussianBlur.cs�������gaussianBlurShader���������Chapter12-

GaussianBlur���������������������



12.5 Bloom��

Bloom�����������������������������������������������“��”�

������������������12.9������������������Elephants Dream�����

Bloom���

�����������Bloom��������������������12.10�����

▲�12.9 ������������Bloom��������������������

▲�12.10 ����������Bloom������

Bloom����������������������������������������������������

�����������������������������������������������

����������������



�1��������������������Scene_12_5��Unity 5.2����������������

����������������������Window → Lighting → Skybox������������

�2��������Textures/Chapter12/Sakura1.jpg��������������������

��������Sakura1.jpg����������Sprite��������������

�3��������������������Bloom.cs�������������

�4�����Unity Shader���������Shader��Chapter12-Bloom�

�������Bloom.cs�����������������

�1������12.1��������

public class Bloom : PostEffectsBase { 

 

�2���������Shader������������

public Shader bloomShader; 

private Material bloomMaterial = null; 

public Material material {   

    get { 

        bloomMaterial = CheckShaderAndCreateMaterial(bloomShader, bloomMaterial); 

        return bloomMaterial; 

    }   

} 

 

�������bloomShader������Shader�����������Chapter12-Bloom�

�3���Bloom���������������������������12.4����������������

������luminanceThreshold������������������

// Blur iterations - larger number means more blur. 

[Range(0, 4)] 

public int iterations = 3; 

 

// Blur spread for each iteration - larger value means more blur 

[Range(0.2f, 3.0f)] 

public float blurSpread = 0.6f; 

 

[Range(1, 8)] 

public int downSample = 2; 

 

[Range(0.0f, 4.0f)] 

public float luminanceThreshold = 0.6f; 

 



���������������������1���������HDR����������������������

�������������������1����������luminanceThreshold�����[0, 4]����

����HDR��������18.4.3��

�4�������������OnRenderImage���

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        material.SetFloat("_LuminanceThreshold", luminanceThreshold); 

 

        int rtW = src.width/downSample; 

        int rtH = src.height/downSample; 

 

        RenderTexture buffer0 = RenderTexture.GetTemporary(rtW, rtH, 0); 

        buffer0.filterMode = FilterMode.Bilinear; 

 

        Graphics.Blit(src, buffer0, material, 0); 

 

        for (int i = 0; i < iterations; i++) { 

            material.SetFloat("_BlurSize", 1.0f + i * blurSpread); 

 

            RenderTexture buffer1 = RenderTexture.GetTemporary(rtW, rtH, 0); 

 

            // Render the vertical pass 

            Graphics.Blit(buffer0, buffer1, material, 1); 

 

            RenderTexture.ReleaseTemporary(buffer0); 

            buffer0 = buffer1; 

            buffer1 = RenderTexture.GetTemporary(rtW, rtH, 0); 

 

            // Render the horizontal pass 

            Graphics.Blit(buffer0, buffer1, material, 2); 

 

            RenderTexture.ReleaseTemporary(buffer0); 

            buffer0 = buffer1; 

        } 

 

        material.SetTexture ("_Bloom", buffer0);   

        Graphics.Blit (src, dest, material, 3);   

 

        RenderTexture.ReleaseTemporary(buffer0); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

������12.4�����������������������������������Bloom����3��

�����������������������12.4������src������������

Graphics.Blit(src, buffer0, material, 0)���Shader�����Pass�����������

�������������buffer0����������12.4������������������Pass���

Shader��������Pass��������������buffer0���������buffer0�������



_Bloom��������Graphics.Blit (src, dest, material, 3)��Shader�����Pass

���������������������dest������������

��������Shader������Chapter12-Bloom��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _Bloom ("Bloom (RGB)", 2D) = "black" {} 

    _LuminanceThreshold ("Luminance Threshold", Float) = 0.5 

    _BlurSize ("Blur Size", Float) = 1.0 

} 

 

_MainTex�����������_Bloom������������_LuminanceThreshold��

��������������_BlurSize�12.4������������������������������

�2������������CGINCLUDE���������SubShader����CGINCLUDE�

ENDCG�����������

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 

�3����������������

sampler2D _MainTex;  

half4 _MainTex_TexelSize; 

sampler2D _Bloom; 

float _LuminanceThreshold; 

float _BlurSize; 

 

�4������������������������������

struct v2f { 

    float4 pos : SV_POSITION;  

    half2 uv : TEXCOORD0; 

};   

 

v2f vertExtractBright(appdata_img v) { 

    v2f o; 

 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord;  



 

    return o; 

} 

 

fixed luminance(fixed4 color) { 

    return  0.2125 * color.r + 0.7154 * color.g + 0.0721 * color.b;  

} 

 

fixed4 fragExtractBright(v2f i) : SV_Target { 

    fixed4 c = tex2D(_MainTex, i.uv); 

    fixed val = clamp(luminance(c) - _LuminanceThreshold, 0.0, 1.0); 

 

    return c * val; 

} 

 

���������������������������������������

_LuminanceThreshold��������0�1�������������������������������

�5�����������������������������������

struct v2fBloom { 

    float4 pos : SV_POSITION;  

    half4 uv : TEXCOORD0; 

}; 

 

v2fBloom vertBloom(appdata_img v) { 

    v2fBloom o; 

 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    o.uv.xy = v.texcoord;        

    o.uv.zw = v.texcoord; 

 

    #if UNITY_UV_STARTS_AT_TOP           

    if (_MainTex_TexelSize.y < 0.0) 

        o.uv.w = 1.0 - o.uv.w; 

    #endif 

 

    return o;  

} 

 

fixed4 fragBloom(v2fBloom i) : SV_Target { 

    return tex2D(_MainTex, i.uv.xy) + tex2D(_Bloom, i.uv.zw); 

} 

 

�����������������������������������������half4���uv����xy�

����_MainTex��������������zw���_Bloom������������������������

���������������5.6.1���

������������������������������������



�6���������Bloom�����4�Pass�

ZTest Always Cull Off ZWrite Off 

 

Pass {   

    CGPROGRAM   

    #pragma vertex vertExtractBright   

    #pragma fragment fragExtractBright   

 

    ENDCG   

} 

 

UsePass "Unity Shaders Book/Chapter 12/Gaussian Blur/GAUSSIAN_BLUR_VERTICAL" 

 

UsePass "Unity Shaders Book/Chapter 12/Gaussian Blur/GAUSSIAN_BLUR_HORIZONTAL" 

 

Pass {   

    CGPROGRAM   

    #pragma vertex vertBloom   

    #pragma fragment fragBloom   

 

    ENDCG   

} 

 

����������Pass�������12.4�����������Pass�����UsePass������

�Pass���������������Unity������Pass�Name���������������

UsePass�����������������

�7����������Shader�Fallback�

Fallback Off 

 

�����������Chapter12-Bloom�������Bloom.cs����bloomShader��

����������Bloom.cs�������bloomShader���������Chapter12-Bloom�

��������������������



12.6 ����

��������������������������������������������������������������������

������������������������������������������������������������������������

������������������������������������������������������������������������

���������������������������������������������12.11�����

▲�12.11 ��������������������

���������������������������� �accumulation buffer � ������������������

������������������������������������������������������������������������

������������������������������ �velocity buffer ��������������������������

��������������

��������������������������������������������������������������������

����������������������������������������������������������������������

����������������

�1��������������������Scene_12_6��Unity 5.2���������������������������

�����������Window→Lighting→Skybox������������

�2��������������������������������������3����������4��������������

9.5����������������������Translating.cs��������������������

�3��������������������MotionBlur.cs�������������

�4�����Unity Shader���������Shader��Chapter12-MotionBlur�

�������MotionBlur.cs�����������������

�1������12.1��������

public class MotionBlur : PostEffectsBase { 

 

�2���������Shader������������

public Shader motionBlurShader; 

private Material motionBlurMaterial = null; 



 

public Material material {   

    get { 

        motionBlurMaterial = CheckShaderAndCreateMaterial(motionBlurShader, motionBlurMaterial);

        return motionBlurMaterial; 

    }   

} 

 

�3���������������������

[Range(0.0f, 0.9f)] 

public float blurAmount = 0.5f; 

 

blurAmount�����������������������������������������������0.0�0.9����

�4�����RenderTexture������������������

private RenderTexture accumulationTexture; 

 

void OnDisable() { 

    DestroyImmediate(accumulationTexture); 

} 

 

����������������������OnDisable��������accumulation Texture������������

������������������

�5�����������������OnRenderImage���

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        // Create the accumulation texture 

        if (accumulationTexture == null || accumulationTexture.width != src.width ||    

        accumulationTexture.height != src.height) { 

            DestroyImmediate(accumulationTexture); 

            accumulationTexture = new RenderTexture(src.width, src.height, 0); 

            accumulationTexture.hideFlags = HideFlags.HideAndDontSave; 

            Graphics.Blit(src, accumulationTexture); 

        } 

 

        // We are accumulating motion over frames without clear/discard 

        // by design, so silence any performance warnings from Unity 

        accumulationTexture.MarkRestoreExpected(); 

 

        material.SetFloat("_BlurAmount", 1.0f - blurAmount); 

 

        Graphics.Blit (src, accumulationTexture, material); 

        Graphics.Blit (accumulationTexture, dest); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

����������������������accumulationTexture�����������������������������

������������������������������������accumulationTexture������������������

��������������hideFlags���HideFlags.HideAndDontSave��������������Hierarchy



����������������������������accumulation Texture���Graphics.Blit(src,

accumulationTexture)����

�������accumulationTexture���������accumulationTexture.Mark

RestoreExpected��������������������������� �restore operation� �����������

����������������������������OnRenderImage������������accumulationTexture�

������accumulationTexture�������������������������������������������

Graphics.Blit (src, accumulationTexture, material)��������src���accumulationTexture

������Graphics.Blit (accumulationTexture, dest)����������

��������Shader����������������������Chapter12-MotionBlur��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _BlurAmount ("Blur Amount", Float) = 1.0 

} 

 

_MainTex�����������_BlurAmount��������������

�2����������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG��������

���

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 

�3����������������

sampler2D _MainTex; 

fixed _BlurAmount; 

 

�4������������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv : TEXCOORD0; 

}; 

 

v2f vert(appdata_img v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord;  

 

    return o; 

} 

 

�5����������������������������RGB�����������������A�����



fixed4 fragRGB (v2f i) : SV_Target { 

    return fixed4(tex2D(_MainTex, i.uv).rgb, _BlurAmount); 

} 

 

half4 fragA (v2f i) : SV_Target { 

    return tex2D(_MainTex, i.uv); 

} 

 

RGB�����Shader�������������A������_BlurAmount����������������������

��A������������������������������������������������������������������

�6����������������Pass�����������Pass������������RGB����������A�����

���A���RGB�����������RGB���������A�������������A������������

    ZTest Always Cull Off ZWrite Off 

 

    Pass { 

        Blend SrcAlpha OneMinusSrcAlpha 

        ColorMask RGB 

 

        CGPROGRAM 

 

        #pragma vertex vert   

        #pragma fragment fragRGB   

 

        ENDCG 

    } 

 

    Pass {    

        Blend One Zero 

        ColorMask A 

 

        CGPROGRAM   

 

        #pragma vertex vert   

        #pragma fragment fragA 

 

        ENDCG   

    } 

 

�7���������Shader�Fallback�

Fallback Off 

 

�����������Chapter12-MotionBlur�������MotionBlur.cs����motionBlurShader��

����������MotionBlur.cs�������motionBlurShader���������Chapter12-MotionBlur�

��������������������

��������������������������������������������������������������������

��������������13������������������������������



12.7 ����

��������Unity�����������������������������������

��������������������������������������������������

Unity�Image Effect�http://docs.unity3d.com/Manual/comp-

ImageEffects.html ��������������GPU Gems��

�https://developer.nvidia.com/ gpugems/GPUGems �������

������������������GPU Gems 3���27�����������������

�����������Unity�������������������������

http://docs.unity3d.com/Manual/comp-ImageEffects.html
https://developer.nvidia.com/gpugems/GPUGems


�13� ���������

��12�������������������������������������������

��������������������������������������������������

��������������������������������������������������

��������������������������������������������������

�������������������������

�������������Unity���������������������������

13.1�������������Unity����������13.2����������������

����������������������13.3�������������������������

�����������������13.4������������������������������

����



13.1 ���������

���Unity�������������������������������������������

13.1.1 �����

������������������������������������������������������������

���������[0, 1]����������������������������������������������4���

���������������������������������������Normalized Device

Coordinates �NDC������������������������������������������������

������������MVP������������������������������������������������

��������������������������4.6.7���

�13.1���4.6.7������Unity���������������13.1�������������������

���������������������������������������������������������������

�������������������������������������������Unity����������������

�����������������������������������NDC�z ������[−1, 1]����������

DirectX������������z ������[0, 1]���������������������������������

���������������������������4.6.7���

▲�13.1 �������������������������������������������������������4����������������

�13.2����������������������������������[−1, 1]���������������

������



▲�13.2 �����������������������������������������������������4����������������

���NDC���������������������������������NDC������z �������

NDC�z ������[−1, 1]������������������������������������

d =0.5·zndc +0.5

���d �������������zndc ���NDC����z �����

��Unity�����������������Unity�������������������������������

Pass������������������������������������������������������������

������������������G-buffer�������������������������������Pass����

��������Unity���������Shader Replacement�������������SubShader�

RenderType����Opaque���������������������2 500����Background�

Geometry�AlphaTest����������������������������������������������

��������������Shader������RenderType�� �

�Unity����������������������������+������������������������

��Unity������������������������������������������������Pass��

LightMode����ShadowCaster�Pass���9.4������������Shader��������

Pass�����������������������������������������������24��16������

���������������������+�����Unity�����������������32�������8����

����������������������R�G�������������B�A����������������������

������Unity�����������������������������������������Unity��������

��Pass�����������������Pass����Unity�����Unity Shader����������

builtin_shaders-xxx/DefaultResources/Camera-DepthNormalTexture.shader�

������������������Pass�

13.1.2 ����

�Unity����������������������Unity�“����������”����Shader������

������������Unity������������������depthTextureMode��������������

������������

camera.depthTextureMode = DepthTextureMode.Depth; 

 

����������������������Shader�����_CameraDepthTexture���������

�����������������������Unity�����������13.1.1���

�����������+�������������������

camera.depthTextureMode = DepthTextureMode.DepthNormals; 

 

���Shader�����_CameraDepthNormalsTexture�������



�����������������������������+�����

camera.depthTextureMode |= DepthTextureMode.Depth; 

camera.depthTextureMode |= DepthTextureMode.DepthNormals; 

 

�Unity 5������������Camera���������������������+�������

Shader��������_CameraDepthTexture�������������������������������

��������tex2D����������������PS3�PSP2��������������Unity��������

����SAMPLE_DEPTH_TEXTURE��������������������������Shader���

SAMPLE_DEPTH_TEXTURE��������������

float d = SAMPLE_DEPTH_TEXTURE(_CameraDepthTexture, i.uv); 

 

���i.uv���float2�������������������������

SAMPLE_DEPTH_TEXTURE_PROJ�SAMPLE_DEPTH_TEXTURE_LOD�

SAMPLE_DEPTH_ TEXTURE_PROJ���������——�������float3�float4������

���������tex2Dproj����������������������������������������������

�����������������������������SAMPLE_DEPTH_TEXTURE_PROJ��������

����������������������

float d = SAMPLE_DEPTH_TEXTURE_PROJ(_CameraDepthTexture, UNITY_PROJ_COORD(i.scrPos)); 

 

���i.scrPos������������ComputeScreenPos(o.pos)�����������������

�����Unity���HLSLSupport.cginc������

������������������������������������������������������������

���������������������������������������������������������������

���������������������������������������������������������������

��

�4.6.7������������������ P clip �������������������������z �w ��

��

���Far �Near �����������������������������NDC��z ���



�13.1.1�������������������������NDC������

�����������������d �����zvisw �����

���Unity�����������������z ����������������������������������

����������

�����������������[Near, Far]�����������[0, 1]�������������������

�Far������0����������������1����������������������

�����Unity����������������������——LinearEyeDepth�

Linear01Depth�LinearEyeDepth�����������������������������������

 ��Linear01Depth���������[0�1]�����������������z 01 ������������

��_ZBufferParams���������������

����������+�����������tex2D���_CameraDepthNormalsTexture���

�����������������Unity�����������������������������������������

DecodeDepthNormal���UnityCG.cginc�����

inline void DecodeDepthNormal( float4 enc, out float depth, out float3 normal ) 

{ 

    depth = DecodeFloatRG (enc.zw); 

    normal = DecodeViewNormalStereo (enc); 



} 

 

DecodeDepthNormal����������+�����������������Unity����������

�������xy ���������������������������zw�������DecodeDepthNormal

��������������������������������������[0, 1]���������������������

�������������������������������������DecodeFloatRG�

DecodeViewNormalStereo�����+��������������

�������������Unity�������������������������������������

13.1.3 ���������

���������������������������Shader�����Unity 5����������������

������������������������Frame Debugger���13.3�������������������

�+�����

▲�13.3 ��Frame Debugger������������+������������������������������������������������

�����������������������

����������������������������+�������Unity�������������������

�����������������������������������������������������13.4�������

���������������������������

float depth = SAMPLE_DEPTH_TEXTURE(_CameraDepthTexture, i.uv); 

float linearDepth = Linear01Depth(depth); 

return fixed4(linearDepth, linearDepth, linearDepth, 1.0); 

 

���������

fixed3 normal = DecodeViewNormalStereo(tex2D(_CameraDepthNormalsTexture, i.uv).xy); 

return fixed4(normal * 0.5 + 0.5, 1.0); 

 

��������������������������������������������������Unity���1

000������������������������������������������������������������



���������������������������������������������������13.4���������

�������������������������������������������������������

▲�13.4 ��������������������������[0, 1]��������������



13.2 ������

�12.6��������������������������������������������������������������������

����������������������������������������������������������������������������

���������Shader��������������������������

�GPU Gems3���27�

�http://http.developer.nvidia.com/GPUGems3/gpugems3_ch27.html �������������������

���������������������������������������������*���������NDC������������������

���������������������*����������������������NDC�����������������������������

������������������������������������������������������������������

����������������������������

�1��������������������Scene_13_2��Unity 5.2�������������������������������

�������Window → Lighting →Skybox������������

�2��������������������������������������3����������4��������������9.5����

������������������Translating.cs��������������������

�3��������������������MotionBlurWithDepthTexture.cs�������������

�4�����Unity Shader���������Shader��Chapter13-MotionBlurWithDepthTexture�

�������MotionBlurWithDepthTexture.cs�����������������

�1������12.1��������

public class MotionBlurWithDepthTexture : PostEffectsBase { 

 

�2���������Shader������������

public Shader motionBlurShader; 

private Material motionBlurMaterial = null; 

 

public Material material {   

    get { 

        motionBlurMaterial = CheckShaderAndCreateMaterial(motionBlurShader, motionBlurMaterial); 

        return motionBlurMaterial; 

    }   

} 

 

�3������������������

[Range(0.0f, 1.0f)] 

public float blurSize = 0.5f; 

 

�4�����������������������������Camera���������������������

private Camera myCamera; 

public Camera camera { 

    get { 

        if (myCamera == null) { 

            myCamera = GetComponent<Camera>(); 

        } 

http://http.developer.nvidia.com/GPUGems3/gpugems3_ch27.html


        return myCamera; 

    } 

} 

 

�5������������������������*�����

private Matrix4x4 previousViewProjectionMatrix; 

 

�6������������������������OnEnable������������

void OnEnable() { 

    camera.depthTextureMode |= DepthTextureMode.Depth; 

} 

 

�7���������OnRenderImage���

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        material.SetFloat("_BlurSize", blurSize); 

 

        material.SetMatrix("_PreviousViewProjectionMatrix", previousViewProjectionMatrix); 

        Matrix4x4 currentViewProjectionMatrix = camera.projectionMatrix * camera.worldToCameraMatrix; 

        Matrix4x4 currentViewProjectionInverseMatrix = currentViewProjectionMatrix.inverse; 

        material.SetMatrix("_CurrentViewProjectionInverseMatrix", currentViewProjectionInverseMatrix);

        previousViewProjectionMatrix = currentViewProjectionMatrix; 

 

        Graphics.Blit (src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

���OnRenderImage�����������������������������������������——������*�����

�������*������������������camera.worldToCameraMatrix�camera.projectionMatrix����

����������������������������������*�������������������������������

previousViewProjectionMatrix�����������������_PreviousViewProjectionMatrix���

��������Shader������Chapter13-MotionBlurWithDepthTexture��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _BlurSize ("Blur Size", Float) = 1.0 

} 

 

_MainTex�����������_BlurSize������������������������������

_PreviousViewProjectionMatrix�_CurrentViewProjectionInverseMatrix��������Properties���

��������Unity��������������������CG���������������������

�2����������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG�����������

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 



    ... 

 

�3����������������

sampler2D _MainTex; 

half4 _MainTex_TexelSize; 

sampler2D _CameraDepthTexture; 

float4x4 _CurrentViewProjectionInverseMatrix; 

float4x4 _PreviousViewProjectionMatrix; 

half _BlurSize; 

 

�������������Properties���_MainTex�_BlurSize����������������

_CameraDepthTexture�Unity������������_CurrentViewProjectionInverseMatrix�

_PreviousViewProjectionMatrix�����������������������_MainTex_TexelSize������������

������������������������������������5.6.1���

�4������������������������������������������������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv : TEXCOORD0; 

    half2 uv_depth : TEXCOORD1; 

}; 

 

v2f vert(appdata_img v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord; 

    o.uv_depth = v.texcoord; 

 

    #if UNITY_UV_STARTS_AT_TOP 

    if (_MainTex_TexelSize.y < 0) 

        o.uv_depth.y = 1 - o.uv_depth.y; 

    #endif 

 

    return o; 

} 

 

�������������������������DirectX������������������������������������������

���������������������DirectX����������������������������

�5���������������

fixed4 frag(v2f i) : SV_Target { 

    // Get the depth buffer value at this pixel. 

    float d = SAMPLE_DEPTH_TEXTURE(_CameraDepthTexture, i.uv_depth); 

    // H is the viewport position at this pixel in the range -1 to 1. 

    float4 H = float4(i.uv.x * 2 - 1, i.uv.y * 2 - 1, d * 2 - 1, 1); 

    // Transform by the view-projection inverse. 

    float4 D = mul(_CurrentViewProjectionInverseMatrix, H); 

    // Divide by w to get the world position.  

    float4 worldPos = D / D.w; 

 

    // Current viewport position  

    float4 currentPos = H; 

    // Use the world position, and transform by the previous view-projection matrix.   

    float4 previousPos = mul(_PreviousViewProjectionMatrix, worldPos); 

    // Convert to nonhomogeneous points [-1,1] by dividing by w. 

    previousPos /= previousPos.w; 

 

    // Use this frame's position and last frame's to compute the pixel velocity. 

    float2 velocity = (currentPos.xy - previousPos.xy)/2.0f; 



 

    float2 uv = i.uv; 

    float4 c = tex2D(_MainTex, uv); 

    uv += velocity * _BlurSize; 

    for (int it = 1; it < 3; it++, uv += velocity * _BlurSize) { 

        float4 currentColor = tex2D(_MainTex, uv); 

        c += currentColor; 

    } 

    c /= 3; 

 

    return fixed4(c.rgb, 1.0); 

} 

 

�������������������*���������������������������������������������

SAMPLE_DEPTH_TEXTURE����������������������d ��13.1.2����d ��NDC������������

�������NDC��H ���������������NDC�������������������������d * 2-1����NDC�xy �

����������������NDC��xyz ������[-1, 1]�����NDC����H ���������������*����������

��������������w ���������������worldPos�

���������������������������*�����������������NDC����previousPos����������

������������������������velocity�

������������������������������������������������������������_BlurSize�����

���

�6����������������Pass�

Pass {       

    ZTest Always Cull Off ZWrite Off 

 

    CGPROGRAM   

 

    #pragma vertex vert   

    #pragma fragment frag   

 

    ENDCG   

} 

 

�7���������shader�Fallback�

Fallback Off 

 

�����������Chapter13-MotionBlurWithDepthTexture�������MotionBlur

WithDepthTexture.cs����motionBlurShader������������MotionBlurWith DepthTexture.cs�

������motionBlurShader���������Chapter13-MotionBlur WithDepthTexture������������

���������

�������������������������������������������������������������������������

������������������������������������������������������������������������Unity

���ImageEffect�����������������

�������������������������������������������������13.3��������������������

���������



13.3 ����

���Fog� ��������������Unity�����������������������������������/������

������������Shader���#pragma multi_compile_fog�������������������

UNITY_FOG_COORDS�UNITY_TRANSFER_FOG�UNITY_APPLY_FOG�����������������

����������������������������������������������������������������������

Unity�������������

�������������������������������������������������������Shader�������

������������������������������������������������������/����������������

���������������13.5�����

▲�13.5 ��������������������

�������������������������������������������13.2���������������������

�����������NDC��������������*�����������������������������������������

�����������������������������������������������������������������������

�����������������������������������������������������������������������

�������������������������������������������������������������������

13.3.1 ������

��������������������������������������������������������������������

�����������������������������������������������������������������������

�����������������������������

float4 worldPos = _WorldSpaceCameraPos + linearDepth * interpolatedRay; 

 

���_WorldSpaceCameraPos������������������Unity�������������

linearDepth * interpolatedRay���������������������linearDepth���������������

interpolatedRay���������������������������������������������linearDepth���

�����13.1.2������������������interpolatedRay����

interpolatedRay����������4��������������4����������������������������

�����������FOV����������13.6����������������������������������——toTop�

toRight��������������������������������������������



halfHeight =Near ×tan 

toTop =camera.up ×halfHeight

toRight =camera.right ×halfHeight ·aspect

���Near����������FOV�����������camera.up�camera.right���������������

��

�������������������4������������������������13.6��TL������������

TL =camera.forward ·Near +toTop-toRight

��������������������������3�����������

TR =camera.forward · Near +toTop+toRight

BL =camera.forward · Near -toTop-toRight

BR =camera.forward · Near -toTop+toRight

��������4��������������������4������������������������������������

�����z ����������������������4��������������������������13.7������������

�����������������TL��������������TL������������������������������������

�TL��������

����������TL����������dist�

��4�����������3������TL����������������������������������



▲�13.6 ��interpolatedRay

▲�13.7 ���������������������

��������������������������������������������4�������������4��������

���������������������������������������������������������������

interpolatedRay������������������������������������

13.3.2 ����

����������������������f��������������������

float3 afterFog = f * fogColor + (1 - f) * origColor; 

 

������f���������Unity�������������������——���Linear�����Exponential��

�������Exponential Squared�������z ��f ����������

Linear�



 �dmin �dmax �������������������

Exponential�

f =  �d �����������

Exponential Squared�

f =  �d �����������

���������������������������������������������������y ��f �������

 �Hstart �Hend �������������������

13.3.3 ��

���Unity���������������������������

�1��������������������Scene_13_3��Unity 5.2��������������������������

������������Window -< Lighting -< Skybox������������

�2������������������������������������3����������������������������

��9.5����������������������Translating.cs��������������������

�3��������������������FogWithDepthTexture.cs�������������

�4�����Unity Shader���������Shader��Chapter13-FogWithDepthTexture�

�������FogWithDepthTexture.cs�����������������

�1������12.1��������

public class FogWithDepthTexture : PostEffectsBase { 

 

�2���������Shader������������

public Shader fogShader; 

private Material fogMaterial = null; 

 

public Material material {   

    get { 

        fogMaterial = CheckShaderAndCreateMaterial(fogShader, fogMaterial); 

        return fogMaterial; 

    }   

} 

 

�3�������������������������������FOV�������������������������������

���������������Camera���Transform���

private Camera myCamera; 

public Camera camera { 



    get { 

        if (myCamera == null) { 

            myCamera = GetComponent<Camera>(); 

        } 

        return myCamera; 

    } 

} 

 

private Transform myCameraTransform; 

public Transform cameraTransform { 

    get { 

        if (myCameraTransform == null) { 

            myCameraTransform = camera.transform; 

        } 

 

        return myCameraTransform; 

    } 

} 

 

�4����������������

[Range(0.0f, 3.0f)] 

public float fogDensity = 1.0f; 

 

public Color fogColor = Color.white; 

 

public float fogStart = 0.0f; 

public float fogEnd = 2.0f; 

 

fogDensity���������fogColor�������������������������������fogStart�����

�������fogEnd������������

�5������������������������OnEnable��������������

void OnEnable() { 

    camera.depthTextureMode |= DepthTextureMode.Depth; 

} 

 

�6���������OnRenderImage���

  void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        Matrix4x4 frustumCorners = Matrix4x4.identity; 

 

        float fov = camera.fieldOfView; 

        float near = camera.nearClipPlane; 

        float far = camera.farClipPlane; 

        float aspect = camera.aspect; 

 

        float halfHeight = near * Mathf.Tan(fov * 0.5f * Mathf.Deg2Rad); 

        Vector3 toRight = cameraTransform.right * halfHeight * aspect; 

        Vector3 toTop = cameraTransform.up * halfHeight; 

 

        Vector3 topLeft = cameraTransform.forward * near + toTop - toRight; 

        float scale = topLeft.magnitude / near; 

 

        topLeft.Normalize(); 

        topLeft *= scale; 

 



        Vector3 topRight = cameraTransform.forward * near + toRight + toTop; 

        topRight.Normalize(); 

        topRight *= scale; 

 

        Vector3 bottomLeft = cameraTransform.forward * near - toTop - toRight; 

        bottomLeft.Normalize(); 

        bottomLeft *= scale; 

 

        Vector3 bottomRight = cameraTransform.forward * near + toRight - toTop; 

        bottomRight.Normalize(); 

        bottomRight *= scale; 

 

        frustumCorners.SetRow(0, bottomLeft); 

        frustumCorners.SetRow(1, bottomRight); 

        frustumCorners.SetRow(2, topRight); 

        frustumCorners.SetRow(3, topLeft); 

 

        material.SetMatrix("_FrustumCornersRay", frustumCorners); 

        material.SetMatrix("_ViewProjectionInverseMatrix", (camera.projectionMatrix *    

       camera.worldToCameraMatrix).inverse); 

 

        material.SetFloat("_FogDensity", fogDensity); 

        material.SetColor("_FogColor", fogColor); 

        material.SetFloat("_FogStart", fogStart); 

        material.SetFloat("_FogEnd", fogEnd); 

 

        Graphics.Blit (src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

OnRenderImage�������������������������������������frustumCorners����

��������13.3.1�������������������������������������������frustumCorners��

��������������������������������������������������������������������

Graphics.Blit (src, dest, material)������������

��������Shader������Chapter13-FogWithDepthTexture��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _FogDensity ("Fog Density", Float) = 1.0 

    _FogColor ("Fog Color", Color) = (1, 1, 1, 1) 

    _FogStart ("Fog Start", Float) = 0.0 

    _FogEnd ("Fog End", Float) = 1.0 

} 

 

�2����������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG�������

����

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 



�3����������������

float4x4 _FrustumCornersRay; 

 

sampler2D _MainTex; 

half4 _MainTex_TexelSize; 

sampler2D _CameraDepthTexture; 

half _FogDensity; 

fixed4 _FogColor; 

float _FogStart; 

float _FogEnd; 

 

_FrustumCornersRay�����Properties�������������Shader���Properties�������

������������_CameraDepthTexture�Unity������������������

�4���������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv : TEXCOORD0; 

    half2 uv_depth : TEXCOORD1; 

    float4 interpolatedRay : TEXCOORD2; 

}; 

 

v2f vert(appdata_img v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord; 

    o.uv_depth = v.texcoord; 

 

    #if UNITY_UV_STARTS_AT_TOP 

    if (_MainTex_TexelSize.y < 0) 

        o.uv_depth.y = 1 - o.uv_depth.y; 

    #endif 

 

    int index = 0; 

    if (v.texcoord.x < 0.5 && v.texcoord.y < 0.5) { 

        index = 0; 

    } else if (v.texcoord.x > 0.5 && v.texcoord.y < 0.5) { 

        index = 1; 

    } else if (v.texcoord.x > 0.5 && v.texcoord.y > 0.5) { 

        index = 2; 

    } else { 

        index = 3; 

    } 

 

    #if UNITY_UV_STARTS_AT_TOP 

      if (_MainTex_TexelSize.y < 0) 

          index = 3 - index; 

      #endif 

 

    o.interpolatedRay = _FrustumCornersRay[index]; 

 

    return o; 

} 

 

�v2f������������������������������������interpolatedRay���������������

���������������������������������������������4�������������������������

������Unity�������(0, 0)���������(1, 1)������������������������������������



��frustumCorners��������������������������������������DirectX�Metal������

������(0, 0)���������Unity��������������������������������������DirectX���

��������Unity���������������������������������������������������5.6.1���

�����������������������������_FrustumCornersRay�����������interpolatedRay

��

�����������������������������������������4����������������������

�5�����������������

fixed4 frag(v2f i) : SV_Target { 

    float linearDepth = LinearEyeDepth(SAMPLE_DEPTH_TEXTURE(_CameraDepthTexture, i. uv_depth));

    float3 worldPos = _WorldSpaceCameraPos + linearDepth * i.interpolatedRay.xyz; 

 

    float fogDensity = (_FogEnd - worldPos.y) / (_FogEnd - _FogStart);  

    fogDensity = saturate(fogDensity * _FogDensity); 

 

    fixed4 finalColor = tex2D(_MainTex, i.uv); 

    finalColor.rgb = lerp(finalColor.rgb, _FogColor.rgb, fogDensity); 

 

    return finalColor; 

} 

 

�������������������������������SAMPLE_DEPTH_TEXTURE�������������

LinearEyeDepth������������������interpolatedRay��������������������������

������

������������������������������������������������13.3.2����������

_FogEnd�_FogStart���������worldPos.y�������fogDensity�����_FogDensity������

saturate�����[0, 1]������������������������������������������������������

�����������

�6����������������Pass�

Pass { 

    ZTest Always Cull Off ZWrite Off 

 

    CGPROGRAM   

 

    #pragma vertex vert   

    #pragma fragment frag   

 

    ENDCG   

} 

 

�7���������Shader�Fallback�

Fallback Off 

 

�����������Chapter13-FogWithDepthTexture�������FogWithDepthTexture.cs��

��fogShader������������FogWithDepthTexture.cs�������fogShader���������

Chapter13-FogWithDepthTexture���������������������



��������������������������������������������������������������������

�����������������������������������������������������������������������

����http://www.derschmale.com/2014/03/19/reconstructing- positions-from-the-

depth-buffer-pt-2-perspective-and-orthographic-general-case/ �����

http://www.derschmale.com/2014/03/19/reconstructing-positions-from-the-depth-buffer-pt-2-perspective-and-orthographic-general-case/


13.4 ������

�12.3������������Sobel����������������������������������������������������

�����������13.8���

�������������������������������������������������������������������������

��������������������������������������������������������������13.9�����

▲�13.8 ��������������������������

▲�13.9 ��������������������������������������������

�12.3���Sobel����������Roberts�������������������13.10���

▲�13.10 Roberts��

Roberts�������������������������������������������������������������������

������������������������������������������������

����������������

�1��������������������Scene_13_4��Unity 5.2��������������������������������

������Window→Lighting→Skybox������������



�2������������������������������������3������������������������������9.5�

���������������������Translating.cs��������������������

�3��������������������EdgeDetectNormalsAndDepth.cs�������������

�4�����Unity Shader���������Shader��Chapter13-EdgeDetectNormalAndDepth�

�������EdgeDetectNormalsAndDepth.cs�������12.3�����EdgeDetection.cs�������

������������������������������������

�1������12.1��������

public class EdgeDetectNormalsAndDepth : PostEffectsBase { 

 

�2���������Shader������������

public Shader edgeDetectShader; 

private Material edgeDetectMaterial = null; 

public Material material {   

    get { 

        edgeDetectMaterial = CheckShaderAndCreateMaterial(edgeDetectShader, edgeDetectMaterial); 

        return edgeDetectMaterial; 

    }   

} 

 

�3��������������������������������������������������������������

[Range(0.0f, 1.0f)] 

public float edgesOnly = 0.0f; 

 

public Color edgeColor = Color.black; 

 

public Color backgroundColor = Color.white; 

 

public float sampleDistance = 1.0f; 

 

public float sensitivityDepth = 1.0f; 

 

public float sensitivityNormals = 1.0f; 

 

sampleDistance�������+�����������������������sampleDistance���������

sensitivityDepth�sensitivityNormals����������������������������������������������

�����������������������

�4���������������+�����������OnEnable��������������

void OnEnable() { 

    GetComponent<Camera>().depthTextureMode |= DepthTextureMode.DepthNormals; 

} 

 

�5���OnRenderImage��������������

[ImageEffectOpaque] 

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        material.SetFloat("_EdgeOnly", edgesOnly); 

        material.SetColor("_EdgeColor", edgeColor); 

        material.SetColor("_BackgroundColor", backgroundColor); 

        material.SetFloat("_SampleDistance", sampleDistance); 



        material.SetVector("_Sensitivity", new Vector4(sensitivityNormals, sensitivityDepth, 0.0f, 0.0f

 

        Graphics.Blit(src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

������������OnRenderImage�����[ImageEffectOpaque]�������12.1��������������

�����OnRenderImage��������������Pass����������������������������������������

Pass����������2 500�Pass����Background�Geometry�AlphaTest���������������������

����������������Transparent�Pass��������������OnRenderImage�����

ImageEffectOpaque�������������������������������������������������������

��������Shader������Chapter13-EdgeDetectNormalAndDepth��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _EdgeOnly ("Edge Only", Float) = 1.0 

    _EdgeColor ("Edge Color", Color) = (0, 0, 0, 1) 

    _BackgroundColor ("Background Color", Color) = (1, 1, 1, 1) 

    _SampleDistance ("Sample Distance", Float) = 1.0 

    _Sensitivity ("Sensitivity", Vector) = (1, 1, 1, 1) 

} 

 

���_Sensitivity�xy�������������������zw����������

�2����������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG�����������

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 

�3�������������������CG������������

sampler2D _MainTex; 

half4 _MainTex_TexelSize; 

fixed _EdgeOnly; 

fixed4 _EdgeColor; 

fixed4 _BackgroundColor; 

float _SampleDistance; 

half4 _Sensitivity; 

sampler2D _CameraDepthNormalsTexture; 

 

��������������������+����_CameraDepthNormalsTexture����������������������

������������_MainTex_TexelSize�

�4���������

struct v2f { 

    float4 pos : SV_POSITION; 

    half2 uv[5]: TEXCOORD0; 

}; 

 

v2f vert(appdata_img v) { 



    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    half2 uv = v.texcoord; 

    o.uv[0] = uv; 

 

    #if UNITY_UV_STARTS_AT_TOP 

    if (_MainTex_TexelSize.y < 0) 

        uv.y = 1 - uv.y; 

    #endif 

 

    o.uv[1] = uv + _MainTex_TexelSize.xy * half2(1,1) * _SampleDistance; 

    o.uv[2] = uv + _MainTex_TexelSize.xy * half2(-1,-1) * _SampleDistance; 

    o.uv[3] = uv + _MainTex_TexelSize.xy * half2(-1,1) * _SampleDistance; 

    o.uv[4] = uv + _MainTex_TexelSize.xy * half2(1,-1) * _SampleDistance; 

 

    return o; 

} 

 

���v2f������������5������������������������������������������������������

���������������������������4���������Roberts�������������������_SampleDistance

����������������������������������������������������������������������������

�������������������

�5���������������

fixed4 fragRobertsCrossDepthAndNormal(v2f i) : SV_Target { 

    half4 sample1 = tex2D(_CameraDepthNormalsTexture, i.uv[1]); 

    half4 sample2 = tex2D(_CameraDepthNormalsTexture, i.uv[2]); 

    half4 sample3 = tex2D(_CameraDepthNormalsTexture, i.uv[3]); 

    half4 sample4 = tex2D(_CameraDepthNormalsTexture, i.uv[4]); 

 

    half edge = 1.0; 

 

    edge *= CheckSame(sample1, sample2); 

    edge *= CheckSame(sample3, sample4); 

 

    fixed4 withEdgeColor = lerp(_EdgeColor, tex2D(_MainTex, i.uv[0]), edge); 

    fixed4 onlyEdgeColor = lerp(_EdgeColor, _BackgroundColor, edge); 

 

    return lerp(withEdgeColor, onlyEdgeColor, _EdgeOnly); 

} 

 

������4��������+������������CheckSame��������������������CheckSame�����

����0����1���0��������������������1��������

half CheckSame(half4 center, half4 sample) { 

    half2 centerNormal = center.xy; 

    float centerDepth = DecodeFloatRG(center.zw); 

    half2 sampleNormal = sample.xy; 

    float sampleDepth = DecodeFloatRG(sample.zw); 

 

    // difference in normals 

    // do not bother decoding normals - there's no need here 

    half2 diffNormal = abs(centerNormal - sampleNormal) * _Sensitivity.x; 

    int isSameNormal = (diffNormal.x + diffNormal.y) < 0.1; 

    // difference in depth 

    float diffDepth = abs(centerDepth - sampleDepth) * _Sensitivity.y; 

    // scale the required threshold by the distance 

    int isSameDepth = diffDepth < 0.1 * centerDepth; 

 

    // return: 

    // 1 - if normals and depth are similar enough 

    // 0 - otherwise 

    return isSameNormal * isSameDepth ? 1.0 : 0.0; 



} 

 

CheckSame�����������������������������������������������������������xy �

����������������������������������������������������������������������������

�������������������������������1���������������������0����������������������

��������

���CheckSame�����������������������������12.3��������

�6������������������Pass�

Pass {  

    ZTest Always Cull Off ZWrite Off 

 

    CGPROGRAM       

 

    #pragma vertex vert   

    #pragma fragment fragRobertsCrossDepthAndNormal 

 

    ENDCG   

} 

 

�7����������Shader�Fallback�

Fallback Off 

 

�����������Chapter13-EdgeDetectNormalAndDepth�������EdgeDetect

NormalsAndDepth.cs����edgeDetectShader������������EdgeDetectNormals

AndDepth.cs�������edgeDetectShader���������Chapter13-EdgeDetectNormal

AndDepth���������������������

�������������������������������������������������������������������������

�������������������������������������Unity���Graphics.DrawMesh�

Graphics.DrawMeshNow��������������������������������������������������������

�������������������������������Shader���clip()�����������������������



13.5 ����

�����������������������������������������������

����������������Unity��������������������Unity������

�Shader Replacement�������

Camera.RenderWithShader(shader, replacementTag)������

������������������������Unity����������������

�����������������������������������������������

���Unity��2011��SIGGRAPH��������������������������

����������http://blogs.unity3d.com/2011/09/08/special-

effects-with- depth-talk-at-siggraph/ ���������Unity������

���������������������������������������Unity�Image

Effect�http://docs.unity3d.com/ Manual/comp-

ImageEffects.html �����������������������������������

���������Screen Space Ambient Occlusion�SSAO�����

http://blogs.unity3d.com/2011/09/08/special-effects-with-depth-talk-at-siggraph/
http://docs.unity3d.com/Manual/comp-ImageEffects.html


�14� ������

����������������� �photorealism� ���������������

�������� �Non-Photorealistic Rendering�NPR� �������

��������������������������������������������������

����������

��������������������������14.1�����������������

�����������������������14.2������������������������

���������������������������������������������



14.1 �������

�����������������������������������������������������������������

�����������Capcom�������������������Okami�������+��������������14.1

�����������������

������������������������������ �tone-based shading� �Gooch�����

1998������[1] ������������������������������������������������������

������7.3�����������������������������������������������������������

��������

�����������������������������������������������������������������

������������������������������������������������

����������������14.2����

▲�14.1 �����������Okami������

▲�14.2 ���������

14.1.1 �����

���������������������������20�������������������������Real Time

Rendering, third edition���������������5����



��������������������������������������������������������������

Pass������������������������������������

�����������������������Pass������Pass��������������������������

Pass�������������������������������������������������������������

����

�����������������12�13������������������������������������������

�������������������������������������������

�����������������������������������������������������������������

�����������������������������������������������������������������

������������������������

�n 0 ·v >0�≠(n 1 ·v> 0)

���n 0 �n 1 ����������������v �������������������������������������

������������������������Geometry Shader�����������������������������

�����������������������������������������������������

����������������������������������������������������������������

�����������������

����������Unity����������������������������������Pass���������Pass

������������������������������������������������������������������

viewPos = viewPos + viewNormal * _Outline; 

 

�����������������������������������������������������������������

�����������������z �������������������������������������������������

���������������������������

viewNormal.z = -0.5; 

viewNormal = normalize(viewNormal); 

viewPos = viewPos + viewNormal * _Outline; 

 

14.1.2 ����

�����������������������������������������������������������������

�����Blinn-Phong�����������������������������������������������������

����

float spec = pow(max(0, dot(normal, halfDir)), _Gloss) 

 

��������������������������normal�halfDir�������������������������

������������������0�����1�

float spec = dot(worldNormal, worldHalfDir); 

spec = step(threshold, spec); 

 



������������CG�step �� ������������step��������������������������

��������������������������1�����0�

����������������������������14.3���������������������������������

��0���1������������������������������������������

float spec = dot(worldNormal, worldHalfDir); 

spec = lerp(0, 1, smoothstep(-w, w, spec - threshold)); 

 

���������������������step����0�1��������CG�smoothstep �� ����w �

��������spec - threshold��-w ����0���w ����1����0�1�������������������

[−w , w ]�������������������0�1�����spec��������������������w �������

���������������������������������CG�fwidth �� ����

▲�14.3 ����������������������fwidth��������������

���������������������������������������������������Anjyo�����2003

������[2] �����������������������������������

�http://blog.csdn.net/candycat1992/article/details/47284289 ���������Unity���

��

14.1.3 ��

�����������������Unity��������������������������

�1��Unity��������������������Scene_14_1��Unity 5.2�����������������

���������������������Window → Lighting → Skybox������������

�2��������������������ToonShadingMat�

�3�����Unity Shader���������Unity Shader��Chapter14-ToonShading����

Unity Shader���2��������

�4���������Suzanne������2�����������

http://blog.csdn.net/candycat1992/article/details/47284289


�5������

��Chapter14-ToonShading��������

�1�������������������

Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _MainTex ("Main Tex", 2D) = "white" {} 

    _Ramp ("Ramp Texture", 2D) = "white" {} 

    _Outline ("Outline", Range(0, 1)) = 0.1 

    _OutlineColor ("Outline Color", Color) = (0, 0, 0, 1) 

    _Specular ("Specular", Color) = (1, 1, 1, 1) 

    _SpecularScale ("Specular Scale", Range(0, 0.1)) = 0.01 

} 

 

���_Ramp����������������_Outline����������_OutlineColor���������

_Specular��������_SpecularScale�����������������

�2�����������Pass���������Pass����������������������������

Pass { 

    NAME "OUTLINE" 

 

    Cull Front 

 

����Cull��������������������������������NAME����Pass�������������

�������������������Pass�������������������������Pass��������������

�3��������������������

v2f vert (a2v v) { 

    v2f o; 

 

    float4 pos = mul(UNITY_MATRIX_MV, v.vertex);  

    float3 normal = mul((float3x3)UNITY_MATRIX_IT_MV, v.normal);   

    normal.z = -0.5; 

    pos = pos + float4(normalize(normal), 0) * _Outline; 

    o.pos = mul(UNITY_MATRIX_P, pos); 

 

    return o; 

} 

 

float4 frag(v2f i) : SV_Target {  

    return float4(_OutlineColor.rgb, 1);                

} 

 

�14.1.1����������������������������������������������������������

����z ��������������������������������������������������������������

��������������������

���������������������������������



�4�����������������Pass��������������������Unity��������������Pass

�������������������

Pass { 

    Tags { "LightMode"="ForwardBase" } 

 

    Cull Back 

 

    CGPROGRAM 

 

    #pragma vertex vert 

    #pragma fragment frag 

 

    #pragma multi_compile_fwdbase 

 

�����������LightMode���ForwardBase�����#pragma�����������������

Shader��������������

�5���������������

struct v2f { 

    float4 pos : POSITION; 

    float2 uv : TEXCOORD0; 

    float3 worldNormal : TEXCOORD1; 

    float3 worldPos : TEXCOORD2; 

    SHADOW_COORDS(3) 

}; 

 

v2f vert (a2v v) { 

    v2f o; 

 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex); 

    o.uv = TRANSFORM_TEX (v.texcoord, _MainTex); 

    o.worldNormal  = mul(v.normal, (float3x3)_World2Object); 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

��������������������������������Unity������SHADOW_COORDS�

TRANSFER_SHADOW�������������������������9.4��

�6����������������������

float4 frag(v2f i) : SV_Target {  

    fixed3 worldNormal = normalize(i.worldNormal); 

    fixed3 worldLightDir = normalize(UnityWorldSpaceLightDir(i.worldPos)); 

    fixed3 worldViewDir = normalize(UnityWorldSpaceViewDir(i.worldPos)); 

    fixed3 worldHalfDir = normalize(worldLightDir + worldViewDir); 

 

    fixed4 c = tex2D (_MainTex, i.uv); 

    fixed3 albedo = c.rgb * _Color.rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 



    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    fixed diff =  dot(worldNormal, worldLightDir); 

    diff = (diff * 0.5 + 0.5) * atten; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * tex2D(_Ramp, float2(diff, diff)).rgb; 

 

    fixed spec = dot(worldNormal, worldHalfDir); 

    fixed w = fwidth(spec) * 2.0; 

    fixed3 specular = _Specular.rgb * lerp(0, 1, smoothstep(-w, w, spec + _SpecularScale    

    - 1)) * step(0.0001, _SpecularScale); 

 

    return fixed4(ambient + diffuse + specular, 1.0); 

} 

 

��������������������������������������������������albedo�����

ambient�����������UNITY_LIGHT_ ATTENUATION��������������������������

������������������������������������������_Ramp��������������������

�����������������������14.1.2��������������fwidth��������������������

�����������������������������������������������step(0.000 1,

_SpecularScale)������_SpecularScale�0����������������������������������

����������

�7�������Shader������Fallback�

Fallback "Diffuse" 

 

�������������������9.4���

�����������������������������������������������������������������

������������2������Team Fortress 2�������Valve���2007�����������[3] ����

�����������������



14.2 �������

�����������������������������Praun���2001��SIGGRAPH�������������[4] ������

�������������������������������������������� �Tonal Art Map�TAM� ���14.4�����

14.4�����������������������������������������������������mipmaps������������

����������������������������������������������

▲�14.4 ��TAM�������Praun E, et al. Real-time hatching
[4]

 �

���������������������������������������6���������������������������������

������������6��������������������������������������6������������������������

�14.5����

▲�14.5 ���������

����������������

�1��Unity��������������������Scene_14_2��Unity 5.2�������������������������

�������������Window -> Lighting -> Skybox������������

�2��������������������HatchingMat�

�3�����Unity Shader���������Unity Shader��Chapter14-Hatching����Unity Shader��

�2��������

�4���������TeddyBear������2������������������������������������������

�5������

��Chapter14-Hatching����������

�1����������������



Properties { 

    _Color ("Color Tint", Color) = (1, 1, 1, 1) 

    _TileFactor ("Tile Factor", Float) = 1 

    _Outline ("Outline", Range(0, 1)) = 0.1 

    _Hatch0 ("Hatch 0", 2D) = "white" {} 

    _Hatch1 ("Hatch 1", 2D) = "white" {} 

    _Hatch2 ("Hatch 2", 2D) = "white" {} 

    _Hatch3 ("Hatch 3", 2D) = "white" {} 

    _Hatch4 ("Hatch 4", 2D) = "white" {} 

    _Hatch5 ("Hatch 5", 2D) = "white" {} 

} 

 

���_Color�������������_TileFactor���������_TileFactor������������������14.5���

�����_TileFactor���8�_Hatch0�_Hatch5���������6������������������

�2�������������������������������14.1��������Pass�

SubShader { 

    Tags { "RenderType"="Opaque" "Queue"="Geometry"} 

 

    UsePass "Unity Shaders Book/Chapter 14/Toon Shading/OUTLINE" 

 

����UsePass�����14.1�����������Pass�Unity Shaders Book/Chapter 14/Toon Shading

���14.1��Chapter14-ToonShading���Shader�����Unity����Pass�������������������

UsePass��������Pass���

�3�����������������Pass���������������������Pass������������

Pass { 

    Tags { "LightMode"="ForwardBase" } 

 

    CGPROGRAM 

 

    #pragma vertex vert 

    #pragma fragment frag  

 

    #pragma multi_compile_fwdbase 

 

�4����������������6����������������v2f������������

struct v2f { 

    float4 pos : SV_POSITION; 

    float2 uv : TEXCOORD0; 

    fixed3 hatchWeights0 : TEXCOORD1; 

    fixed3 hatchWeights1 : TEXCOORD2; 

    float3 worldPos : TEXCOORD3; 

    SHADOW_COORDS(4) 

}; 

 

�������6����������6����������������fixed3������hatchWeights0�hatchWeights1�

�����������������worldPos������SHADOW_COORDS��������������

�5������������������

v2f vert(a2v v) { 

    v2f o; 

 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uv = v.texcoord.xy * _TileFactor; 



 

    fixed3 worldLightDir = normalize(WorldSpaceLightDir(v.vertex)); 

    fixed3 worldNormal = UnityObjectToWorldNormal(v.normal); 

    fixed diff = max(0, dot(worldLightDir, worldNormal)); 

 

    o.hatchWeights0 = fixed3(0, 0, 0); 

    o.hatchWeights1 = fixed3(0, 0, 0); 

 

    float hatchFactor = diff * 7.0; 

 

    if (hatchFactor > 6.0) { 

        // Pure white, do nothing 

    } else if (hatchFactor > 5.0) { 

        o.hatchWeights0.x = hatchFactor - 5.0; 

    } else if (hatchFactor > 4.0) { 

        o.hatchWeights0.x = hatchFactor - 4.0; 

        o.hatchWeights0.y = 1.0 - o.hatchWeights0.x; 

    } else if (hatchFactor > 3.0) { 

        o.hatchWeights0.y = hatchFactor - 3.0; 

        o.hatchWeights0.z = 1.0 - o.hatchWeights0.y; 

    } else if (hatchFactor > 2.0) { 

        o.hatchWeights0.z = hatchFactor - 2.0; 

        o.hatchWeights1.x = 1.0 - o.hatchWeights0.z; 

    } else if (hatchFactor > 1.0) { 

        o.hatchWeights1.x = hatchFactor - 1.0; 

        o.hatchWeights1.y = 1.0 - o.hatchWeights1.x; 

    } else { 

        o.hatchWeights1.y = hatchFactor; 

        o.hatchWeights1.z = 1.0 - o.hatchWeights1.y; 

    } 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    TRANSFER_SHADOW(o); 

 

    return o;  

} 

 

�����������������������_TileFactor�������������6��������������������������

����������������������������diff��������������0���diff���[0, 7]�����hatchFactor���

�[0, 7]��������7���������hatchFactor��������������������������������������

TRANSFER_SHADOW��������������

�6���������������

fixed4 frag(v2f i) : SV_Target {             

    fixed4 hatchTex0 = tex2D(_Hatch0, i.uv) * i.hatchWeights0.x; 

    fixed4 hatchTex1 = tex2D(_Hatch1, i.uv) * i.hatchWeights0.y; 

    fixed4 hatchTex2 = tex2D(_Hatch2, i.uv) * i.hatchWeights0.z; 

    fixed4 hatchTex3 = tex2D(_Hatch3, i.uv) * i.hatchWeights1.x; 

    fixed4 hatchTex4 = tex2D(_Hatch4, i.uv) * i.hatchWeights1.y; 

    fixed4 hatchTex5 = tex2D(_Hatch5, i.uv) * i.hatchWeights1.z; 

    fixed4 whiteColor = fixed4(1, 1, 1, 1) * (1 - i.hatchWeights0.x - i.hatchWeights0.y - i.hatchWeight

                        i.hatchWeights1.x - i.hatchWeights1.y - i.hatchWeights1.z); 

 

    fixed4 hatchColor = hatchTex0 + hatchTex1 + hatchTex2 + hatchTex3 + hatchTex4 + hatchTex5 + whiteCo

 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

 

    return fixed4(hatchColor.rgb * _Color.rgb * atten, 1.0); 

} 

 

����6��������������������������������������������������������������������

1�����6���������������������������������������������������������������������

���atten�����_Color�������������



�7������������Fallback�

Fallback "Diffuse" 

 

����������������������������[4] ������https://alastaira.

wordpress.com/2013/11/01/hand-drawn-shaders-and-creating-tonal-art-maps/ ����������

Photoshop����������������

https://alastaira.wordpress.com/2013/11/01/hand-drawn-shaders-and-creating-tonal-art-maps/


14.3 ����

������������������������������������������2����

��������������������������������������������������

�������������������NPAR�Non-Photorealistic Animation

and Rendering��������������������������������������

����������������The Algorithms and Principles of Non-

photorealistic Graphics�[5] ����������������������������

�������������������������������������

�Unity��������������������������Toon Shader

Free

�https://www.assetstore.unity3d.com/cn/#!/content/21288 �

���������������������������������Toon Styles

Shader Pack �https://www.assetstore.unity3d.com/

cn/#!/content/7212 ���������������������������Unity

Shader�Hand-Drawn Shader Pack

�https://www.assetstore.unity3d.com/cn/#!/content/12465 �

��������������������������������������������������

��

https://www.assetstore.unity3d.com/cn/#!/content/21288
https://www.assetstore.unity3d.com/cn/#!/content/7212
https://www.assetstore.unity3d.com/cn/#!/content/12465
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�15� ����

����������������“����”������������������“����”��

��������������������������������“��”�����15.1������

�������������������15.2����������������������������

����15.3��������13.3������������������������������



15.1 ����

�� �dissolve� ���������������������������������������������������������

�����������������������Unity�������������������������15.1�����

▲�15.1 �������

����15.1����������������������+���������������������������������������

������clip������������������������“��”����������������������������pow����

���������������

������������������������

�1��Unity��������������������Scene_15_1��Unity 5.2����������������������

����������������Window -> Lighting -> Skybox������������

�2��������������������DissolveMat�

�3�����Unity Shader���������Unity Shader��Chapter15-Dissolve����Unity

Shader���2��������

�4������������������������������������3������������������2�����������

��

�5������

��Chapter15-Dissolve�����������������

�1������������������

Properties { 

    _BurnAmount ("Burn Amount", Range(0.0, 1.0)) = 0.0 

    _LineWidth("Burn Line Width", Range(0.0, 0.2)) = 0.1 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _BumpMap ("Normal Map", 2D) = "bump" {} 

    _BurnFirstColor("Burn First Color", Color) = (1, 0, 0, 1) 

    _BurnSecondColor("Burn Second Color", Color) = (1, 0, 0, 1) 

    _BurnMap("Burn Map", 2D) = "white"{} 

} 

 



_BurnAmount��������������0�������������1����������_LineWidth����������

�������������������������_MainTex�_BumpMap���������������������

_BurnFirstColor�_BurnSecondColor��������������_BurnMap����������

�2����SubShader���������Pass�

Pass { 

    Tags { "LightMode"="ForwardBase" } 

 

    Cull Off 

 

    CGPROGRAM 

 

    #include "Lighting.cginc" 

    #include "AutoLight.cginc" 

 

    #pragma multi_compile_fwdbase 

 

���������������Pass�LightMode�multi_compile_fwdbase������������������Cull

������Shader�������������������������������������������������������������

�3���������

struct v2f { 

    float4 pos : SV_POSITION; 

    float2 uvMainTex : TEXCOORD0; 

    float2 uvBumpMap : TEXCOORD1; 

    float2 uvBurnMap : TEXCOORD2; 

    float3 lightDir : TEXCOORD3; 

    float3 worldPos : TEXCOORD4; 

    SHADOW_COORDS(5) 

}; 

 

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.uvMainTex = TRANSFORM_TEX(v.texcoord, _MainTex); 

    o.uvBumpMap = TRANSFORM_TEX(v.texcoord, _BumpMap); 

    o.uvBurnMap = TRANSFORM_TEX(v.texcoord, _BurnMap); 

 

    TANGENT_SPACE_ROTATION; 

    o.lightDir = mul(rotation, ObjSpaceLightDir(v.vertex)).xyz; 

 

    o.worldPos = mul(_Object2World, v.vertex).xyz; 

 

    TRANSFER_SHADOW(o); 

 

    return o; 

} 

 

�����������������TRANSFORM_TEX��������������������������������������

������������������������������������TRANSFER_SHADOW����������9.4��

�4���������������������

fixed4 frag(v2f i) : SV_Target { 

    fixed3 burn = tex2D(_BurnMap, i.uvBurnMap).rgb; 

 

    clip(burn.r - _BurnAmount); 

 



    float3 tangentLightDir = normalize(i.lightDir); 

    fixed3 tangentNormal = UnpackNormal(tex2D(_BumpMap, i.uvBumpMap)); 

 

    fixed3 albedo = tex2D(_MainTex, i.uvMainTex).rgb; 

 

    fixed3 ambient = UNITY_LIGHTMODEL_AMBIENT.xyz * albedo; 

 

    fixed3 diffuse = _LightColor0.rgb * albedo * max(0, dot(tangentNormal, tangentLightDir)); 

 

    fixed t = 1 - smoothstep(0.0, _LineWidth, burn.r - _BurnAmount); 

    fixed3 burnColor = lerp(_BurnFirstColor, _BurnSecondColor, t); 

    burnColor = pow(burnColor, 5); 

 

    UNITY_LIGHT_ATTENUATION(atten, i, i.worldPos); 

    fixed3 finalColor = lerp(ambient + diffuse * atten, burnColor, t * step(0.0001, _BurnAmount));

 

    return fixed4(finalColor, 1); 

} 

 

��������������������������������_BurnAmount������clip��������0���������

���������������������������������������������������albedo����������������

�������������������burnColor���������_LineWidth�����������������������

smoothstep���������t ��t ��1�����������������t ��0��������������������������

���������������t ���������_BurnFirstColor�_BurnSecondColor�������������������

�pow�������������������t ��������������+������������������step������

_BurnAmount�0������������������������finalColor�

�5�����������������������������Pass������9.4.5�������������������������

��������������Pass������������������������“��”����������������������������

������������Pass�

// Pass to render object as a shadow caster 

Pass { 

    Tags { "LightMode" = "ShadowCaster" } 

 

    CGPROGRAM 

 

    #pragma vertex vert 

    #pragma fragment frag 

 

    #pragma multi_compile_shadowcaster 

 

�Unity���������Pass�LightMode������ShadowCaster���������#pragma

multi_compile_shadowcaster�����������

������������������

struct v2f { 

    V2F_SHADOW_CASTER; 

    float2 uvBurnMap : TEXCOORD1; 

}; 

 

v2f vert(appdata_base v) { 

    v2f o; 

 

    TRANSFER_SHADOW_CASTER_NORMALOFFSET(o) 

 

    o.uvBurnMap = TRANSFORM_TEX(v.texcoord, _BurnMap); 

 

    return o; 



} 

 

fixed4 frag(v2f i) : SV_Target { 

    fixed3 burn = tex2D(_BurnMap, i.uvBurnMap).rgb; 

 

    clip(burn.r - _BurnAmount); 

 

    SHADOW_CASTER_FRAGMENT(i) 

} 

 

����������������Pass����������������������������������������������Pass

���������Unity������V2F_SHADOW_CASTER�

TRANSFER_SHADOW_CASTER_NORMALOFFSET��������TRANSFER_SHADOW_CASTER�

�SHADOW_CASTER_FRAGMENT�����������������������������������������������

���v2f������V2F_SHADOW_CASTER������������������������������

TRANSFER_SHADOW_CASTER_NORMALOFFSET���V2F_SHADOW_ CASTER�����������

���Unity�����������������������������������������������������uvBurnMap���

����������������������������������������SHADOW_CASTER_FRAGMENT��Unity��

�����������������������������

��Unity����3������UnityCG.cginc��������������������������Pass�����������

��������������������������������TRANSFER_SHADOW_CASTER_NORMALOFFSET��

���v��������v���������v.vertex�����v.normal���������������appdata_base������

��������������������������������������v.vertex�����TRANSFER_SHADOW_

CASTER_NORMALOFFSET������11.3.3���

����������������������Assets/Textures/Chapter15/Burn_Noise.png���15.2�����

������_BurnMap����������_BurnAmount��������������������������������������

������������_BurnAmount���������������������������

▲�15.2 �����������

����������������������Tiling�Offset�������������������������������������

�����������



15.2 ����

�����������������������������������������������������������������������

���������������������������������������+�����������������

����������������������������������������10.1.5����������15.3���

▲�15.3 ��������������������������������������������������������������������

����10.2.2�������������������������������Shader�10.2.2�������������������

���Cubemap��������������������������GrabPass������������������������������

����������������������������������������10.2.2����������������������������

��������������������������������������������������������������������������

�������������������

fresnel =pow (1-max (0,v · n ),4)

���v �n �������������������������fresnel ��������������������������������

��

���������������

�1��������������������Scene_15_2��Unity 5.2������������������������������

��������Window -> Lighting -> Skybox������������

�2��������������������WaterWaveMat�

�3�����Unity Shader���������Shader��Chapter15-WaterWave����Shader���2����

����

�4���������������������������������6�������������������9.5��������������

������������������2�������������

�5���������������������10.1.2������������������Gameobject -> Render into

Cubemap��������������15.4�����������Cubemap��Water_Cubemap�



▲�15.4 ����������

����������Chapter15-WaterWave������������

�1�����������Shader��������

Properties { 

    _Color ("Main Color", Color) = (0, 0.15, 0.115, 1) 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _WaveMap ("Wave Map", 2D) = "bump" {} 

    _Cubemap ("Environment Cubemap", Cube) = "_Skybox" {} 

    _WaveXSpeed ("Wave Horizontal Speed", Range(-0.1, 0.1)) = 0.01 

    _WaveYSpeed ("Wave Vertical Speed", Range(-0.1, 0.1)) = 0.01 

    _Distortion ("Distortion", Range(0, 100)) = 10 

} 

 

���_Color���������_MainTex������������������_WaveMap����������������

_Cubemap��������������_Distortion������������������_WaveXSpeed�_WaveYSpeed

�����������X�Y���������

�2��������������GrabPass��������

SubShader { 

    // We must be transparent, so other objects are drawn before this one. 

    Tags { "Queue"="Transparent" "RenderType"="Opaque" } 

 

    // This pass grabs the screen behind the object into a texture. 

    // We can access the result in the next pass as _RefractionTex 

    GrabPass { "_RefractionTex" } 

 

�����SubShader������������Transparent������RenderType���Opaque��Queue���

Transparent�������������������������������������������“���������”����

RenderType�������������Shader Replacement����������������������������������



������������13����������������GrabPass������������Pass����Pass�������������

����������������������������������10.2.2���

�3����������Pass����Shader������������������������

fixed4 _Color; 

sampler2D _MainTex; 

float4 _MainTex_ST; 

sampler2D _WaveMap; 

float4 _WaveMap_ST; 

samplerCUBE _Cubemap; 

fixed _WaveXSpeed; 

fixed _WaveYSpeed; 

float _Distortion;   

sampler2D _RefractionTex; 

float4 _RefractionTex_TexelSize; 

 

�������������_RefractionTex�_RefractionTex_TexelSize����������GrabPass�������

���_RefractionTex_TexelSize�����������������������256×512�����������(1/256,

1/512)���������������������������

�4�����������10.2.2����������

struct v2f { 

    float4 pos : SV_POSITION; 

    float4 scrPos : TEXCOORD0; 

    float4 uv : TEXCOORD1; 

    float4 TtoW0 : TEXCOORD2;   

    float4 TtoW1 : TEXCOORD3;   

    float4 TtoW2 : TEXCOORD4;  

}; 

 

v2f vert(a2v v) { 

    v2f o; 

    o.pos = mul(UNITY_MATRIX_MVP, v.vertex); 

 

    o.scrPos = ComputeGrabScreenPos(o.pos); 

 

    o.uv.xy = TRANSFORM_TEX(v.texcoord, _MainTex); 

    o.uv.zw = TRANSFORM_TEX(v.texcoord, _WaveMap); 

 

    float3 worldPos = mul(_Object2World, v.vertex).xyz;   

    fixed3 worldNormal = UnityObjectToWorldNormal(v.normal);   

    fixed3 worldTangent = UnityObjectToWorldDir(v.tangent.xyz);   

    fixed3 worldBinormal = cross(worldNormal, worldTangent) * v.tangent.w;  

 

    o.TtoW0 = float4(worldTangent.x, worldBinormal.x, worldNormal.x, worldPos.x);   

    o.TtoW1 = float4(worldTangent.y, worldBinormal.y, worldNormal.y, worldPos.y);   

    o.TtoW2 = float4(worldTangent.z, worldBinormal.z, worldNormal.z, worldPos.z);   

 

    return o; 

} 

 

���������������������ComputeGrabScreenPos�����������������������

UnityCG.cginc�����������������ComputeScreenPos����������������������������

5.6.1����������������_MainTex�_BumpMap�����������������float4�����xy �zw ����

����������������������������������������������Cubemap���������������������

��������������������������� �����TtoW0�TtoW1�TtoW2�xyz ��������������������

�����3�����x�y�z������������������������������������� �����������TtoW0���w

�������������������������



�5���������

fixed4 frag(v2f i) : SV_Target { 

    float3 worldPos = float3(i.TtoW0.w, i.TtoW1.w, i.TtoW2.w); 

    fixed3 viewDir = normalize(UnityWorldSpaceViewDir(worldPos)); 

    float2 speed = _Time.y * float2(_WaveXSpeed, _WaveYSpeed); 

 

    // Get the normal in tangent space 

    fixed3 bump1 = UnpackNormal(tex2D(_WaveMap, i.uv.zw + speed)).rgb; 

    fixed3 bump2 = UnpackNormal(tex2D(_WaveMap, i.uv.zw - speed)).rgb; 

    fixed3 bump = normalize(bump1 + bump2); 

 

    // Compute the offset in tangent space 

    float2 offset = bump.xy * _Distortion * _RefractionTex_TexelSize.xy; 

    i.scrPos.xy = offset * i.scrPos.z + i.scrPos.xy; 

    fixed3 refrCol = tex2D( _RefractionTex, i.scrPos.xy/i.scrPos.w).rgb; 

 

    // Convert the normal to world space 

    bump = normalize(half3(dot(i.TtoW0.xyz, bump), dot(i.TtoW1.xyz, bump), dot(i.TtoW2.xyz, bump)));

    fixed4 texColor = tex2D(_MainTex, i.uv.xy + speed); 

    fixed3 reflDir = reflect(-viewDir, bump); 

    fixed3 reflCol = texCUBE(_Cubemap, reflDir).rgb * texColor.rgb * _Color.rgb; 

 

    fixed fresnel = pow(1 - saturate(dot(viewDir, bump)), 4); 

    fixed3 finalColor = reflCol * fresnel + refrCol * (1 - fresnel); 

 

    return fixed4(finalColor, 1); 

} 

 

������TtoW0����w ���������������������������������������_Time.y���

_WaveXSpeed�_WaveYSpeed��������������������������������������������������

��������������������������������10.2.2���������������_Distortion����

_RefractionTex_TexelSize�����������������������_Distortion����������������������

���������������������������������������������������������������������������

���������������z ����������������������������������������������������������

������scrPos����������������������_RefractionTex���������������

�������������������������������������TtoW0�TtoW1�TtoW2����������������

�������������������������������������Cubemap������������������������������

�������������������

�������������������������������������������������������������������

����������������������Assets/Textures/Chapter15/Water_Noise.png���15.5������
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▲�15.6 ������������������������

�����������������13.3����������������������������Shader�������������

����������������������������Shader����������������������13.3��

���������������

�1��������������������Scene_15_3��Unity 5.2��������������������������

������������Window -> Lighting -> Skybox������������

�2������������������������������������3����������������������������

��9.5����������

�3��������������������FogWithNoise.cs�������������

�4�����Unity Shader���������Shader��Chapter15-FogWithNoise�

�������FogWithNoise.cs�����������������

�1������12.1��������

public class FogWithNoise : PostEffectsBase { 

 

�2���������Shader������������

public Shader fogShader; 

private Material fogMaterial = null; 

 

public Material material {   

    get { 

        fogMaterial = CheckShaderAndCreateMaterial(fogShader, fogMaterial); 

        return fogMaterial; 

    }   



} 

 

�3�������������������������������FOV�������������������������������

���������������Camera���Transform���

private Camera myCamera; 

public Camera camera { 

    get { 

        if (myCamera == null) { 

            myCamera = GetComponent<Camera>(); 

        } 

        return myCamera; 

    } 

} 

 

private Transform myCameraTransform; 

public Transform cameraTransform { 

    get { 

        if (myCameraTransform == null) { 

            myCameraTransform = camera.transform; 

        } 

 

        return myCameraTransform; 

    } 

} 

 

�4����������������

[Range(0.1f, 3.0f)] 

public float fogDensity = 1.0f; 

 

public Color fogColor = Color.white; 

 

public float fogStart = 0.0f; 

public float fogEnd = 2.0f; 

 

public Texture noiseTexture; 

 

[Range(-0.5f, 0.5f)] 

public float fogXSpeed = 0.1f; 

 

[Range(-0.5f, 0.5f)] 

public float fogYSpeed = 0.1f; 

 

[Range(0.0f, 3.0f)] 

public float noiseAmount = 1.0f; 

 

fogDensity���������fogColor�������������������������������fogStart�����

�������fogEnd������������noiseTexture�����������fogXSpeed�fogYSpeed������

����X�Y������������������������noiseAmount����������noiseAmount�0������

������������������������

�5������������������������OnEnable��������������

void OnEnable() { 

    camera.depthTextureMode |= DepthTextureMode.Depth; 

} 

 



�6���������OnRenderImage���

void OnRenderImage (RenderTexture src, RenderTexture dest) { 

    if (material != null) { 

        Matrix4x4 frustumCorners = Matrix4x4.identity; 

 

        // Compute frustumCorners 

        ... 

 

        material.SetMatrix("_FrustumCornersRay", frustumCorners); 

 

        material.SetFloat("_FogDensity", fogDensity); 

        material.SetColor("_FogColor", fogColor); 

        material.SetFloat("_FogStart", fogStart); 

        material.SetFloat("_FogEnd", fogEnd); 

 

        material.SetTexture("_NoiseTex", noiseTexture); 

        material.SetFloat("_FogXSpeed", fogXSpeed); 

        material.SetFloat("_FogYSpeed", fogYSpeed); 

        material.SetFloat("_NoiseAmount", noiseAmount); 

 

        Graphics.Blit (src, dest, material); 

    } else { 

        Graphics.Blit(src, dest); 

    } 

} 

 

������13.3��������������4�������������������������frustumCorners�����

���������13.3������������������������Graphics.Blit �src, dest, material�������

������

��������Shader������Chapter15-FogWithNoise��������

�1�������������������

Properties { 

    _MainTex ("Base (RGB)", 2D) = "white" {} 

    _FogDensity ("Fog Density", Float) = 1.0 

    _FogColor ("Fog Color", Color) = (1, 1, 1, 1) 

    _FogStart ("Fog Start", Float) = 0.0 

    _FogEnd ("Fog End", Float) = 1.0 

    _NoiseTex ("Noise Texture", 2D) = "white" {} 

    _FogXSpeed ("Fog Horizontal Speed", Float) = 0.1 

    _FogYSpeed ("Fog Vertical Speed", Float) = 0.1 

    _NoiseAmount ("Noise Amount", Float) = 1 

} 

 

�2����������CGINCLUDE���������SubShader����CGINCLUDE�ENDCG�������

����

SubShader { 

    CGINCLUDE 

    ... 

    ENDCG 

    ... 

 

�3����������������



float4x4 _FrustumCornersRay; 

 

sampler2D _MainTex; 

half4 _MainTex_TexelSize; 

sampler2D _CameraDepthTexture; 

half _FogDensity; 

fixed4 _FogColor; 

float _FogStart; 

float _FogEnd; 

sampler2D _NoiseTex; 

half _FogXSpeed; 

half _FogYSpeed; 

half _NoiseAmount; 

 

_FrustumCornersRay�����Properties�������������Shader���Properties�������

������������_CameraDepthTexture�Unity������������������

�4�����������13.3���������������13.3�������������

�5���������

fixed4 frag(v2f i) : SV_Target { 

    float linearDepth = LinearEyeDepth(SAMPLE_DEPTH_TEXTURE(_CameraDepthTexture, i. uv_depth));

    float3 worldPos = _WorldSpaceCameraPos + linearDepth * i.interpolatedRay.xyz; 

 

    float2 speed = _Time.y * float2(_FogXSpeed, _FogYSpeed); 

    float noise = (tex2D(_NoiseTex, i.uv + speed).r - 0.5) * _NoiseAmount; 

 

    float fogDensity = (_FogEnd - worldPos.y) / (_FogEnd - _FogStart);  

    fogDensity = saturate(fogDensity * _FogDensity * (1 + noise)); 

 

    fixed4 finalColor = tex2D(_MainTex, i.uv); 

    finalColor.rgb = lerp(finalColor.rgb, _FogColor.rgb, fogDensity); 

 

    return finalColor; 

} 

 

������������������������������������_Time.y���_FogXSpeed�_FogYSpeed�

�����������������������������������������0.5�������������_NoiseAmount��

��������������������������������������������fogDensity������������������

�����������

�6����������������Pass�

Pass {               

    CGPROGRAM   

 

    #pragma vertex vert   

    #pragma fragment frag   

 

    ENDCG   

} 

 

�7���������Shader�Fallback�

Fallback Off 

 



�����������Chapter15-FogWithNoise�������FogWithNoise.cs����fogShader��

����������FogWithNoise.cs�������fogShader���������Chapter15-FogWithNoise��

������������������������������������

Assets/Textures/Chapter15/Fog_Noise.jpg���15.7��������������FogWithNoise.cs��

��noiseTexture��������������������FogWithNoise.cs�������noiseTexture�������

��Fog_Noise.jpg���������������������

▲�15.7 ���������
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������Procedure Texture��������������������Perlin��

�https://en.wikipedia.org/wiki/Perlin_noise ��Worley��

�https://en.wikipedia.org/wiki/Worley_noise ��������������

�����15.3����������Perlin�������Perlin���������������

���Worley�����������������������������������

Photoshop������������������������������������������

�������������������������������������

�http://flafla2.github.io/2014/08/09/perlinnoise.html ������

����Perlin�������������������������������������

Worley����������Worley1998������[1] ����������������

��������http://scrawkblog.com/category/procedural-noise/

���������������Unity��������������

https://en.wikipedia.org/wiki/Perlin_noise
https://en.wikipedia.org/wiki/Worley_noise
http://flafla2.github.io/2014/08/09/perlinnoise.html
http://scrawkblog.com/category/procedural-noise/


15.5 ����

[1] Worley S. A cellular texture basis

function[C]//Proceedings of the 23rd annual conference on

Computer graphics and interactive techniques. ACM, 1996:

291-294�
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����Unity����

�����������������������������������ShadowGun��

�MadFinger�2011�����������������������������Unity��

Unite 2011�������������ShadowGun������������������

Youtube������������������2012���ShadowGun���������

������������������������shader���������������Unity�

�����Angry Bots���������Unity����������������

http://docs.unity3d.com/Manual/MobileOptimizationPracticalGuide.html
http://docs.unity3d.com/Manual/OptimizingGraphicsPerformance.html
http://blogs.unity3d.com/2011/08/18/fast-mobile-shaders-talk-at-siggraph/
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���������������������������

�17� Unity��������
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�18� �������

���������������������Unity�������������

�19� Unity 5�����

�����Unity 5�������������������Unity 5����������

�20� �������
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�17� Unity��������

�2009�������Unity����2.x��Unity������Aras��������

���������������Aras Pranckevičius������3����Shaders

must die������������Aras���������������������������

�����������������/��/������������������������������

��������������������������������������������������

�������������������������������Blinn-Phong���������

��������������������������������������������������

��������������������������������������������������

���������������Shader����������������Aras����������

����������Unity������2010��Unity 3��Surface Shader �

���Unity�������

��Unity������“��”������� �Surface Shader� ������

��/�����������������Aras����������/��/���������“��”�

��������������������������������������������

Shader�“�������������������������������������������

��������”�����������������������������������������

�������������Pass��������������������������������

Shader������……�����Unity��“��������”

���������������������������������������



17.1 ����������

���������������������������������������������

�1��Unity���������������������Scene_17_1��Unity

5.2��������������������������������������Window

→Lighting → Skybox������������

�2���������������������BumpedSpecularMat�

�3������Unity Shader���������Unity Shader��

Chapter17-BumpedDiffuse����Unity Shader���2��������

�4�������������capsule�����2������������

�5������

����������������������������������Unity��

�“Legacy Shaders/Bumped Diffuse”����������������

Shader��������Chapter17-BumpedDiffuse��������������

������

Shader "Unity Shaders Book/Chapter 17/Bumped Diffuse" { 

    Properties { 

        _Color ("Main Color", Color) = (1,1,1,1) 

        _MainTex ("Base (RGB)", 2D) = "white" {} 

        _BumpMap ("Normalmap", 2D) = "bump" {} 

    } 

    SubShader { 

        Tags { "RenderType"="Opaque" } 

        LOD 300 

 

        CGPROGRAM 

        #pragma surface surf Lambert 

        #pragma target 3.0 

 

        sampler2D _MainTex; 

        sampler2D _BumpMap; 

        fixed4 _Color; 

 



        struct Input { 

            float2 uv_MainTex; 

            float2 uv_BumpMap; 

        }; 

 

        void surf (Input IN, inout SurfaceOutput o) { 

            fixed4 tex = tex2D(_MainTex, IN.uv_MainTex); 

            o.Albedo = tex.rgb * _Color.rgb; 

            o.Alpha = tex.a * _Color.a; 

            o.Normal = UnpackNormal(tex2D(_BumpMap, IN.uv_BumpMap));

        } 

 

        ENDCG 

    }  

 

    FallBack "Legacy Shaders/Diffuse" 

} 

 

��������Unity�����BumpedDiffuseMat��������������

Assets/Textures/Chapter17/Mud_Diffuse.tif�

Assets/Textures/Chapter17/Mud_Normal.tif�����_MainTex�

_BumpMap������������17.1��������������������������

�������������������17.1����������������������������

���

▲�17.1 ���������������������������������������������������

��������������������/��������������������������

�����������/������������������150�������������“Unity



Shaders Book/Common/Bumped Diffuse”����������������

������������������������Unity������������������

�����Unity������������� ��

�http://docs.unity3d.com/Manual/SL-

SurfaceShaderExamples.html �������������������������

�����������

���/���������������Pass�����������CG������������

SubShader���Unity�����������Pass�������SubShader���

���Tags ����������������Chapter17-BumpedDiffuse�����

��LOD ������������LOD����16.8.1����������

CGPROGRAM �ENDCG ��������������

�������������������� �������� ������������������

���������������������Unity��������

http://docs.unity3d.com/Manual/SL-SurfaceShaderExamples.html


17.2 ����

���������������������������Unity���������������Unity�“�����

��������������������������������������”���������������������

�������������������������� ����� �����������������CG������

�������������������������

#pragma surface surfaceFunction lightModel [optionalparams] 

 

���#pragma surface �������������������������������������

�surfaceFunction�������lightModel������������������������������

17.2.1 ����

���������������������“��”�������������/��������������������

�����������������������surfaceFunction������������surfaceFunction

������surf��������������������������

void surf (Input IN, inout SurfaceOutput o) 

void surf (Input IN, inout SurfaceOutputStandard o) 

void surf (Input IN, inout SurfaceOutputStandardSpecular o) 

 

�������Unity 5������������������������SurfaceOutput �

SurfaceOutputStandard �SurfaceOutputStandardSpecular ��Unity

���������������������������������������

���������������Input IN ������������������������

SurfaceOutput�SurfaceOutputStandard�SurfaceOutputStandardSpecular

����������������������Unity������������ ��

�http://docs.unity3d.com/ Manual/SL-SurfaceShaderExamples.html �����

���������

17.2.2 ����

������������������������——������������������������������

���������������������Unity��������������Standard �

StandardSpecular ��UnityPBSLighting.cginc�����������������������

��Lambert �BlinnPhong ��Lighting.cginc������������Chapter17-

BumpedDiffuse����������Lambert�����

http://docs.unity3d.com/Manual/SL-SurfaceShaderExamples.html


����������������������������������������������

// ������������������ 

half4 Lighting<Name> (SurfaceOutput s, half3 lightDir, half atten); 

// ������������������ 

half4 Lighting<Name> (SurfaceOutput s, half3 lightDir, half3 viewDir, half atten); 

 

�����Unity����������������� ���http://docs.unity3d.com/

Manual/SL-SurfaceShaderLighting.html ����������������������������

�������������� ���http://docs.unity3d.com/Manual/SL-SurfaceShader

LightingExamples.html �����������������������������������������

��������

17.2.3 ������

�����������������������optionalparams���������������������

�������/�������/����������������������������������������������

�������������������Unity������������ ��

�http://docs.unity3d.com/Manual/SL-SurfaceShaders.html �������������

����

�������������������������������������������������

�vertex:VertexFunction� ����������

�finalcolor:ColorFunction� ���������������������������������

����������������������������������������������������������

���������

����������������������������addshadow ������������������

Pass�������Unity�����FallBack�����������ShadowCaster�Pass���

��������������������9.4�����������������������������������

�������������������������11.3.3��������fullforwardshadows

�������������������������������Unity����������������������

����������������������������������������������Shader������

�����������noshadow ��������

������������������alpha �alphatest ��������������������

alphatest:VariableName �������VariableName����������������

����������������addshadow �������������Pass�

�����������������������noambient �����Unity���������������

�light probe��novertexlights ����Unity������������

noforwardadd ��������������Pass��������Shader������������

���������������SH����������������������������������������

����������������nolightmap �nofog ��

�������������������������������������Unity����������������

��������������Pass��������Shader��������������������������

http://docs.unity3d.com/Manual/SL-SurfaceShaderLighting.html
http://docs.unity3d.com/Manual/SL-SurfaceShaderLightingExamples.html
http://docs.unity3d.com/Manual/SL-SurfaceShaders.html


��������exclude_path:deferred �exclude_path:forward �

exclude_path:prepass ���Unity���������������

�������������������������������������������������/��������

������������������������������������������/������������������

������17.6�����������



17.3 �����

�����������������������4�����������������������

��������������������������������������������������

��������������������������������������������������

����������������������������������������

���������������������������Input ��������������

SurfaceOutput �Unity 5��������������

SurfaceOutputStandard �

SurfaceOutputStandardSpecular ��

17.3.1 �����Input���

Input ������������������������������������������

�������������������������Input���������������������

��Unity������������ ��Chapter17-BumpedDiffuse��Input�

�������������������uv_MainTex�uv_BumpMap���������

�“uv”����������“uv2”������������������������������

_MainTex��������������������Input������float2

uv_MainTex�����������17.1���Input������������

�17.1

� � � �

float3 viewDir ������������������

��COLOR�����

float4��
������������

float4

screenPos
����������������������



� � � �

float3 worldPos �����������

float3 worldRefl �������������������������o.Normal

float3

worldRefl;

INTERNAL_DATA

���������o.Normal����������Unity��������������

���������������������WorldReflectionVector(IN,

o.Normal)�������������

float3

worldNormal
������������������������o.Normal

float3

worldNormal;

INTERNAL_DATA

���������o.Normal����������Unity��������������

���������������������WorldNormalVector(IN,

o.Normal)�������������

������������������������������Input�������������

�������Unity���������������������������������������

��������������������������������������������������

���������������������������������������������Input�

���������half fog���������������������

17.3.2 �����SurfaceOutput���

��Input�����������������������������������������

����������������SurfaceOutput �

SurfaceOutputStandard �

SurfaceOutputStandardSpecular �������������������

�������������������Input���������������������������

��������������������������������SurfaceOutput������

Lighting.cginc������



struct SurfaceOutput { 

    fixed3 Albedo; 

    fixed3 Normal; 

    fixed3 Emission; 

    half Specular; 

    fixed Gloss; 

    fixed Alpha; 

}; 

 

�SurfaceOutputStandard �

SurfaceOutputStandardSpecular ������

UnityPBSLighting.cginc����

struct SurfaceOutputStandard 

{ 

    fixed3 Albedo;      // base (diffuse or specular) color 

    fixed3 Normal;      // tangent space normal, if written 

    half3 Emission; 

    half Metallic;      // 0=non-metal, 1=metal 

    half Smoothness;    // 0=rough, 1=smooth 

    half Occlusion;     // occlusion (default 1) 

    fixed Alpha;        // alpha for transparencies 

}; 

 

struct SurfaceOutputStandardSpecular 

{ 

    fixed3 Albedo;      // diffuse color 

    fixed3 Specular;    // specular color 

    fixed3 Normal;      // tangent space normal, if written 

    half3 Emission; 

    half Smoothness;    // 0=rough, 1=smooth 

    half Occlusion;     // occlusion (default 1) 

    fixed Alpha;        // alpha for transparencies 

}; 

 

������������������������������������������Unity�

�������������Unity 5����������������������Lambert �

BlinnPhong �����Unity 5����������������Standard �

StandardSpecular ���������������������������������

���������������SurfaceOutput �������������������

Standard �StandardSpecular ��������



SurfaceOutputStandard �SurfaceOutput

StandardSpecular �������SurfaceOutputStandard������

���������Metallic Workflow�����Standard������

SurfaceOutputStandardSpecular������������Specular

Workflow�����StandardSpecular�����������������������

�18�����

������������SurfaceOutput�����������������������

�Input������������������SurfaceOutput��������������

fixed3 Albedo�����������������������������

fixed3 Normal��������

fixed3 Emission�����Unity�������������������������

��������������������������������

c.rgb += o.Emission; 

 

half Specular������������������������������������

BlinnPhong�����������������������

float spec = pow (nh, s.Specular*128.0) * s.Gloss; 

 

fixed Gloss����������������Specular���������������

������������������

fixed Alpha�����������������������������

�����������������������������������������������

������������“����”��������������������������������

������������������������“��������������������������

�������������������������”�������������������������

����������������������������������Unity������������

������/���������������������������Pass���/�������



17.4 Unity������

������������������������������������������������

��������������������������������������Unity���������

����������/��������������������������������/��������

������������������

�������Unity��������������������Pass���/��������

Pass�����������������������Unity����������LightMode

�ForwardBase �ForwardAdd �Pass��Unity 5�����������

LightMode �PrePassBase �PrePassFinal �Pass��Unity 5�

����������LightMode �Deferred �Pass�����Pass�������

����������������������������Unity�����LightMode �

Meta �Pass���������������������������adddshadow ��

���������LightMode �ShadowCaster �����Pass���Pass�

�������������������������������������Unity����������

�“����”�����������������������������������������

�“Show generated code”������17.2������������������

Unity���������������/������

▲�17.2 ������������



�����������������Unity����������������Pass���

Unity���LightMode �ForwardBase �Pass���������������

�������17.3�����17.3��������4������������������

Unity��Pass������������

�1����������CGPROGRAM�ENDCG������������������

��Input���������������������������������������������

���������������������

▲�17.3 �����������������������������Unity���������

�2�Unity���������������������——v2f_surf���������

������������������Unity�����������������������������

������������������v2f_surf�������������������Input���

����������������Unity�������������������������������

����v2f_surf�����������Unity�������v2f_surf�����������

���������������������������

�3������������

① �������������� �Unity��������������������������

Input�����������Unity����������������������Input�����

������v2f_surf�������



② ��v2f_surf�������������������������������������

��������������������������������������

③ ����v2f_surf�������������

�4���������

① ��v2f_surf��������Input������������������

② ������������ ��SurfaceOutput����

③ ������ ������������������Lambert�BlinnPhong���

��Unity������������������������

④ �������������������������������������

⑤ ������������������ �Unity���������������

��Pass������������������



17.5 ���������

������������������������������������������Unity��������

�����������Scene_17_4����������������������������17.4���

▲�17.4 �������������������������

�����������������������������������������������4�������������������������

����������������������4��������������������Chapter17-NormalExtrusion����������

���������

Shader "Unity Shaders Book/Chapter 17/Normal Extrusion" { 

    Properties { 

        _ColorTint ("Color Tint", Color) = (1,1,1,1) 

        _MainTex ("Base (RGB)", 2D) = "white" {} 

        _BumpMap ("Normalmap", 2D) = "bump" {} 

        _Amount ("Extrusion Amount", Range(-0.5, 0.5)) = 0.1 

    } 

    SubShader { 

        Tags { "RenderType"="Opaque" } 

        LOD 300 

 

        CGPROGRAM 

 

        // surf - which surface function. 

        // CustomLambert - which lighting model to use. 

        // vertex:myvert - use custom vertex modification function. 

        // finalcolor:mycolor - use custom final color modification function. 

        // addshadow - generate a shadow caster pass. Because we modify the vertex position,    

        // the shder needs special shadows handling. 

        // exclude_path:deferred/exclude_path:prepas - do not generate passes for    

        //deferred/legacy deferred rendering path. 

        // nometa - do not generate a "meta" pass (that’s used by lightmapping & dynamic    

        //global illumination to extract surface information). 

        #pragma surface surf CustomLambert vertex:myvert finalcolor:mycolor addshadow    

        exclude_path:deferred exclude_path:prepass nometa 

        #pragma target 3.0 

 

        fixed4 _ColorTint;   

        sampler2D _MainTex; 

        sampler2D _BumpMap; 

        half _Amount; 

 

        struct Input { 

            float2 uv_MainTex; 

            float2 uv_BumpMap; 

        }; 

 

        void myvert (inout appdata_full v) { 

            v.vertex.xyz += v.normal * _Amount; 

        } 

 



        void surf (Input IN, inout SurfaceOutput o) { 

            fixed4 tex = tex2D(_MainTex, IN.uv_MainTex); 

            o.Albedo = tex.rgb; 

            o.Alpha = tex.a; 

            o.Normal = UnpackNormal(tex2D(_BumpMap, IN.uv_BumpMap)); 

        } 

 

        half4 LightingCustomLambert (SurfaceOutput s, half3 lightDir, half atten) { 

            half NdotL = dot(s.Normal, lightDir); 

            half4 c; 

            c.rgb = s.Albedo * _LightColor0.rgb * (NdotL * atten); 

            c.a = s.Alpha; 

            return c; 

        } 

 

        void mycolor (Input IN, SurfaceOutput o, inout fixed4 color) { 

          color *= _ColorTint; 

        } 

 

        ENDCG 

    }  

 

    FallBack "Legacy Shaders/Diffuse" 

} 

 

�������������������������������������������������������������������������

�����������������������������������������������������4��������#pragma surface

���������������������������������������������������������FallBack��������Pass�

addshadow ������Unity������������������Pass�������Unity����������������Pass��

����������������exclude_path:deferred �exclude_path:prepass ���Unity���������

�����Pass��������nometa �����������Pass����

����������������“Show generated code”�����������Unity�����/����������������

����������������������������������������������������������

�����600��������Unity������������3�Pass����LightMode���ForwardBase�

ForwardAdd�ShadowCaster�����������������������Pass����������Pass��������Pass�

��Pass�������9.1.1��9.4�����������������������#ifdef �#if ���������������������

�������������������������������������Unity������������������������������� ——

������������Unity���

����������Unity�����������������������Unity 5.2.1���������������Unity���

ForwardBase Pass�

�1�Unity������������

// ---- forward rendering base pass: 

Pass { 

    Name "FORWARD" 

    Tags { "LightMode" = "ForwardBase" } 

 

    CGPROGRAM 

    // compile directives 

    #pragma vertex vert_surf 

    #pragma fragment frag_surf 

    #pragma target 3.0 

    #pragma multi_compile_fwdbase 

    #include "HLSLSupport.cginc" 

    #include "UnityShaderVariables.cginc" 

 

�����vert_surf������frag_surf��������



�2�����������������

  // Surface shader code generated based on: 

// vertex modifier: 'myvert' 

// writes to per-pixel normal: YES 

// writes to emission: no 

// needs world space reflection vector: no 

// needs world space normal vector: no 

// needs screen space position: no 

// needs world space position: no 

// needs view direction: no 

// needs world space view direction: no 

// needs world space position for lighting: no 

// needs world space view direction for lighting: no 

// needs world space view direction for lightmaps: no 

// needs vertex color: no 

// needs VFACE: no 

// passes tangent-to-world matrix to pixel shader: YES 

// reads from normal: no 

// 2 texcoords actually used 

//   float2 _MainTex 

//   float2 _BumpMap 

 

����������������������������Unity�������������

�3����Unity������������

#define INTERNAL_DATA half3 internalSurfaceTtoW0; half3 internalSurfaceTtoW1; half3 internalSurfaceTtoW

#define WorldReflectionVector(data,normal) reflect (data.worldRefl, half3(dot(data. internalSurfaceTtoW

#define WorldNormalVector(data,normal) fixed3(dot(data.internalSurfaceTtoW0,normal), dot(data.internalS

 

�����������������������������������������������������������������Input����

���������17.3.1���

�4����Unity�������������CG���������Pass������������

�5����Unity����������������������������������v2f_surf�������Unity��#ifdef���

�����������������������������������������������������������SH������

// vertex-to-fragment interpolation data 

// no lightmaps: 

#ifdef LIGHTMAP_OFF 

struct v2f_surf { 

  float4 pos : SV_POSITION; 

  float4 pack0 : TEXCOORD0; // _MainTex _BumpMap 

  fixed3 tSpace0 : TEXCOORD1; 

  fixed3 tSpace1 : TEXCOORD2; 

  fixed3 tSpace2 : TEXCOORD3; 

  fixed3 vlight : TEXCOORD4; // ambient/SH/vertexlights 

  SHADOW_COORDS(5) 

  #if SHADER_TARGET >= 30 

  float4 lmap : TEXCOORD6; 

  #endif 

}; 

#endif 

// with lightmaps: 

#ifndef LIGHTMAP_OFF 

struct v2f_surf { 

  float4 pos : SV_POSITION; 

  float4 pack0 : TEXCOORD0; // _MainTex _BumpMap 

  fixed3 tSpace0 : TEXCOORD1; 

  fixed3 tSpace1 : TEXCOORD2; 

  fixed3 tSpace2 : TEXCOORD3; 

  float4 lmap : TEXCOORD4; 



  SHADOW_COORDS(5) 

}; 

#endif 

 

���������������������������������������������������������������pack0�����

�������������������tSpace0�tSpace1�tSpace2�����������������������������vlight�

Unity������SH����������������������������������������

�6����Unity��������������������������������������������

// vertex shader 

v2f_surf vert_surf (appdata_full v) { 

v2f_surf o; 

UNITY_INITIALIZE_OUTPUT(v2f_surf,o); 

myvert (v); 

 

�������������������������Input��������������������������������������������

����Input�����

void vert(inout appdata_full v, out Input o)� 

 

����������v2f_surf���������������MVP�������������TRANSFORM_TEX����������

�����������o.pack0�xy���zw�����������������������������������o.tSpace0�

o.tSpace1�o.tSpace2�����������������������������������������������o.lmap.xy�

o.lmap.zw�����������������������������SH����������������������o.vlight��������

�����������������4������������������o.vlight������������������������������

�������������������

    TRANSFER_SHADOW(o); // pass shadow coordinates to pixel shader 

    return o; 

} 

 

�7��Pass����Unity������������Unity�����������v2f_surf����Input��������

// fragment shader 

fixed4 frag_surf (v2f_surf IN) : SV_Target { 

  // prepare and unpack data 

  Input surfIN; 

  UNITY_INITIALIZE_OUTPUT(Input,surfIN); 

  surfIN.uv_MainTex = IN.pack0.xy; 

  surfIN.uv_BumpMap = IN.pack0.zw; 

 

���Unity�����SurfaceOutput��������������������������������

#ifdef UNITY_COMPILER_HLSL 

  SurfaceOutput o = (SurfaceOutput)0; 

  #else 

  SurfaceOutput o; 

  #endif 

  o.Albedo = 0.0; 

  o.Emission = 0.0; 

  o.Specular = 0.0; 

  o.Alpha = 0.0; 

  o.Gloss = 0.0; 

 

// call surface function 



surf (surfIN, o); 

 

��������Unity���#ifdef����������������HLSL������������������SurfaceOutput��

����DirectX�������������������������������Unity�������surf����������

���Unity�����������������������������������

// compute lighting & shadowing factor 

UNITY_LIGHT_ATTENUATION(atten, IN, worldPos) 

fixed4 c = 0; 

fixed3 worldN; 

worldN.x = dot(IN.tSpace0.xyz, o.Normal); 

worldN.y = dot(IN.tSpace1.xyz, o.Normal); 

worldN.z = dot(IN.tSpace2.xyz, o.Normal); 

o.Normal = worldN; 

 

�����c �������������������0����Unity�������������������������������������

#ifdef LIGHTMAP_OFF 

  c.rgb += o.Albedo * IN.vlight; 

  #endif // LIGHTMAP_OFF 

 

������������Unity���������������������������������������������������������

���������������

�����������������������������������

// realtime lighting: call lighting function 

#ifdef LIGHTMAP_OFF 

  c += LightingCustomLambert (o, lightDir, atten); 

#else 

  c.a = o.Alpha; 

#endif 

 

�������������Unity�����������������������������c ���������������Unity������

�����������������������c ������������������������������

���Unity������������������c ��������

  mycolor (surfIN, o, c); 

  UNITY_OPAQUE_ALPHA(c.a); 

  return c; 

} 

 

��������Unity�������UNITY_OPAQUE_ALPHA��UnityCG.cginc���������������������

��������������������������1.0������������������������������������������������

���������keepalpha ���

���ForwardBase Pass���������ForwardAdd Pass����ForwardBase Pass�������������

��Unity����������������������������������Pass��������

�������Pass�ShadowCaster Pass���������Pass��������������������������������

����������������������������������11.3.3��15.1�������������������Pass��������

V2F_SHADOW_CASTER�TRANSFER_SHADOW_CASTER_NORMALOFFSET�

SHADOW_CASTER_FRAGMENT�����������������������



17.6 Surface Shader���

�����������������������������������������������

�������/�������������������

�������������������Unity���/��������������������

�����������������������������/���������������������

�����

�����������������������������������������������

��������������������������������������������������

�����������Shader���Diffuse�Bumped Specular���������

�������Unity���������������Mobile/Diffuse�

Mobile/Bumped Specular��������Shader�������������

Pass�����������������������������������������������

�����

���������������������������������10.2.2��������

��������������������������/������������������������

�����

�����������������

���������������������Unity���������������������

�������������

��������������������������������/��������������

����������������������������/������



�18� �������

�������������Lambert�����Phong�����Blinn-Phong��

��������������������������������������������������

������������

������������� �Physically Based Shading, PBS� ��

���������������PBS�����������������������PBS������

�������������PBS�������������Unity���2012���������

����Butterfly Effect��demo������PBS���Unity 5����PBS��

�������Unity 5�������Standard Shader����������������

���������������������������PBS��������������������

�������Pixar�Disney������PBS�����������������������

�������������������PBS����������������������������

��������������������������PBS���������������������

�����������������������������������������PBS������

���������������PBS���������������+��Shader��������

�����������������������������Unity 5������������

��������PBS���������������������������������������

��������������������������������������������������

��������������������������������������������������

�������������PBS��������PBS������������������PBS��

�������������������������������

������������PBS�������������������������������

������������“������Unity”����������������Unity 5���

Standard Shader������������Unity 5������������������

���������������PBS�����������PBS������������������

����������������������PBS����



18.1 PBS��������

�������PBS�������������������������������������

���������������������������������������������������

���������������Naty Hoffman�SIGGRAPH 2013�����

Background: Physics and Math of Shading ���[1]�

18.1.1 ����

������������������������������������������������

���������������������������������������������

�absorption� ��������� �scattering� �����������������

��������

������������������������������������������������

���������������������������������������������������

������������������������������������ �refractive

index� ��������������������������������������������

�������������������������������������

������������������������������������������������

���������������������������������������������������

���optically flat�������������������������������������

���������������������������������������������������

���������������������������������������������

�Fresnel equations� �������18.1���



▲�18.1 ������������������������

������������������������������������������������

���������������������������������������������������

���������������������������������������������������

��������������������������������

�����������������������������������������18.2���

���������������������������������������������������

�����������������������������������18.2������������

����������18.2����������������������������



▲�18.2 ������������������������������������������������������������

���

������������������������������������������������

���������������������������������������������������

���������������������������������������������������

����� �subsurface-scattered light� ���18.3�����������

��������������18.3��������������������

▲�18.3 ����������������������������������

������������������������������������������������

�����������������������������18.4������������������

��������������������������������������18.4���������

���������������������������������������������������

������������������������������18.4�����������������

���������������������������������������������������

����������



▲�18.4 ������������������������������������������������������������

���������������������������

���������������������������������������

18.1.2 ���������BRDF�

������������������������������������������������

���������������

�������� �radiance� ����������������������������

��L �����������������������������������������������

Li ��������Lo �������������� �shading� ���

���������Lo ����������������������������������

BRDF�Bidirectional Reflectance Distribution Function�

������������� ��������������BRDF���f ( l , v )������ l �

����� v �����������������������������������������

BRDF������BRDF�������� �isotropic� �BRDF�����������

� �anisotropic� �BRDF�

���BRDF������������BRDF�������——�������������

���BRDF�������������������������������������������

�������BRDF���������������������������������������

����� l ��������f ( l , v )�������������������� v ��



��������������������������——���� �reflection

equation� �

������������������������������������������������

����������� v �����������  ������������������BRDF

�f ( l , v )���������(n ·l )������������������������������

���������������������������������������������������

��������������������BRDF��������������������������

�������������Li ( l )����������������f ( l , v )����������

��������(n ·l )�������������������������������

������������������� �punctual light sources� �����

���������������������������������������������������

������������ l c ���������� c light ��������������������

�����������������������������������������[1]�������

���������������������������������� v ��������

�������������������������������BRDF������������

���������������������������������������������������

����

���������������������——BRDF������������BRDF��

������������������BRDF��������������������

�reciprocity� ����� �energy conservation� �

�������� l � v ����BRDF������



��������������������������

�������BRDF����������������������������������

BRDF�����������������——�������������������

�specular term� ����������������� �diffuse term� ���

18.5���

▲�18.5 BRDF�����������������������������������

18.1.3 ����



��������Lambert�������������������BRDF����

Lambertian BRDF�����

��� c diff ���������������������������diffuse color���

�������Lambert�����������������������������������( n

· l )��������������������BRDF������������������������

������������������BRDF�����������1���������� l �����

��������������

Lambert����������������������������������������

������Disney���BRDF[2]����������

���

�Disney�����baseColor ����������������roughness��

����������������������glancing angles����������������

����������������������Unity 5����������

18.1.4 �����

���������������������������John Hable����������

Everything is Shiny ��������Shader������������������

��������������������������������������BDRF��������

������������ �microfacet theory� �������������������

���������������������������������������������������



���������������������������������������������������

�18.1.1�����������������������������——������������

���������������������������������������������������

������������������������������������������

������� n ��������� m ����� n �������������������

������������������BRDF������ l ����� v �������������

��������������������������������������� v ��������

m �� l � v ������������������� h �half-angle vector�����

half vector����18.6�a����

����� m = h ���������������BRDF����������������

������� l ����������shadowing����18.6�b��������������

v �����������masking����18.6�c����������������������

���������������������������������������������������

�������

�������������BRDF������������������

▲�18.6�a� �� m = h ������������ I ��� v ����������������BRDF������b��

�����a������� I ��������������������������������c���������a����������

� v �������������������������

������Torrance-Sparrow�����[5]��������������������

������������������D ( h )����������� �normal

distribution function�NDF� �������������������� m =



h ��������������� l ����� v ��G ( l , v , h )���—����

�shadowing-masking function� ���������� m = h �����

������������������������������active microfacets�����

���������������������������F ( l , h )���������������

�Fresnel reflectance� ������������������������������

���������������������������������������������������

������������Everything has Fresnel ����������������

4( n l )( n v )�������������������������������

������������������BRDF�������������Blinn-Phong��

[7]����������������������D ( h )��

����Blinn-Phong����������������������������������

������������������GGX[3]�Beckmann[4]�������-����G (

l , v , h )����������������Smith��[6]������������������

����������������������

�����������BRDF��������������������������������

��������������BRDF�������������������������������

������������������������������BRDF��������������

������������Unity 5������

18.1.5 Unity��PBS��

�������������Unity 5�PBS�����Disney�BRDF[2]������

BRDF�����������������������Shader������������������

����������������Unity���UnityStandardBRDF.cginc������

����

�����Unity 5�������PBS��������GGX���������������

Blinn—Phong���������������������������������D ( h )�

��—����G ( l ,v ,h )��������Unity 5.2���������Blinn-



Phong���������������Unity 5.3������������GGX�������

�������������

������Unity���BRDF��������������

���

��������GGX�������������������Blinn-Phong�������

��������UnityStandardBRDF.cginc����������

Unity��������������D ( h )���GGX��������

���

��-����G ( l , v , h )�������GGX����Smith-Schlick���

���



������F ( l , h )�������������Schlick�������[7]�

��F 0 ����������Unity��������������

��������������������������������������������

BRDF���������������������������������������������

����������������

������Unity���������Shader���������Unity���������

���������Shader����Standard Shader�



18.2 Unity 5�Standard Shader

����Unity 5����������������������������������

Standard�������Standard Shader�������������������

Unity���������������������� �Metallic workflow� ��

������ �Specular workflow� ���������������������

Shader�Standard Shader�����������������������Shader�

�����Standard�Specular setup�������������������������

���������������������������������������������������

���������������������������������������������������

���������������������������������������������������

���������������������������������������������������
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float3 diffuseCol = pow(tex2D( diffTex, texCoord ), 2.2 ); 
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fragColor.rgb = pow(fragColor.rgb, 1.0/2.2); 

return fragColor; 
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// Unity 5���shader������������� 

// ��Unity 5����������x2��� 

c.rgb = s.Albedo * _LightColor0.rgb * (diff * atten * 2); 
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#pragma surface surfaceFunction lightModel noshadow nolightmap nofog
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// #define SCALED_NORMAL (v.normal * unity_Scale.w) 

float3 worldNormal = mul((float3x3)_Object2World, SCALED_NORMAL); 
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